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COMPUTER FUNDAMENTALS

Computer is an electronic device that is designed to work with Information. The term
computer is derived from the Latin term ‘compute’, this means to calculate. Computer
cannot do anything without a Program. It represents the decimal numbers through a string



of binary digits. The Word 'Computer' usually refers to the Center Processor Unit plus
Internal memory.

CHARLES BABBAGE

Charles Babbage, was an English polymath. He was a mathematician, philosopher,
inventor and mechanical engineer, who is best remembered now for originating the
concept of a programmable computer.

Considered a "father of the computer", Babbage is credited with inventing the first
mechanical computer that eventually led to more complex designs. His varied work in
other fields has led him to be described as "pre-eminent" among the many polymaths of
his century.

FUNCTIONALITES OF COMPUTER:

Any digital computer carries out five functions in gross terms:

• Takes data as input.

• Stores the data/instructions in its memory and can use them when required.

• Process the data and convert it into useful information.

• Output the information.

• Control all the above four steps.

Definition

Computer System is an electronic data processing device which does the following:

• Accept and store an input data.

• Process the data input.

• And output the processed data in required format.

ADVANTAGES OF COMPUTER:



Following list demonstrates the advantages of Computers : High
Speed

• Computer is a very fast device.

• It is capable of performing addition of very big data.

• The computer has units of speed in microsecond, nanosecond and even the
picoseconds.

• It can perform millions of calculations in a few seconds as compared to man who
can spend many months for doing the same task.

Accuracy

• In addition to being very fast, computer is very accurate. The computer

can perform calculations 100% error free.

• Computers perform all jobs with 100% accuracy.

Storage Capability

• Memory is a very important characteristic of a computer.

• The computer has much more storage capacity than human beings.

• It can store large amount of data.

• It can store any type of data such as images, videos, text, audio and any other
type.

Diligence

• Unlike human beings, a computer is free from monotony, tiredness and lack of
concentration.

• It can work continuously without creating any error and boredom.

• It can do repeated work with same speed and accuracy.

Versatility

• A computer is a very versatile machine.
• A computer is very flexible in performing the jobs to be done.

• This machine can be used to solve the problems relating to various different fields.



• At one instant, it may be solving a complex scientific problem and the very next
moment it may be playing a card game. Reliability

• A computer is a reliable machine.

• Modern electronic components have failure free long lives.

• Computers are designed to make maintenance easy.

Automation

• Computer is an automatic machine.

• Automation means ability to perform the task automatically.

• Once a program is given to computer i.e stored in computer memory, the program
and instruction can control the program execution without human interaction.

Reduction In Paper Work

• The use of computers for data processing in an organization leads to reduction in
paper work and speeds up the process.

• As data in electronic files can be retrieved as and when required, the problem of
maintenance of large number of files gets reduced.

Reduction In Cost

• Though the initial investment for installing a computer is high but it substantially
reduces the cost of each of its transaction.

DISADVANTAGES OF COMPUTER:

Following list demonstrates the disadvantages of Computers in today's arena.

• A computer is a machine and has no intelligence of its own to perform any task.

• Each and every instruction has to be given to the computer.

• A computer cannot take any decision on its own.
Dependency

• It can perform function as instructed by the user, so it is fully dependent on human
being.

Environment



• The operating environment of computer should be dust free and suitable to it. No
Feeling

• Computer has no feeling or emotions.

• It cannot make Judgment based on feelings, tastes, experiences and knowledge
unlike a human being.

APPLICATIONS OF COMPUTER

Banking

Today Banking is almost totally dependent on computer.

Banks provide following facilities:

• Banks on-line accounting facility, which include current balances, deposits,
overdrafts, interest charges, shares and trustee records.

• ATM machines are making it even easier for customers to deal with banks.

Insurance

Insurance companies are keeping all records up to date with the help of computer. The
Insurance Companies, Finance houses and Stock broking firms are widely using
computers for their concerns.

Insurance Companies are maintaining a database of all clients with information showing

• how to continue with policies

• starting date of the policies

• next due installment of a policy

• maturity date

• interests due

• survival benefits

• bonus

Education
The computer has provided a lot of facilities in the Education System.

• The uses of computer provide a tool in the Education system is known as CBE
(Computer Based Education).



• CBE involves Control, Delivery and Evaluation of learning.

• The computer education is very familiar and rapidly increasing the graph of
computer students.

• There are number of methods in which educational institutions can use computer
to educate the students.

• It is used for prepare a database about student performance and analysis are
carried out.

Marketing

In Marketing uses of computer are following:
• Advertising: With computers, advertising professionals create art and graphics,

write and revise copy and print and disseminate ads with the goal of selling more
products.

• At Home Shopping: At home shopping has been made possible through use of
computerized catalogues that provide access to product information and permit
direct entry of orders to be filled by the customers.

Health Care

Computers have become important part in all Medical Systems.

The computers are being used in hospitals to keep the record of patients and medicines.
It is also used in scanning and diagnosing different diseases. ECG, EEG, Ultrasounds
and CT Scans etc. are also done by computerized machines.

Some of major fields of health care in which computer are used:
• Diagnostic System: Computers are used to collect data and identify cause of

illness.
• Lab-diagnostic System: All tests can be done and reports are prepared by

computer.
• Patient Monitoring System: These are used to check patient's signs for

abnormality such as in Cardiac Arrest, ECG etc.
• Pharma Information System: Computer checks Drug-Labels, Expiry dates,

harmful drug side effects etc.

• Nowadays, computers are also used in performing surgery.

Engineering Design

Computers are widely used in Engineering purposes.
One of major areas is CAD (Computer Aided Design). CAD provides creation, edition and
modification of image. Some fields are:



• Structural Engineering: Requires stress and strain analysis required for design
of Ships, Buildings, Budgets, and Airplanes etc.

• Industrial Engineering: Computers deals with design, implementation and
improvement of integrated systems of people, materials and equipments.

• Architectural Engineering: Computers help in planning towns, designing
buildings, determining a range of buildings on a site using both 2D and 3D
drawings.

Military
Computers are largely used in defense. Modern tanks, missiles, weapons etc. employ
computerized control systems. Some military areas where a computer has been used
are:

• Missile Control

• Military Communication

• Military operation and planning

• Smart Weapons

Communication

Communication means to convey a message, an idea, a picture or speech that is received
and understood clearly and correctly by the person for whom it is meant. Some main
areas in this category are:

• E-mail

• Chatting

• Usenet

• FTP

• Telnet

• Video-conferencing

Government applications

Computers play an important role in government applications. Some major fields in this
category are:

• Budgets

• Sales tax department

• Income tax department



• Male/Female ratio
• Computerization of voters lists

• Computerization of Driving Licensing system

• Computerization of PAN card Weather Forecasting.

TYPES OF COMPUTER:

Computer can be broadly classified by their speed and computing power.

Single user computer system. Moderately
PC (Personal Computer) powerful microprocessor.

WorkStation
Single user computer system. Similar to
Personal Computer but have more powerful
microprocessor.

Mini Computer
Multi-user computer system. Capable of
supporting hundreds of users simultaneously.

An extremely fast computer which can perform
hundreds of millions of instructions per
second.

Supercomputer5

Multi-user computer system. Capable of
supporting hundreds of users simultaneously.
Software technology is different from
minicomputer.

Main Frame4

3

2

1

SpecificationsType
Sr.
No.

INPUT DEVICES

Following are few of the important input devices which are used in Computer Systems

• Keyboard

• Mouse

• Joy Stick

• Light pen



• Track Ball

• Scanner
• Graphic Tablet

• Microphone

• Magnetic Ink Card Reader(MICR)

• Optical Character Reader(OCR)

• Bar Code Reader

• Optical Mark Reader

OUTPUT DEVICES

Following are few of the important output devices which are used in Computer Systems

• Monitors

• Graphic Plotter

• Printer

CPU (CENTRAL PROCESSING UNIT)

• CPU is considered as the brain of the computer.

• CPU performs all types of data processing operations.

• It stores data, intermediate results and instructions (program).

• It controls the operation of all parts of computer.

CPU itself has following three components.

• Memory Or Storage Unit:

• Control Unit

• ALU (Arithmetic Logic Unit)



Memory or Storage Unit:
This unit can store instruction, data and intermediate results. This unit supplies
information to the other units of the computer when needed. It is also known as internal
storage unit or main memory or primary storage or Random access memory (RAM).



Its size affects speed, power and capability. There are primary memory and secondary
memory two types of memories in the computer.

Function of Memory Unit is:

It stores all the data to be processed and the instructions required for processing.

It stores intermediate results of processing.

It stores final results of processing before these results are released to an output device.

All inputs and outputs are transmitted through main memory.

Control Unit:
This unit controls the operations of all parts of computer. It does not carry out any actual
data processing operations.

Functions of this unit are

It is responsible for controlling the transfer of data and instructions among other units of
a computer.

It manages and coordinates all the units of the computer.

It obtains the instructions from the memory, interprets them and directs the operation of
the computer.

It communicates with Input/output devices for transfer of data or results from storage.

It does not process or store data.

ALU (Arithmetic Logic Unit):

This unit consists of two sub-sections namely

• Arithmetic section

• Logic Section

ARITHMETIC SECTION
Function of Arithmetic section is to perform arithmetic operations like addition,
subtraction, multiplication and division. All complex operations are done by making
repetitive use of above operations.



LOGIC SECTION
Function of logic section is to perform logic operations such as comparing, selecting,
matching and merging of data.

Units of Computer Memory Measurements

1 Bit = Binary Digit (Bits of Computer are 0 and 1)
8 Bits = 1 Byte
1024 Bytes = 1 KB (Kilo Byte)
1024 KB = 1 MB (Mega Byte)
1024 MB = 1 GB(Giga Byte)

Computer Memory
In computing, memory refers to the physical devices used to store programs (sequences
of instructions) or data (e.g. program state information) on a temporary or permanent
basis for use in a computer or other digital electronic device. The term primary memory
is used for the information in physical systems which function at highspeed (i.e. RAM),
as a distinction from secondary memory, which are physical devices for program and data
storage which are slow to access but offer higher memory capacity. Primary memory
stored on secondary memory is called "virtual memory". An archaic synonym for memory
is store.
The term "memory", meaning primary memory is often (but not always) associated with
addressable semiconductor memory, i.e. integrated circuits consisting of silicon-based
transistors, used for example as primary memory but also other purposes in computers
and other digital electronic devices. There are two main types of semiconductor memory:
volatile and non-volatile. Examples of non-volatile memory are flash memory (sometimes
used as secondary, sometimes primary computer memory) and
ROM/PROM/EPROM/EEPROM memory (used for firmware such as boot programs).
Examples of volatile memory are primary memory (typically dynamic RAM, DRAM), and
fast CPU cache memory (typically static RAM, SRAM, which is fast but energyconsuming
and offer lower memory capacity per area unit than DRAM) .

Volatile memory

Volatile memory is computer memory that requires power to maintain the stored
information. Most modern semiconductor volatile memory is either Static RAM or dynamic
RAM. SRAM retains its contents as long as the power is connected and is easy to
interface to but uses six transistors per bit. Dynamic RAM is more complicated to interface
to and control and needs regular refresh cycles to prevent its contents being lost.
However, DRAM uses only one transistor and a capacitor per bit, allowing it to reach
much higher densities and, with more bits on a memory chip, be much cheaper per bit.
SRAM is not worthwhile for desktop system memory, where DRAM dominates, but is
used for their cache memories. SRAM is commonplace in small embedded systems,
which might only need tens of kilobytes or less. Forthcoming volatile memory



technologies that hope to replace or compete with SRAM and DRAM include Z-RAM,
TTRAM, A-RAM and ETA RAM.

Non-volatile memory
Non-volatile memory is computer memory that can retain the stored information even
when not powered. Examples of non-volatile memory include read-only memory(ROM),
flash memory, most types of magnetic computer storage devices (e.g. hard disks, floppy
discs and magnetic tape), optical discs, and early computer storage methods such as
paper tape and punched cards.

OPERATING SYSTEM
An operating system is a program that acts as an interface between the software and the
computer hardware.

• It is an integration set of specialized programs that are used to manage overall
resources and operations of the computer.

• It is specialized software that controls and monitors the execution of all other
programs that reside in the computer, including application programs and other
system software.

Objectives of Operating System

• Making a computer system convenient to use in an efficient manner

• To hide the details of the hardware resources from the users

• To provide users a convenient interface to use the computer system.

• To act as an intermediary between the hardware and its users and making it easier
for the users to access and use other resources.

• Manage the resources of a computer system.

• Keep track of who is using which resource, granting resource requests, according
for resource using and mediating conflicting requests from different programs and
users.

• The efficient and fair sharing of resources among users and programs



Characteristics of Operating System

• Memory Management -- It keeps tracks of primary memory i.e what part of it are in use
by whom, what part are not in use etc. Allocates the memory when the process or
program request it.

• Processor Management -- Allocate the processor(CPU) to a process. De-
allocate processor when processor is no longer required.

• Device Management -- Keep tracks of all devices. This is also called I/O controller.
Decides which process gets the device when and for how much time.

• File Management -- Allocates the resources. De-allocates the resources. Decides who
gets the resources.

• Security -- By means of passwords & similar other techniques, preventing unauthorized
access to programs & data.

• Job accounting -- Keeping track of time & resources used by various jobs and/or users.

• Control over system performance -- Recording delays between request for a service &
from the system.

• Interaction with the operators -- The interaction may take place via the console of the
computer in the form of instructions. Operating System acknowledges the same, do the
corresponding action and inform the operation by a display screen.

• Error-detecting aids -- Production of dumps, traces, error messages and other
debugging and error-detecting methods.

• Coordination between other software and users -- Coordination and assignment of
compilers, interpreters, assemblers and other software to the various users of the
computer systems.

WINDOWS 7

Windows 7 is an operating system produced by Microsoft for use on personal
computers, including home and business desktops, laptops, net books, tablet PCs, and
media center PCs. It was released to manufacturing on July 22, 2009, and became
generally available retail worldwide on October 22, 2009, less than three years after the
release of its predecessor, Windows Vista. Windows 7's server counterpart, Windows
Server 2008 R2, was released at the same time. Windows 7 is succeeded by Windows
8.

Unlike Windows Vista's many new features, Windows 7 was an incremental upgrade
designed to work with Vista-compatible applications and hardware. Presentations given
by Microsoft in 2008 focused on multi-touch support, an updated Windows shell with a
new taskbar, referred to internally as the Superbar, a home networking system called
Home Group, and performance improvements. Some standard applications that have



been included with prior releases of Microsoft Windows, including Windows Calendar,
Windows Mail, Windows Movie Maker, and Windows Photo Gallery, are not included in
Windows 7; most are instead offered separately at no charge as part of the Windows
Essentials suite.

Install Windows 7

Many people have computers that come with Windows 7 so they may never have to install
it. However, you may need to install Windows 7 if:

• You replaced your hard disk drive with a new hard disk drive that does not have
Windows 7 installed.

• You are reinstalling Windows 7 on a computer because you want to clean off
your hard drive and remove any unwanted programs, such as spyware.

You purchased a computer without an operating system.

Pre-installation checklist

Before you begin the installation process, use this checklist to make sure that you are
prepared:

• You have the Windows 7 CD.
• You have the product key available. The product key is located on your Windows

7 CD case and is required to install and activate Windows 7.
• Your computer hardware is set up. At a minimum, you should connect your

keyboard, mouse, monitor, and CD drive. If available, you should connect your
computer to a wired network.

• You have Windows 7 drivers available. Drivers are software that Windows 7 uses
to communicate with your computer’s hardware. If you do not have drivers
available, Windows 7 may already include drivers for your hardware. If not, you
should be able to download them from your hardware manufacturer’s website
after you set up Windows 7.

• If you are reinstalling Windows 7 on an existing computer, you need a backup
copy of your files and settings. The installation process will delete all of your files.
You can use the File and Settings Transfer Wizard to store your files and settings
on removable media and then restore them after installation is complete.

Installation process

Installing Windows 7 can take up to two hours. To make the process more manageable,
it has been broken up into several sections.

To Begin Installation:

1. Insert the Windows 7 CD into your computer and restart your computer.
2. If prompted to start from the CD, press Spacebar. If you miss the prompt (it only

appears for a few seconds), restart your computer to try again.



3. Windows 7 Setup begins. During this portion of setup, your mouse will not work,
so you must use the keyboard. On the Welcome to Setup page, press Enter. 4.
On the Windows 7 Licensing Agreement page, read the licensing agreement.
Press the Page Down key to scroll to the bottom of the agreement. Then press F8.

5. This page enables you to select the hard disk drive on which Windows 7
will be installed. Once you complete this step, all data on your hard disk
drive will be removed and cannot be recovered. It is extremely important
that you have a recent backup copy of your files before continuing. When
you have a backup copy, press D, and then press L when prompted. This
deletes your existing data.



6. Press Enter to select unpartitioned space, which appears by default.
7. Press Enter again to select Format the partition using the NTFS file system, which

appears by default.
8. Windows 7 erases your hard disk drive using a process called formatting and

then copies the setup files. You can leave your computer and return in 20 to 30
minutes.

To Continue the Installation

1. Windows 7 restarts and then continues with the installation process. From this point
forward, you can use your mouse. Eventually, the Regional and Language Options
page appears. Click Next to accept the default settings. If you are multilingual or
prefer a language other than English, you can change language settings after setup
is complete.

2. On the Personalize Your Software page, type your name and your organization
name. Some programs use this information to automatically fill in your name when
required. Then, click next.

3. On the Your Product Key page, type your product key as it appears on your
Windows 7 CD case. The product key is unique for every Windows 7 installation.
Then, click Next.

4. On the Computer Name and Administrator Password page, in the Computer name
box, type a name that uniquely identifies your computer in your house, such as
FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect
your computer to a network, you will use this computer name to find shared files
and printers. Type a strong password that you can remember in the Administrator
password box, and then retype it in the Confirm password box. Write the password
down and store it in a secure place. Click Next.

5. On the Date and Time Settings page, set your computer’s clock. Then, click the
Time Zone down arrow, and select your time zone. Click Next.

6. Windows 7 will spend about a minute configuring your computer. On the
Networking Settings page, click next.

7. On the Workgroup or Computer Domain page, click Next.

To complete the installation

1. Windows 7 will spend 20 or 30 minutes configuring your computer and will
automatically restart when finished. When the Display Settings dialog appears, click
OK.

2. When the Monitor Settings dialog box appears, click OK.
3. The final stage of setup begins. On the Welcome to Microsoft Windows page, click

Next.
4. On the Help protect your PC page, click Help protect my PC by turning on Automatic

Updates now. Then, click Next.
5. Windows 7 will then check if you are connected to the Internet:

o If you are connected to the Internet, select the choice that describes your
network connection on the Will this computer connect to the Internet
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directly, or through a network page. If you’re not sure, accept the default selection,
and click Next.

o If you use dial-up Internet access, or if Windows 7 cannot connect to the
Internet, you can connect to the Internet after setup is complete. On the
How will this computer connect to the Internet? page, click Skip.

6. Windows 7 Setup displays the Ready to activate Windows page. If you are connected
to the Internet, click Yes, and then click Next. If you are not yet connected to the
Internet, click No, click Next, and then skip to step 24. After setup is complete,
Windows 7 will automatically remind you to activate and register your copy of
Windows 7.

7. On the Ready to register with Microsoft page, click Yes, and then click Next.
8. On the Collecting Registration Information page, complete the form. Then, click Next.
9. On the Who will use this computer page, type the name of each person who will use

the computer. You can use first names only, nicknames, or full names. Then click
Next.

10.On the Thank you! Page, click Finish.

Windows 7 setup is complete. You can log on by clicking your name on the logon
screen. If you’ve installed Windows 7 on a new computer or new hard disk drive,
you can now use the File and Settings Transfer Wizard to copy your important
data to your computer or hard disk drive.

MS-DOS

Short for Microsoft Disk operating system, MS-DOS is a non-graphical command line
operating system derived from 86-DOS that was created for IBM compatible computers.
MS-DOS originally written by Tim Peterson and introduced by Microsoft in August 1981
and was last updated in 1994 when MS-DOS 6.22 was released. Today, MS-DOS is no
longer used; however, the command shell, more commonly known as the Windows
command line is still used by many users.

Today, most computer users are only familiar with how to navigate Microsoft Windows
using the mouse Unlike Windows, MS-DOS is a command-line and is navigated by using
MS-DOS commands. For example, if you wanted to see all the files in a folder in Windows
you would double-click the folder to open the folder in Windows Explorer. In MS-DOS, to
view that same folder you would navigate to the folder using the CD command and then
list the files in that folder using the dir command.

DOS Commands

MS-DOS has a relatively small number of commands, and an even smaller number of
commonly used ones. Moreover, these commands are generally inflexible because, in
contrast to Linux and other Unix-like operating systems, they are designed to
accommodate few options or arguments (i.e., values that can be passed to the
commands).
Some of the most common commands are as follows (corresponding commands on Unix-like
operating systems are shown in parenthesis):



CD - changes the current directory (cd)
COPY - copies a file (cp) DEL
- deletes a file (rm)
DIR - lists directory contents (ls)
EDIT - starts an editor to create or edit plain text files (vi, vim, ed, Joe)
FORMAT - formats a disk to accept DOS files (mformat)
HELP - displays information about a command (man, info)
MKDIR - creates a new directory (mkdir)
RD - removes a directory (rmdir)
REN - renames a file (mv)
TYPE - displays contents of a file on the screen (more, cat)

Other DOS Command commonly used are:

Append
The append command can be used by programs to open files in another directory as if they
were located in the current directory.
Attrib
The attrib command is used to change the attributes of a single file or a directory.
Break
The break command sets or clears extended CTRL+C checking. Call
The call command is used to run a script or batch program from within another script or batch
program.
The call command has no effect outside of a script or batch file. In other words, running the
call command at the DOS prompt will do nothing.
Chcp
The chcp command displays or configures the active code page number. Chdir
The chdir command is used to display the drive letter and folder that you are currently in.
Chdir can also be used to change the drive and/or directory that you want to work in.
Chkdsk
The chkdsk command, often referred to as check disk, is used to identify and correct certain
hard drive errors.
Choice
The choice command is used within a script or batch program to provide a list of choices
and return the value of that choice to the program.
Cls
The cls command clears the screen of all previously entered commands and other text.
Dir
The dir command is used to display a list of files and folders contained inside the folder that
you are currently working in.
The dir command also displays other important information like the hard drive's serial
number, the total number of files listed, their combined size, the total amount of free
space left on the drive, and more.
DIR [drive:][path][filename] [/P] [/W] [/A[[:]attributes]] [/O[[:]sort order]] [/S] [/B] [/L] [/V]



Specifies drive, directory, or files to list. (Could be enhanced file



[drive:][path][filename] specification or multiple file specs)
/P Pauses after each screenful of information.
/W Uses wide list format.

attributes: D
Directories
R Read-only files

/A H Hidden files
A Files ready for archiving
S System files
- Prefix meaning not
List by files in sorted order, sort order:
N By name (alphabetic)
S By size (smallest first)

/O E By extension (alphabetic)
D By date and time (earliest first)
G Group directories first
- Prefix to reverse order
A By Last Access Date (earliest first)

/S Displays files in specified directory and all subdirectories.
/B Uses bare format (no heading information or summary).
/L Uses lowercase.
/V Verbose mode.

WINDOWS OPERATIONS:

MS- PAINT
Paint is a drawing tool you can use to create simple or elaborate drawings. These
drawings can be either black-and-white or color, and can be saved as bitmap files. You
can print your drawing, use it for your desktop background, or paste it into another
document. You can even use Paint to view and edit scanned photos.

You can also use Paint to work with pictures, such as .jpg, .gif, or .bmp files. You can paste a
Paint picture into another document you've created, or use it as your desktop background.

To draw a straight line
1. In the toolbox, click Line .
2. Below the toolbox, click a line width.
3. Drag the pointer to draw the line.
To draw a freeform line
1. In the toolbox, click Line .
2. Drag the pointer to draw the line.

To draw a curved line
1. In the toolbox, click Curve .
2. Below the toolbox, click a line width.
3. Draw a straight line by dragging the pointer.



4. Click where you want one arc of the curve to be, and then drag the pointer to adjust the
curve. Repeat this step for a second arc. You can only create two curves for each line.

To send an image using e-mail
After you are done working on an image, you can send it to anyone who has an e-mail account
(as long as you also have access to an e-mail account).
1. On the File menu, click Send.
2. Your e-mail program will display, with your image included either as an attachment or as

part of the message section of your e-mail.
3. Specify your recipient's e-mail address, a subject, and a message; then send the email as

you normally would.

To draw a rectangle or square
1. In the toolbox, click Rectangle to create a square-cornered shape, or click Rounded

Rectangle to create a round-cornered shape.
2. Below the toolbox, click a fill style.
3. To draw a rectangle, drag the pointer diagonally in the direction you want.
4. To draw a square, hold down SHIFT while dragging the pointer.

To acquire an image from a scanner or a digital camera 1.
On the File menu, click From Scanner or Camera.
2. In the Get Pictures dialog box, click the image you want, and then click Get Picture.

NOTEPAD

Notepad overview
Notepad is a basic text editor you can use for simple documents or for creating Web
pages. The most common use for Notepad is to view or edit text (.txt) files, but many users
find Notepad a simple tool for creating Web pages.
Because Notepad supports only very basic formatting, you cannot accidentally save
special formatting in documents that need to remain pure text. This is especially useful
when creating HTML documents for a Web page because special characters or other
formatting may not appear in your published Web page or may even cause errors. You
can save your Notepad files as Unicode, ANSI, UTF-8, or big-endian Unicode. These
formats provide you greater flexibility when working with documents that use different
character sets.
WORDPAD

WordPad is a basic word processor that is included with almost all versions of Microsoft
Windows from Windows 95 onwards. It is more advanced than Notepad but simpler than
Microsoft Works Word Processor and Microsoft Word. It replaced Microsoft Write.

Using WordPad

WordPad is a basic word processor that is included in Windows. A word processor is a
computer program that you can use to create, edit, view, and print text documents. With
WordPad, you can type letters, book reports, and other simple documents. You can also
change how the text looks, quickly move sentences and paragraphs around, and copy
and paste text within and between documents.



The WordPad window



To open WordPad, click the Start button , click All Programs, click Accessories, and then
clickWordPad.

There are four main parts of the WordPad window:

The toolbar: The toolbar contains buttons for basic commands, including saving and
printing. To find out what a button does, rest your mouse pointer on it. A box pops up
showing the function of the button.

The format bar: The format bar contains buttons that you can use to format the text in
your document. For example, you can choose the font, color, and alignment of your text.
The ruler: Use the ruler to check the layout and placement of text in your document.

The document area: This is where you type your document, make changes to the text, and
apply your formatting.

Typing text:When you're ready to get started, type in the document area of WordPad. A
flashing vertical line called the cursor indicates where the next text that you type will
appear. To move the cursor within text, click where you want the cursor to appear.

Unlike using a typewriter, when you type in WordPad you don't have to press ENTER to
start a new line. WordPad will take care of that for you by automatically starting a new line
when you reach the end of the one you're working on. When you want to start a new
paragraph, press ENTER.

Selecting text

Whenever you want to do something to text in your document, such as copy it or format
it, you need to select it first. To select text, position the mouse pointer to the left of where
you want to begin your selection. With the pointer positioned, click and hold the left mouse
button while you drag the pointer over the text that you want to select. The selected text
will be highlighted. Once you've completed your selection, release the mouse button.

Copying and moving text
If you have text in one part of your document that you want to appear in another part, there
are two ways to move the text around without having to retype it: You can copy and paste
it to another location, or you can move it to another location.

When you copy text, it is placed in the Clipboard. You can then paste it in a different location.
The original text is preserved.

When you move text to another location, the original text is not preserved. You might find
this method useful when you want to rearrange the sentences and paragraphs in your
document.

To copy text and paste it in another location

1. Select the text that you want to copy.

2. On the Edit menu, click Copy.



3. Move the cursor to the location where you want to insert the copied text.



4. On the Edit menu, click Paste.

Tip

To quickly copy text that you've selected, press CTRL+C. To paste it, press CTRL+V.

Inserting and deleting text

WordPad makes it easy to insert and delete text wherever you want. To insert text, click
where you want to insert the text and then just start typing. To delete text, select the text
that you want to delete, and then press DELETE.

Formatting your document

Formatting refers to the how the text in your document looks as well as how it is arranged.
WordPad lets you easily change the formatting in your document. For example, you can
choose from many different fonts and font sizes, and you can make your text almost any
color you want. You can also easily change how your document is aligned.

To change the font, font style, or font size:

1. Select the text whose formatting you want to change.

2. On the Format menu, click Font.

3. In the Font box, type or select the font you want to use.

4. In the Font Style box, type or select the font style you want.

5. In the Size box, type or select the size you want to use.

To change the color
1. Select the text whose color you want to change.

2. On the Format menu, click Font.

3. Under Color, click the color that you want.

To change the alignment

You can align the text in your document to either the left margin, the center, or the right margin.

1. Select the paragraph whose alignment you want to change.

2. On the Format menu, click Paragraph.

3. In the Alignment box, click the alignment you want.

Saving your document

It's a good idea to save your document periodically while you are working on it so that in
case your computer stops working for some reason, you won't lose any of your work.
Saving the document will also allow you to come back to it later if you want to work on it



again.



To save the document

On the File menu, click Save.

If you haven't saved the document yet, you'll be asked to provide a name for the document
and location on your computer to save it to:

1. In the Save in box, click the location where you want to save the document.

2. In the File name box, type a name for your document.

3. Click Save.

Printing your document

On the File menu, click Print. In the Print dialog box, use the Page Range box and the
Number of copies box to specify which pages you want to print as well as how many
copies. When you're done, click Print.

MS-OFFICE:
Microsoft Office is an office suite of desktop applications, servers and services for the
Microsoft Windows and OS X operating systems, introduced by Microsoft on August 1,
1989. Initially a marketing term for a bundled set of applications, the first version of Office
contained Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years,
Office applications have grown substantially closer with shared features such as a
common spell checker, OLE data integration and Microsoft Visual Basic for Applications
scripting language. Microsoft also positions Office as a development platform for line-of-
business software under the Office Business Applications brand. Office is reported to now
be used by over a billion people worldwide.

The current versions are Office 2013 for Windows, released on October 11, 2012 and
Office 2011 for OS X, released October 26, 2010. On 24 October 2012, the RTM final
code of Office 2013 Professional Plus has been released to TechNet and MSDN
subscribers for download. On 15 November 2012, the 60-day trial version of Office 2013
Professional Plus was released for download.

MS- WORD
Microsoft →ord is an example of a program called a “word processor.” The key benefit to
using a word processor is that you can make changes easily, including correcting spelling;
adding, deleting, formatting, and relocating text; and inserting images. Once you create a
document, you can effortlessly print it (as many copies as you want!), save it for later
modifications, or send it to a friend via e-mail. Microsoft Word is a very powerful word
processor—this handout was created using just a small number of its features!

Microsoft Word is available on both PCs and Macs, so what you learn in class today should
be applicable to any computer you use. The program may look slightly different depending
on the version and computer that you’re using, but Microsoft →ord will function in the



same basic ways. There are other word processors out there, including OpenOffice.org



Writer, WordPerfect, Apple Pages, and WordPad. They have many features in common
with Microsoft Word, and you should feel free to choose any program you prefer.

Opening Microsoft Word
To get started with Microsoft →ord (sometimes called “MS →ord”), you will need to locate
and open the program on your computer. To open the program, point to →ord’s icon on
the desktop with your mouse and double-click on it with the left mouse button. If you don’t
see the MS →ord icon on your desktop, you’ll have to access the program from the Start
Menu. Click on the button in the bottom left corner to pull up the Start Menu. You should
see the MS Word icon here, so click on it once with your left button. If you still don’t see
it, click on “All Programs” and scroll through the list of programs until you find it. Click once
with your left button to open the program. Occasionally, Microsoft Word will be in a folder
called “Microsoft Office” or something similar—this will make one more step between “All
Programs” and “Microsoft →ord.”

MS →ord will then open a blank page called “Document 1.”
This is an image of the upper-left corner of MS Word. This box features two important
pieces of information: the name of the file that you are currently working on (in this case,
“Document 1” since we have not yet renamed it) and which program you are using
(“Microsoft →ord”).There should now be a blinking line in the top left corner of the part of
the screen that looks like a sheet of paper. This means you will be able to type in this
space!

Microsoft Word Features

The Title Bar
This is a close-up view of the Title Bar, where file information is located. It shows the name



of the file (here, “Microsoft Word”) and the name of the program (“Microsoft →ord”). Notice
the three buttons on the right side, controlling the size and closing of the program.



Minimize: Left click this button to shrink the window down to a small button that will appear in
the task bar
Maximize: Left click this button to make the window as large as it can be—it should take up
your entire screen.
Close: Left-click this button to close the window. The program will close and stop running. Make
sure you save your work first!
Restore Down:
Left-click this button to make the window smaller without minimizing it. The tabbed Ribbon
menu system is how you navigate through Word and access various Word commands. If
you have used previous versions of Word, the Ribbon system replaces the traditional
menus.

The File Menu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the
top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in the
Ribbon called “File.”
When you left-click on this tab, a drop-down menu appears. From this menu, you can
perform the same functions as were found under the Microsoft Office Button menu, such
as: Create a new document, open files, save files in a variety of ways, and print.
Quick Access Toolbar
On the top left-hand side of the Title Bar, you will see several little icons above the File
menu. These let you perform common tasks, such as saving and undoing, without having
to find them in a menu. →e’ll go over the meanings of the icons a little later.

The Home Tab

The most commonly used commands in MS Word are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
that can change the font, size, color, alignment, organization and style of the text in the
document. For example, the “Times New Roman” Indicates the FONT of your text, the
“12” indicates the SI↕E of your text; etc. →e will go over how to use all of these options
toformat your text in a little while. Each of these options expands into a menu if you left-
clickon the tiny down-arrow in the bottom right corner of the window. The ruler is found
below the Ribbon. The ruler tells you where you are on the page, along with the
dimensions ofthe overall document. Just like a real piece of paper, the default setting is
8.5 x 11 inches,and the margins have been incorporated for you. Similar to most options
in MS Word, this is entirely customizable and the user can create a document of any
dimensions.

Keyboard Review

In order to use MS Word effectively, you must input commands using both the mouse and
the keyboard. The above image of a keyboard should look similar to the keyboard in front
of you; learning just a few certain keys will help to improve your efficiency in typing, as
well as present you with more options within the program. The following is a list of
commonly used keys that have special functions in MS Word (key functions can change
depending on which program you are using) :



1. Backspace: This key deletes letters backward.



2. Delete: This key deletes letters forward.

3. Shift: This key, when pressed WITH another key, will perform a secondary

Function.

4. Spacebar: This key enters a space between words or letters.

5. Tab: This key will indent what you type, or move the text to the right. The default

Indent distance is usually ½ inch.

6. Caps Lock: Pressing this key will make every letter you type capitalized.
7. Control (Ctrl): This key, when pressed WITH another key, performs a shortcut.

8. Enter: This key either gives you a new line, or executes a command (pressed in MS Word,

it begins a new line).

9. Number Keypad: These are exactly the same as the numbers at the top of the

Keyboard; some people just find them easier to use in this position.

10. Arrow Keys: Like the mouse, these keys are used to navigate through a document.

MICROSOFT WORD BASICS

Typing Text

To enter text, type just as you would if you were using a typewriter. To capitalize a letter,
hold down the SHIFT key while typing the letter. Or, press the CAPS LOCK key on the
left-hand side of your keyboard. You will have to press the CAPS LOCK key again—once
you are done capitalizing—to remove the lock. You do not need to press ENTER to start
a new line—Microsoft Word will automatically wrap your sentence at the end of the line.
To move the cursor from its position at the end of your sentence to anywhere else on the
page, use the mouse or the arrow keys to move the cursor where you want the letters or
spaces to be (left-click the mouse to place the cursor) and then type what you want to
add—the text will automatically adjust to include it. Press ENTER to start a new paragraph
(this is sometimes called a “carriage return”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Word can delete text on the screen and leave no trace—it is as if you never typed on the
page in the first place. There are two different buttons on the keyboard that will allow you
to erase text. They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the



keyboard map on page. The “Backspace” key deletes words to the LEFT of the cursor,
and the “Delete” key deletes words to the RIGHT of the cursor.



BACKSPACE ↔ DELETE

Let’s assume that the vertical line dissecting the word “creative” in the example above is

Our cursor. Pressing the “Backspace” key will erase “a,” “e,” “r,” “c,” and so on, moving LEFT.

The “Delete” key will erase “t,” “i,” “v,” “e,” and so on, moving RIGHT.

To delete a whole chunk of text at once, left-click with your mouse and drag to highlight a

section of text. Then simply press “Backspace” or “Delete” and all of the highlighted Text

will disappear.

Undoing and Redoing

The UNDO and REDO features of Microsoft Windows applications are great tools to rely
on. The program will keep a list of the last 25 commands that you have performed, and it
allows for taking “one step” backwards in order to erase what you have just done. Click
on the UNDO button in the Quick Access Toolbar to go back one step. Click on the REDO
button in the Quick Access Toolbar to go forward one step.

Formatting Text

Changing the look of what you’ve written is called “formatting.” This can include changing
the text style, size, color, and more. This is a sentence that features many different fonts.
This is a sentence that features many different sizes. From the Home Tab, the “B” will
make your text BOLD, the “I” will put it in italics, and the “←” will add an underline to your
text. These features do not have to be used independently of each other—in other words,
you can bold, underline, and italicize a single piece of text. The alignment of the text can
be altered using the buttons with the horizontal lines on them. You can align text To the
LEFT, To the CENTER and to the RIGHT.

In order to apply certain stylistic or formatting changes to text, you must first
HIGHLIGHT the text. This is a common procedure in Microsoft Windows applications, And
because it is so useful, it is a skill worth practicing. You can also change the font color by
clicking on the appropriate buttons in the

Formatting Toolbar. Experiment and remember—you can always start over with a fresh,
new document, so don’t worry about making mistakes! If you do, however, there is always
the incredible “←NDO” tool. Cutting, Copying, and Pasting Text in MS Word, you can CUT
or COPY text from one area of the document and save that text to be PASTED elsewhere
(these commands are found on the Home Tab). When you CUT text, you actually delete
it from where you took it, as opposed to COPYING it, which makes a copy of your
selection.



When you CUT or COPY text, it is stored on the CLIPBOARD. The Clipboard is a tool in
MS Word that stores cuts and copies of your work, to be pasted in other places in the
document. Once your selection is on the CLIPBOARD, you can PASTE it as many times
as you want! CUTTING a selection will place it on the clipboard, just in case you want to
PASTE it elsewhere. To CUT a selection, first highlight it. Then, click on the CUT icon
from the Home Tab. The highlighted text will disappear, as you have just cut it out, but a
copy is now on your clipboard, and MSWord is waiting for you to paste it somewhere else.

To PASTE this cut selection, place your cursor where you want the selection to go. Click
on the PASTE icon from the Home Tab toolbar, and it will pop the text into place, right
where you have your cursor. To COPY, simply follow those same steps, replacing the
CUT command with COPY. The COPY command will not alter your original selection at
all, as it simply makes a copy of the selection without changing or deleting it in any way.

DOING MORE WITH MICROSOFT WORD

Inserting Images and Clip Art

With MicrosoftWord, you can insert pictures in your document using the Insert Tab toolbar.
↔ou can insert pictures from the “Clip Art” album that comes with the program, or you can
insert pictures from a file that you have previously saved on a disk or elsewhere on the
computer (e.g., the My Pictures folder).Clip Art is a collection of cartoon and computer-
generated images that cover a broad array of commonly needed icons and pictures. These
include business, holiday, nature, entertainment, academic and other themes, along with
standard bullets and symbols.

To insert a clip art picture into a Microsoft Word document, you will first need to place
your cursor (left-click) where you wish to insert you picture in your document. Then, from
the Insert tab on the Ribbon, click on “Clip Art.” A Clip Art search box will appear on the
right side of your screen. From here, you can enter a search word for the picture you would
like to find. Then click “Go.” This will show all the options of pictures you can insert. When
you see a piece of clip art that you like, click on it, and it will automatically insert into your
document, in the exact place where you left the cursor. To resize your image, grab one of
the corners of the image by left-clicking and holding—drag it to your desired size and fine-
tune the placement. The cursor will change from a typing icon to a double arrow when it
can be used to resize an image.

Drag the corner toward the upper-left corner of the screen, and the image will grow. Drag
toward the bottom-right, and it will shrink. You can move the image to another place in the
document by left-clicking and holding on the center of it; drag it to its desired location.
More options, such as aligning the image with text (or special effects like wrapping text
around or through an image) can be found by clicking on the picture, and then choosing
the Picture Tools Tab. You can also insert a photograph or other images from your files
using this same process. On the Insert Tab, click on Picture and locate the files that you
want to include.

Modifying Line Spacing



Line spacing in Word refers to the amount of space between lines of text. The default in
Word 2010 is 1.15 spacing, which leaves a little bit more space than single-spacing, or
what you would find in a normal book. Single spacing is generally easy for the eye to read.
There may be times, however, when you want to change this spacing. One common option
is to double-space text: This text is double-spaced. Double-spacing is especially useful if
someone else is proof reading your document. It allows for more room to write comments
on the page.

To change the line spacing:
1. Select text you want to format by highlighting it.

2. On the Home Tab, click on the Line Spacing button in the Paragraph group.

3. Choose the spacing you want from the menu that appears. For more options, select Line
Spacing Options. In the dialog box that appears, you can choose other spacing options,
including spacing between paragraphs. This can be done by changing the values in the
Before and After boxes.

Creating Bulleted and Numbered Lists

Word allows you to create lists within your document that can be organized with bullets or
numbers. Lists are useful for presenting text that wouldn’t make the most sense in
paragraph form (for example, step-by-step instructions) or for emphasizing key points
Bullets are usually small circles at the beginning of item in a list, and numbers are used
for lists that are arranged in sequential order. Here’s an example of a bulleted list:

• Bananas
• Milk
• Eggs
• Ice Cream

To create a list:

1. On the Home tab, select either the Bullets or Numbering buttons from the Paragraph
group. If you want to choose a particular style for your bullets or numbers, click on the
triangle next to the button and choose a style from the menu that appears.

2. You will see the first bullet or number appear on your document. Type your first line of
text and then hit Enter.

3. Another bullet or number will appear automatically. Type your next line of text and hit
Enter.

4. When you have finished your list, hit Enter twice to end the bullets or numbering.

Changing Views and Overall Look



There will be times when you need to create documents that don’t fit on a standard piece of
paper (8.5” by 11”).



Click on the Page Layout Tab.

From this menu, you can alter the margins, width, height, and orientation (portrait =
11”14long; landscape = 11” wide) of the document, as well as choose from a variety of
templates, different types of paper, and document styles that come with the program. To
change the orientation of your page, click on the Orientation button.
Click on Landscape from the drop-down box that appears. Your document should now be
in landscape position. If you wish to return to portrait orientation, go through the same
steps, clicking on the Landscape option instead of Portrait. If you would like to change the
display of your document or zoom in and out without affecting the way your document will
print, you can do that from the View Tab. Anything you change from the View Tab will not
change the way your document prints out. So if you want your text to be bigger when you
print out the document, make sure to change the size of the font instead of the zoom.

Spelling and Grammar Check

One benefit of using a computerized word processor is its ability to recognize, change,
and give advice about your writing. MS Word has utilities that can check your spelling and
grammar against a master database, and can offer advice on a variety of different
grammatical styles. MS Word automatically underlines any words that it does not
recognize in red, assuming that they are not spelled correctly, and underlines in green if
it does not recognize the grammatical pattern, assuming that the sentence does not make
sense.

For example: In this case, “jumping” should read “jump” and “laziy” should be “lazy.” If you
right click on the word, a menu with pop up with options, including “Ignore” if you do not
want help on this specific phrase or agree with the suggestion. You can also choose to
add words to the MS Word spelling database, if you are going to use them often and don’t
want them to be flagged as misspelled every time—this is especially useful for names, as
MS Word often interprets these as misspellings. The spelling and grammar tools can be
found in the Review Tab

USING MICROSOFT WORD

Microsoft →ord is an example of a program called a “word processor.” →ord processors
are used to create and print text documents in much the same way that you would use a
typewriter. The key benefit to using a word processor is that you can make changes easily,
including correcting spelling; adding, deleting, formatting, and relocating text; and inserting
images. Once you create a document, you can effortlessly print it (as many copies as you
want!), save it for later modifications, or send it to a friend via e-mail. Microsoft Word is a
very powerful word processor—This handout was created using just a small number of its
features! Microsoft Word is available on both PCs and Macs, so what you learn in class
today should be applicable to any computer you use. The program may look slightly
different depending on the version and computer that you’re using, but Microsoft Word will
function in the same basic ways. There are other word processors out there, including
OpenOffice.org Writer, WordPerfect, Apple Pages, and WordPad. They have many
features in common with Microsoft Word, and you should feel free to choose any program
you prefer.



Opening Microsoft Word
To get started with Microsoft →ord (sometimes called “MS →ord”), you will need to locate
and open the program on your computer. To open the program, point to →ord’s icon on
the desktop with your mouse and double-click on it with the left mouse button. If you don’t
see the MS →ord icon on your desktop, you’ll have to access the program from the Start
Menu. Click on the button in the bottom left corner to pull up the Start Menu. You should
see the MS Word icon here, so click on it once with your left button. If you still don’t see
it, click on “All Programs” and scroll through the list of programs until you find it. Click once
with your left button to open the program.

Occasionally, Microsoft →ord will be in a folder called “Microsoft Office” or something
similar—this will make one more step between “All Programs” and “Microsoft →ord.”MS
→ord will then open a blank page called “Document 1.”This is an image of the upper-left
corner of MS Word. This box features two important pieces of information: the name of
the file that you are currently working on (in this case, “Document 1” since we have not
yet renamed it) and which program you are using (“Microsoft →ord”).There should now
be a blinking line in the top left corner of the part of the screen that looks like a sheet of
paper. This means you will be able to type in this space!

MICROSOFT WORD BASICS

Typing Text

To enter text, type just as you would if you were using a typewriter. To capitalize a letter,
hold down the SHIFT key while typing the letter. Or, press the CAPS LOCK key on the
left-hand side of your keyboard. You will have to press the CAPS LOCK key again—once
you are done capitalizing—to remove the lock. You do not need to press ENTER to start
a new line—Microsoft Word will automatically wrap your sentence at the end of the line.
To move the cursor from its position at the end of your sentence to anywhere else on the
page, use the mouse or the arrow keys to move the cursor where you want the letters or
spaces to be (left-click the mouse to place the cursor) and then type what you want to
add—the text will automatically adjust to include it. Press ENTER to start a new paragraph
(this is sometimes called a “carriage return”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Word can delete text on the screen and leave no trace—it is as if you never typed on the
page in the first place. There are two different buttons on the keyboard that will allow you
to erase text. They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the
keyboard map on page.

The “Backspace” key deletes words to the LEFT of the cursor, and the “Delete” key deletes
words to the RIGHT of the cursor.

Microsoft Word Features



The Title Bar



This is a close-up view of the Title Bar, where file information is located. It shows the name
of the file (here, “Microsoft Word”) and the name of the program (“Microsoft →ord”). Notice
the three buttons on the right side, controlling the size and closing of the program.

Minimize: Left click this button to shrink the window down to a small button that will appear in
the task bar

Maximize: Left click this button to make the window as large as it can be—it should take up
your entire screen.

Close: Left-click this button to close the window. The program will close and stop running. Make
sure you save your work first!

Restore Down: Left-click this button to make the window smaller without minimizing it.

The File Menu

In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the
top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in the
Ribbon called “File.” When you left-click on this tab, a drop-down menu appears. From
this menu, you can perform the same functions as were found under the Microsoft Office
Button menu, such as: Create a new document, open existing files, save files in a variety
of ways, and print.

The Home Tab

The most commonly used commands in MS Word are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
that can change the font, size, color, alignment, organization and style of the text in the
document. For example, the “Times New Roman” indicates the FONT of your text, the
“12” indicates the SI↕E of your text; etc. →e will go over how to use all of these options
toformat your text in a little while. Each of these options expands into a menu if you left-
clickon the tiny down-arrow in the bottom right corner of the window.

The Ruler

The ruler is found below the Ribbon. The ruler tells you where you are on the page, along
with the dimensions of the overall document. Just like a real piece of paper, the default
setting is 8.5 x 11 inches, and the margins have been incorporated for you. Similar to most
options in MS Word, this is entirely customizable and the user can create a document of
any dimensions.

Keyboard Review

In order to use MS Word effectively, you must input commands using both the mouse and the
keyboard. The above image of a keyboard should look similar to the keyboard in front of you;
learning just a few certain keys will help to improve your efficiency in typing, as well as present



you with more options within the program. The following is a list of commonly used keys that



have special functions in MS Word (key functions can change depending on which program
you are using)

1. Backspace: This key deletes letters backward.

2. Delete: This key deletes letters forward.

3. Shift: This key, when pressed WITH another key, will perform a secondary function.

4. Spacebar: This key enters a space between words or letters.

5. Tab: This key will indent what you type, or move the text to the right. The default indent
distance is usually ½ inch. 6. Caps Lock: Pressing this key will make every letter you type
capitalized.

7. Control (Ctrl): This key, when pressed WITH another key, performs a shortcut.

8. Enter: This key either gives you a new line, or executes a command (pressed in MS Word, it
begins a new line).

9. Number Keypad: These are exactly the same as the numbers at the top of the keyboard;
some people just find them easier to use in this position.

10. Arrow Keys: Like the mouse, these keys are used to navigate through a document or page.

MICROSOFT EXCEL
Microsoft Excel is an example of a program called a “spreadsheet.” Spreadsheets are
used to organize real world data, such as a check register or a rolodex. Data can be
numerical or alphanumeric (involving letters or numbers). The key benefit to using a
spreadsheet program is that you can make changes easily, including correcting spelling
or values, adding, deleting, formatting, and relocating data. You can also program the
spreadsheet to perform certain functions automatically (such as addition and subtraction),
and a spreadsheet can hold almost limitless amounts of data—a whole filing cabinet’s
worth of information can be included in a single spreadsheet. Once you create a
spreadsheet, you can effortlessly print it (as many copies as you want!), save it for later
modifications, or send it to a colleague via e-mail. Microsoft Excel is a very powerful.

Opening Microsoft Excel
To get started with Microsoft Excel (often called “Excel”), you will need to locate and open the
program on your computer. To open the program, point to Excel’s icon on the desktop with your
mouse and double-click on it with the left mouse button. If you don’t see the Excel icon on your
desktop, you’ll have to access the program from the Start Menu. Click on the button in the
bottom left corner to pull up the Start Menu. You may see the Excel icon here, so click on it
once with your left button. If you still don’t see it, click on “All Programs” and scroll through the



list of programs until you find it. It may also be located in a folder called “Microsoft Office” or



something similar—it will depend on your specific machine. Click once with your left button to
open the program. Excel will then open a blank page called “Book1.”

Microsoft Excel Features

The Title Bar
This is a close-up view of the Title Bar, where file information is located. It shows the name
of the file (here, “Book1,” the default title) and the name of the program (“Microsoft Excel”).
↔ou will be able to name your file something new the first time that you save it. Notice the
three buttons on the right side of the Title Bar, controlling the size and closing of the
program.

The Ribbon Menu System
The tabbed Ribbon menu system is how you navigate through Excel and access various
Excel commands. If you have used previous versions of Excel, the Ribbon system
replaces the traditional menus. At the bottom, left area of the spreadsheet, you will find
worksheet tabs. By default, three worksheet tabs appear each time you create a new
workbook. On the bottom, right area of the spreadsheet you will find page view
commands, the zoom tool, and the horizontal scrolling bar.

The File Menu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the
top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in the
Ribbon called “File.”→hen you left-click on this tab, a drop-down menu appears.
From this menu, you can perform the same functions as were found under the Microsoft
Office Button menu, such as: Create a new worksheet, open existing files, save files in a
variety of ways, and print.6



Quick Access Toolbar On the top left-hand side of the Title Bar, you will see several little
icons above the File menu. These let you perform common tasks, such as saving and
undoing, without having to find them in a menu. →e’ll go over the meanings of the icons
a little later.

The Home Tab
The most commonly used commands in Excel are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
that can change the font, size, color, alignment, organization and style of the text in the
spreadsheet and individual cells. For example, the “Calibri” indicates the FONT of your
text, the “11” indicates the SIZE of your text; etc. We will go over how to use all of these
options to format your text in a little while. Each of these options expands into a menu if
you left-click on the tiny down-arrow in the bottom right corner of the window. This tab
works the exact same way as the MS Word Formatting Toolbar. The main difference is
that the format changes will only affect the selected cell or cells, all unselected cells remain
in the default setting (“Calibri” font, size “11”).

Equation Editor
The Equation Editor is generally found below the ribbon menu. The left side denotes
which cell is selected (“C5”) and the right side allows you to input equations or text into
the selected cell.
There are two ways to input information into a cell. You may either select an individual cell
and type the equation or text into the equation editor or type the equation or text directly
into the selected cell. Equations (for example, =SUM(D5+E5)) will automatically be hidden
inside the cell and can only be viewed using the equation editor; the result of the equation
will display in the cell. If any written text is longer than the cell width, then the spreadsheet
will cover up any portion longer than the cell width. The information will still be in the cell,
you just won’t be able to see it at all times.

Keyboard Review
In order to use Excel effectively, you must input commands using both the mouse and the
keyboard. The above image of a keyboard should look similar to the keyboard in front of
you; learning just a few certain keys will help to improve your efficiency in typing as well
as present you with more options within the program. The following is a list of commonly
used keys that you may already be familiar with:
1. Backspace: This key deletes letters backwards.
2. Delete: This key deletes letters forward.
3. Shift: This key, when pressed WITH another key, will perform a secondary function.
4. Spacebar: This key enters a space between words or letters.
5. Tab: This key will indent what you type, or move the text to the right. The default indent
distance is usually ½ inch.

6. Caps Lock: Pressing this key will make every letter you type capitalized.
7. Control (Ctrl): This key, when pressed WITH another key, performs a shortcut.
8. Enter: This key either gives you a new line, or executes a command.
9. Number Keypad: These are exactly the same as the numbers at the top of the keyboard;
some people just find them easier to use in this position.

10. Arrow Keys: Like the mouse, these keys are used to navigate through a document or page.



Pointer Shapes
As with other Microsoft programs, the pointer often changes its shape as you work in
Excel. Each pointer shape indicates a different mode of operation. This table shows the
various pointer shapes you may see while working in Excel.

MICROSOFT EXCEL BASICS

Formatting Cells
Cells are the small rectangular boxes that make up the spreadsheet. All the information
entered into an Excel spreadsheet is entered into cells. The cell width and height will
usually need to be adjusted to view all the information entered into a cell.

To adjust the cell width, move the mouse pointer in between two cell columns in the
column header. Hold down the left mouse button and drag the mouse left to shorten the
width or right to expand the width. Notice that all cells within the column are automatically
adjusted. Adjust the cell height using the same method. Move the mouse cursor between
two rows, hold down the left mouse button and move the mouse up to decrease the height
and down to increase the height. Before you begin entering data into a spreadsheet, you
may already know the width and height you want your cells to have. In this case, you can
adjust all the widths and heights by doing the following: Select the “square” between
Column A and Row 1.

This will select ALL the cells in the spreadsheet. From the “Home” tab of the Ribbon Menu,
within the “Cells” box, click on “Format,” and select Row Height. ↔ou will now be asked
to enter a numerical value for height. The default value is 15, but you can enter your own
height value (10, 20, 25, etc.).

Repeat the same steps for Column width. From the “Home” tab of the Ribbon Menu, within
the “Cells” box, click on “Format,” and select Column →idth. Note that the default value
for the width is 8.43. Enter your own width value (5, 10, 15, 20, etc.).

For any given cell or selected cells, you can also format the way your data is represented within
the cell(s). Select a single cell or multiple cells.
Again, from the “Home” tab of the Ribbon Menu, within the “Cells” box, click on Format.”
Select “Format Cells.”The format window will now appear, giving you a wide variety of
options on how to format your cell.

Number – This allows you to choose how to represent the numbers that are entered into a
cell (number, currency, time, etc.).
Alignment – This determines how the data will be aligned within the cell (left-side, centered, or
right-side).
Font – Select the type of font to be used within the cells.
Border – This option lets you choose what type of border, if any, you would like around the
cells or some of the cells.
Fill – This allows you to change the background color of the cell.
Protection – This option allows you to “lock” cell information so that other users cannot
make changes. Typing in Cells



Click on a cell to begin typing in it. It is that easy! When you are finished typing in the cell,
press the Enter key and you will be taken to the next cell down. You can then begin typing
in that cell. You can easily navigate around the cells using your arrow keys. Keep in mind
that the Formatting toolbar in Microsoft Excel 2010 is exactly the same as the one used
for Microsoft Word 2010. The biggest difference between the two programs is that, in
Excel, the format is set for each individual cell.

So if you change the font and applied the bold option in cell C5, then this format will only
be applied to cell C5. All remaining cells will remain in default mode until they have been
changed. Sometimes you may only wish to adjust the format of one particular cell. In this
case, simply select the cell by clicking the mouse on it and make any necessary
adjustments to the font, size, style, and alignment. Those changes will not carry over when
you begin typing in a new cell. Other times, you may wish to adjust the text format of a
group of cells, entire rows, or entire columns.

In Excel, you can choose groups of cells in rectangular units—all the
cells you select must form a rectangle of some kind. To select a group of cells, begin by
clicking on the cell that would be in the upper-left hand corner of your rectangle. Hold
down the Shift key on your keyboard and use the arrows (, , , ) on the keyboard to expand
the selection of cells, or click and drag your mouse. Once the group of cells has been
selected, you can make adjustments to the font, size, style, and alignment and they will
be applied to all selected cells.

To select an entire row, click on the Row Number with your mouse—note how the entire
row becomes highlighted. All formatting changes will now be applied to the whole row. To
select an entire column, click on the Column Number with your mouse—again, the entire
column will become highlighted. All formatting changes will be applied to the whole
column.

Inserting Rows and Columns.
When you are working on a spreadsheet, you may realize that you left out a row or column
of data and need to add it in. To insert a row, click on the row below where you want your
new row to be (remember to click on the row number to highlight the entire row). From the
“Home” tab, within the “Cells” box, click “Insert.” Select

“Insert Sheet Rows.” A new row will automatically be inserted and the row numbers
automatically adjusted. To insert a column, click on the column to the right of where you
want your new column to be (remember to click on the column letter to highlight the entire
column). From the “Home” tab, within the “Cells” box, click “Insert.” Select “Insert sheet
Columns.” A new column will automatically be inserted and the column letters
automatically adjusted.

Sorting Data
Once you have created your spreadsheet and entered in some data, you may want to
organize the data in a certain way. This could be alphabetically, numerically, or another
way. Let’s look at the following spreadsheet as an example. This information can be sorted
by check number, date, alphabetically by description, or using any of the other columns.



First, select all the cells that represent the data to be sorted, including the header
descriptions (Check No., Date, Description, etc.). Then, select the first cell in Row 1
(Check No.) Click and drag to select all the cells that you want to sort. Using the mouse,
select Sort & Filter from the Editing panel. Select Custom Sort…
Select the column you wish to sort by. Do you want to sort by alphabetical order, reverse
alphabetical order, date, or amount? →hen you press “OK,” your spreadsheet will be
sorted in the order that you specified.

AutoSum and Excel Equations
One of the most powerful features of Excel is its ability to perform basic math functions on
data. Excel can add, subtract, multiply, divide, find the average, and perform general
counting functions on the numerical data that you enter. To enable this feature, highlight
all of the cells in a column, plus one additional empty cell in which to display the result.

Select the AutoSum icon from the ribbon menu:
If you click directly on the ∑, Excel will automatically add up the numbers you have
selected. If you click on the little dropdown arrow next to it (▼), you will get the full choice
of mathematical functions. If you double-click on the cell in which the answer appears, you
will see an equation that looks something like this (you will also see this equation in the
Equation Editor):
Let’s break down what exactly the equation means:
= indicates that you are starting an equation in this cell.
SUM tells the function to be performed. In this case, all the cells will be added together.
( ) The parentheses contain the cells that the function will be performed on.
D2 This is the first cell to be included in the addition formula.
D8 This is the last cell to be included in the addition formula indicates that all cells between the
first and the last should be included in the formula.
The spreadsheet will often “select” the cells that it thinks you wish to include. But you can
manually change the cell range by typing into the Equation Editor. When you are ready to
execute the formula, just press the “Enter” key. Other mathematical functions you can
perform from the AutoSum button include:
Average – This function will calculate the average of the selected cells.
Count Numbers – This function simply counts the number of cells selected.
Max – This function will return the highest value of the selected cells.
Min – This function will return the lowest value of the selected cells.
*Remember* Excel equations are similar to programming languages, so have some
patience and if at first you don’t succeed, try again. Even Excel professionals create
incorrect formulas on their first try.
Once you get an equation to work, you will technically be a computer programmer!
Creating Charts and Graphs:
In Excel, there are also ways to represent your data in chart or graphical forms. To create
a chart or graph, select the Insert tab from the Ribbon Menu bar. In the middle of this new
menu, you will see a “Charts” box.
1. Select the range of data to be represented in the chart or graph. Click on your
spreadsheet and select the data to be represented using the same method that you used
to select data in the sorting exercise. For this example, we want to see a visual comparison
of how much money we spent on each item in the list. Select rows 1 through 8 in rows B,



C, and D.



2. Select the type of chart or graph you wish to create (for our example, we’ll choose a
bar graph).
3. Once you have created your graph, you can now “customize” it by giving it a title and
labeling different parts. You can also make certain design decisions regarding the
appearance of your graph or chart by choosing the different elements under the Design
tab that appears on the Ribbon Menu bar.
4. Finally, you will need to decide if your chart should be pasted on to the existing
spreadsheet or if it should be pasted on to a brand new sheet. On the very right side of
the Ribbon Menu bar, select Move Chart. Once the chart or graph has been created and
you realize a mistake has been made or it did not turn out the way you wanted it to, simply
click on the chart or graph and hit the Backspace key on your keyboard to delete it from
your spreadsheet. Don’t be afraid to go back and try again!

Multiple Sheets

Sometimes you may find it useful to have multiple spreadsheets for related data. For
example, personal finances are usually tracked on a monthly calendar and it’s generally
good idea to keep records of the past transactions. Excel can create multiple spreadsheets
attached to the same Excel file, one for each month. Tabs for the different sheets are
located in the lower-left corner of the spreadsheet. The spreadsheet that is currently being
worked on is on the top tab. To access another spreadsheet, select the appropriate tab,
such as Sheet 2. The default names for the sheets are usually Sheet1, Sheet2, and Sheet3.
To rename a sheet or to create a new sheet, simply move the mouse pointer over the sheet
name and right-click. Select “Rename” to rename the sheet or select “Insert” to create a
new sheet.

You can transfer cell information between two or more sheets by creating a simple formula.
For example, most people who keep track of their personal finances don’t begin every
month with a balance of $0. Instead, the balance at the beginning of the month is
transferred over from the previous month. So if you have a March 2012 finance
spreadsheet and an April 2012 finance spreadsheet, you can select a cell in the April 2012
sheet and write in the formula

=‘March 2012’!D11
The equals sign (=) tells Excel that the value for this cell is to be derived from somewhere in the
spreadsheet (such as a formula or another cell location).
‘Sheet name’ tells Excel what sheet to refer to when it retrieves the value. The single
quotation marks (‘ ‘) are important. ! D11 tells Excel that it is to copy the value that is
located in cell D11 (or whatever cells you wish to copy the value from).
If you want to transfer cell information from one cell to another on the same sheet, you can
use the exact same formula; just exclude ‘Sheet name.’

DOING MORE WITH MICROSOFT EXCEL

Cutting, Copying, and Pasting Data
When you are typing in your spreadsheet, it can be very helpful to cut or copy information
from one cell and paste it into another. This can help reduce the amount of typing you



have to do, as well as limit the number of typographical errors. Cutting, copying, and
pasting the contents of cells in Excel is very similar to the way you do it in Microsoft Word.
These commands are all accessible from the Home tab on the Ribbon Menu bar. To CUT
the contents of a cell, click on the cell to select it, then click on the Cut button on the Home
tab. ↔ou will see the border of the cell turn into little “marching ants.” The contents are
now on the Clipboard, ready for you to paste them somewhere else.

To PASTE the cut selection somewhere else, click on the cell where you want the
selection to go. Then click on the Paste button on the Home tab. The selection will now
appear in the new cell and be removed from the original cell.

To COPY the contents of a cell, simply follow the directions above but replace the CUT
command with COPY. This will leave the contents of the original cell in place and make
an exact copy of them in another cell.

Filling Data across Columns and Rows
Another way to copy text from one cell to another is to drag it or “fill” it across a range of
cells (a row or a column). This is a great method if you want all the text (or numbers) in
column or row to be the same. For example, if you have a spreadsheet for your yearly
budget with a column for rent, you could use this method to fill in all the cells in the rent
column with the same number without re-typing.

To fill the contents of cells in a column:
1. Click on the cell with the information you want to copy to the other cells.
2. Hover your mouse over the little square (called a “fill handle”) in the bottom right corner of the
highlighted cell border. Your mouse will turn into a cross.

3. Click on the fill handle and drag your mouse (while still holding the button down) down the
column until you’ve highlighted all the cells where you want the text to go.

4. Let go of the mouse button. The text will now appear in all the cells you highlighted.
5. You can follow these same steps to fill the contents of a row rather than a column— simply
drag your mouse across the row instead of down the column.

You can also use this technique to copy formulas across columns and rows in the spreadsheet.

CLOSING MICROSOFT EXCEL

Saving Spreadsheets

When you finish your spreadsheet and want to leave the computer, it is important to save
your work, even if you are printing a hard copy. To save your work in Excel, it is essential
to know WHAT you are trying to save and WHERE you are trying to save it.
Click on the File Tab, then click “Save As” to get started. You can change the filename
that Excel has chosen just by typing a new one in the “File name” box at the bottom of the
window that appears. The My Documents folder on your computer’s hard drive is a good
place to store your documents. A blank CD or a USB jump drive are great portable storage
options and can contain a LOT of data. Excel will automatically save your document with
the suffix “.xlsx”–this is simply a tag that lets Excel know that your work is specific to this
program and what version it is in. You do not have to type it–just highlight what is there



(default is “Book1”) and write a new file name.↔ou may also chose to save it in an older



format so that it can be opened with older versions of Excel. After the first save, you can
just click “Save” to preserve your work.

However, it is important to note that every following command of SAVE will overwrite your
original file, creating the most up-to-date version. If you would like to keep saving different
versions of your worksheet, be sure to use the “Save As” function each time you save,
using a slightly different name for each version.

Printing Spreadsheets
To print your Excel document, click on the File Tab, then click “Print” from the left-side column.
A Print Preview and printing options will appear in your Excel window.
Click the large “Print” button to send your worksheet to the printer.↔ou can change the
number of copies you would like to print, change the paper orientation, choose which
printer you want to use, and more.

Finding More Help
You can get help with Excel by clicking on the Question Mark symbol in the upper-right
hand corner of the main menu bar or by pressing the “F1” button. This will take you to help
from Office.com, Microsoft’s help website. There are also many other resources and
tutorials available online.↔ou might try a Google search with the words “Excel 2010” and
the function you are trying to perform. Ask your instructor for help finding these resources
if you have any trouble.

Closing the Program
Click on the File Tab, then click “Exit.”
OR
Click on the X in the top right corner of the Excel screen.

MICROSOFT POWERPOINT
Microsoft PowerPoint is a professional presentation program that allows the user to create
"presentation slides" that can be displayed on the computer screen or through a projector
that is plugged in to the computer. A PowerPoint presentation is a good way to convey
pieces of information, usually in the form of an outline, to a large audience. Generally,
PowerPoint presentations are appealing to users because they are easy to create and
edit and generally small enough to fit onto a CD or a USB Jump Drive. Therefore, a user
does not have to carry around any slides or a slide project, and, if necessary, can make
last-minute changes to the presentation.



Microsoft PowerPoint Components:

Before you get started with Microsoft PowerPoint (commonly referred to as PowerPoint),
you will need to locate and open it on the computer. It may be on your desktop.
On the computer desktop:
1. Double-click on the MS PowerPoint icon
If the MS PowerPoint icon is not on the desktop, go to the Start menu:
1. Click ►Start ► Programs ►Microsoft PowerPoint*
MS PowerPoint will open a blank page called "Presentation1."

The Title Bar
This is a close-up view of the Title Bar, where file information is located. Notice the default
title "Presentation1." You will get a chance to rename your presentation slides the first
time you choose to save it.

The Menu Bar
The Menu Bar is a common sight in almost all Microsoft Windows programs. It features
text based menus, on which virtually every option available to the user in the entire
program is listed.
Each menu expands when clicked (with the left mouse button), offering many options
categorized by specific tasks.

Standard Toolbar
Toolbars provide "shortcuts" to commands also found in the Menu Bar. Toolbars are
usually located just below the Menu Bar and exist to offer another way to perform the
same task.
The most commonly used commands in MS PowerPoint are also the most accessible.



Some of these commands are:
New | Open | Save | Print | Preview | Spell-check | Copy | Paste | Undo | Insert



Formatting Toolbar
The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization, and style of the text in the presentation slides. For example, (starting from
the left side of the Toolbar) the "Arial" indicates the FONT of your text; the "32" indicates
the SIZE of your text; and so on. This toolbar works the exact same way as the MS Word
Formatting Toolbar. The main difference is that the format changes will only affect the text
box in which you are currently working.
All other text boxes will remain in the default setting ("Arial" font, size "32"). Design/New
Slide Icons additional shortcut icons appear on the MS PowerPoint toolbar: the Design
icon and the New Slide icon. Both commands are frequently used, and it is good to be
familiar with their location on the toolbar.

The Design icon is a shortcut to the slide design page. Here you will be
able to create and edit the appearance of your slide(s). The New Slide icon automatically
adds a new, blank slide for you to work on. You can keep track of the slides you have
already worked on in the Slide Outline box on the left-hand side of the screen. You can
access a slide at any time by clicking on it with your mouse through this screen.

SIMPLE TASKS IN MICROSOFT POWERPOINT
Text Boxes:
Text Boxes are "designated" areas that allow you to type words, sentences, and bullet
points into the slide. You can adjust the size and placement of the text box within any
given slide. It is also possible to have multiple text boxes per slide.

When you first open MS PowerPoint, there will automatically be two text boxes on the slide:
"Click to add title" and "Click to add subtitle." These text boxes already have a preset
format applied to them. The "title" box has a font size of "44" while the "subtitle" box has
a font size of "32." You can change the text format of any box at anytime by adjusting the
format settings on the Formatting Toolbar. To adjust the size of the text box, first click on
the text box. Notice the change in border. Once you have clicked on a text box, the border
of the box becomes thicker and little circles appear on the corners and at the midpoints of
the box. Move the mouse pointer over any one of the circles. Notice that the mouse pointer
will change to either or . Click and hold down the left mouse button. To adjust the height,
move the mouse up or down; to adjust the width, move the mouse left or right. Note that
the corner circles can adjust both height and width, while the mid-point circles can only
adjust either height or width.

To move the text box to a different location on the slide, move your mouse pointer over
any part of the thick, gray box outline. Notice the change in your mouse pointer (it will look
something like a "plus" sign (+) with arrows). Click and hold down the left button on your
mouse. You can now drag the text box to any position on the slide by simply moving your
mouse. To write in a text box, simply click inside the box with your mouse.
When a cursor is flashing, you are ready to type.

Slide Design:

One of the more popular features of MS PowerPoint is that it gives the use a wide variety



of design choices. At some point, you may wish to change the design and color of the



background of your slides. To do so, simply click on the Design icon. On the righthand
side of your screen, the "Slide Design" pane will appear. Here, you are given three design
options to apply to your slides.

Design Templates: Here is a list of over 20 templates that you can choose from to apply
to the background of your slides. For each template, you have the option of applying the
design to all slides or to only the selected slide. You can view these options by clicking on
the arrow on the right side of the template. If you are connected to the Internet, you can
also choose to view hundreds of additional templates by choosing "Design Templates on
Microsoft Office Online" on the bottom of the template screen.

Color Schemes: This option gives you a variety of color schemes to choose from to apply to
your selected design template.

Animation Schemes: This option will allow you to select different types of animation that
can be applied to either all the slides or selected slides. The animation schemes are
different ways the slides are "introduced" to your audience, such as "faded wipe" or
"pinwheel."

Designing your own background:

Sometimes you may wish to design your own background.
To do this, select Format ► Background… from the Menu Bar. Select the Color Bar on
the bottom of the Background window and choose the appropriate color and or/effects
that you desire. There is no right or wrong way to design your own background, so if you
choose this option, have some patience and don't be afraid to experiment.

Slide Layout:

The default in PowerPoint for each new slide is to have a Title text box and a Text box. As
discussed earlier, you do have the option of rearranging the text boxes to fit any layout
you have in mind. However, sometimes it will be easier simply to select a layout that fits
your needs rather than reformatting the default layout for each slide. To choose a slide
layout, select Format ► Slide Layout from the Menu Bar. On the right-hand side of your
screen, the "Slide Layout" pane will appear. From here, you have the option of applying a
slide layout either to a selected slide or to a new slide that has yet to be inserted. You can
view these options by clicking on the arrow on the right side of the template.

Note the four different types of layout categories.

Text Layout: These options are for choosing a layout in which you are only organizing different
text boxes. There is no room for pictures, charts, or graphs.

Content Layout: These options are for choosing a layout that will only contain pictures, charts,
or graphs. There is no room for text boxes.

Text and Content Layout: These options have room for both text boxes and pictures, charts, or
graphs.



Other Layouts: These layouts are designed for other media content such as video clips or
audio tracks.

Inserting a Picture:

Inserting a picture into MS PowerPoint is very similar to inserting a picture into MS Word.

1. Select the slide that you wish to add a picture to.

2. From the Menu Bar, select Insert► Picture► From File (or Clip Art).

3. Choose the picture you wish to insert and select "Insert."

*Note*: The picture will be inserted in its original size, so you will probably have to resize
it. You can re-size a picture the same way you re-sized a text box. Click on the picture
and note the circles at the corners and at the midpoints of the length and width. Move your
mouse pointer over the circles, left-click the mouse and hold the button down. Move the
mouse vertically or horizontally to re-size.
Rotating a picture: It is possible to rotate pictures in MS PowerPoint. Once a picture has
been inserted onto a slide and you have clicked on the picture so it is "outlined," notice
the green circle above the center of the picture.

Move the mouse pointer over the green circle, and left-click and hold the button down.
Now move the mouse either clockwise or counter-clockwise and the picture will rotate in
the same direction.

Inserting a Graph or Table:

There are two ways to insert a graph or table into a PowerPoint slide.

1. The graph or table may already exist in another document or file. If this is the case,
then you can simply insert the graph or table as you would a picture. Follow the
instructions under

Inserting a Picture.

Or you could Cut and Paste a graph or chart from another document or file into your slide
presentation.

2. MS PowerPoint can create graphs or tables directly in the slide. From the Menu Bar,
select

Insert ► Chart (or Table).

For the Chart option, PowerPoint will present a very simple bar graph.



You will need to go in and edit the information in the bar graph to conform to the
information you wish to represent in a chart. From the Datasheet, you can enter in the
appropriate values for the columns and re-name the entities.

The Table option will present you with the following window:

Select the appropriate number of rows and columns you wish to have in your table. Click
"OK" to insert the table. Once the table has been inserted you will be able to put
information into the table cells.

Slide Management:

Once you have completed a slide, you can create a new slide by clicking on the New Slide
icon. Notice that your previous slides still appear on the left-side frame. You can still
access your previous slides by simply clicking on them from this location.

Once all your slides have been completed, you can present your slides in a "slideshow." From
the Menu Bar select Slide Show► ↑iew Show. Notice that the slide takes over our
entire screen. To navigate through the slides, use the arrow
keys on your keyboard (, or , ).↔ou can also navigate through your slides by clicking on
the left or right arrows in the lower left corner of your slide. To end your slide show, click
on the square box on the lower left side of your slide show (this is difficult to see at first
because it is designed to blend into you slide show so it won't be noticeable to your
audience). Select End Show from the pop-up window.

CLOSING MICROSOFT POWERPOINT

Saving Slide Shows:

When you come to a stopping point and want to leave the computer, it is important to save
your work (even if you are printing a hard copy — saving should be a reflex). To save your
work in MS PowerPoint, it is essential to know WHAT you are trying to save as well as
WHERE you are trying to save it.

Click ►File ►Save from the Menu Bar to get started.

You can change the filename that PowerPoint has chosen just by typing a new one in the File
name box at the bottom of the window that appears.

MS PowerPoint will automatically save your document with the suffix “.ppt” – this is simply
a tag that lets PowerPoint know that your work is specific to this program. You do not have
to type it – just highlight what is there (default is “Presentation1”) and write a new file
name.

The My Documents folder on your computer’s hard drive is a good place to store your
documents. A blank CD (compact disc) or a USB Jump Drive are great portable storage
devices and can contain a LOT of data. It is important to note that every consequent



command of SAVE will overwrite your original file, creating the most up-to-date version. If



you want to save any changes to your PowerPoint slides without destroying the original
one:

In the Menu Bar, click►File►Save As from the menu bar and give your document a new
filename (unique from the original). To bring a saved document back up on the screen
from MS PowerPoint:

Click►File►Open from the Menu Bar. Locate where the file is located (which folder, that is)
and click on the filename of the document you want.

Click ►Open.

Printing Slides:

To print your MS PowerPoint slides:

Click►File►Print from the Menu Bar and a Print window will pop up on the screen.
Click►OK for your document to start printing.

As with all commands in MS PowerPoint, you can make changes along the way. From the
Print menu, you can alter how many copies will be made, in what order the pages will be,
and much more. Other useful tools are the Print Preview function found alongside the Print
command and the

Page Setup function. Print Preview will allow you to look over an exact copy of what will
come out of the printer before actually executing the print command.

Closing the Program:

When you are finished,

Click ►File ►Exit from the menu bar

OR

Click on the X in the top right corner of the computer screen.

INTERNET:

Introduction:

The internet in simple terms is a network of the interlinked computer networking worldwide,
which is accessible to the general public. These interconnected computers work by
transmitting data through a special type of packet switching which is known as the IP or
the internet protocol.

Internet is such a huge network of several different interlinked networks relating to the



business, government, academic, and even smaller domestic networks, therefore internet



is known as the network of all the other networks. These networks enable the internet to
be used for various important functions which include the several means of
communications like the file transfer, the online chat and even the sharing of the
documents and web sites on the WWW, or the World Wide Web.

It is always mistaken said that the internet and the World Wide Web are both the same
terms, or are synonymous. Actually there is a very significant difference between the two
which has to be clear to understand both the terms. The internet and World Wide Web are
both the networks yet; the internet is the network of the several different computers which
are connected through the linkage of the accessories like the copper wires, the fiber optics
and even the latest wireless connections. However, the World Wide Web consists of the
interlinked collection of the information and documents which are taken as the resource
by the general public. These are then linked by the website URLs and the hyperlinks.
Therefore World Wide Web is one of the services offered by the whole complicated and
huge network of the internet. The use of IP in the Internet is the integral part of the network,
as they provide the services of the internet, through different layers organization through
the IP data packets. There are other protocols that are the sub-classes of the IP itself, like
the TCP, and the HTTP.

By the turn of the century, information, including access to the Internet, will be the basis
for personal, economic, and political advancement. The popular name for the Internet is
the information superhighway. Whether you want to find the latest financial news, browse
through library catalogs, exchange information with colleagues, or join in a lively political
debate, the Internet is the tool that will take you beyond telephones, faxes, and isolated
computers to a burgeoning networked information frontier. The Internet supplements the
traditional tools you use to gather information, Data Graphics, News and correspond with
other people. Used skillfully, the Internet shrinks the world and brings information,
expertise, and knowledge on nearly every subject imaginable straight to your computer.

What is the Internet?

The Internet links are computer networks all over the world so that users can share
resources and communicate with each other. Some computers have direct access to all
the facilities on the Internet such as the universities. And other computers, example
privately-owned ones, have indirect links through a commercial service provider, who
offers some or all of the Internet facilities. In order to be connected to Internet, you must
go through service suppliers. Many options are offered with monthly rates. Depending on the
option chosen, access time may vary.
The Internet is what we call a Meta network, that is, a network of networks that spans the
globe. It's impossible to give an exact count of the number of networks or users that
comprise the Internet, but it is easily in the thousands and millions respectively. The
Internet employs a set of standardized protocols which allow for the sharing of resources
among different kinds of computers that communicate with each other on the network.
These standards, sometimes referred to as the Internet Protocol Suite, are the rules that
developers adhere to when creating new functions for the Internet. The Internet is also
what we call a distributed system; there are no central archives. Technically, no one runs
the Internet. Rather, the Internet is made up of thousands of smaller networks. The
Internet thrives and develops as its many users find new ways to create, display and



retrieve the information that constitutes the Internet.



Who Owns the Internet?
No one actually owns the Internet, and no single person or organization controls the
Internet in its entirety. The Internet is more of a concept than an actual tangible entity, and
it relies on a physical infrastructure that connects networks to other networks.

Is Web and Internet the Same?
The Internet is not synonymous with World Wide Web. The Internet is a massive network
of networks, a networking infrastructure. It connects millions of computers together
globally, forming a network in which any computer can communicate with any other
computer as long as they are both connected to the Internet. The World Wide Web, or
simply Web, is a way of accessing information over the medium of the Internet.
It is an information-sharing model that is built on top of the Internet.
WEB BROWSER:

A web browser (commonly referred to as a browser) is a software application for
retrieving, presenting, and traversing information resources on the World Wide Web. An
information resource is identified by a Uniform Resource Identifier (URI/URL) and may be
a web page, image, video or other piece of content. Hyperlinks present in resources
enable users easily to navigate their browsers to related resources.

Although browsers are primarily intended to use the World Wide Web, they can also be
used to access information provided by web servers in private networks or files in file
systems.

Uses of Internet

Internet is today one of the most important part of our daily life. There are large numbers
of things that can be done using the internet and so it is very important. You can say
that with the progress in the internet we are progressing in every sphere of life as it not
only makes our tasks easier but also saves a lot of time. Today internet is used for
different purposes depending upon the requirement. Here in this very article we have
mentioned then ten best uses of the internet. Here goes the list.



1) Email:

By using internet now we can communicate in a fraction of seconds with a person who
is sitting in the other part of the world. Today for better communication, we can avail the
facilities of Email. We can chat for hours with our loved ones. There are plenty
messenger services and email services offering this service for free. With help of such
services, it has become very easy to establish a kind of global friendship where you can
share your thoughts, can explore other cultures of different ethnicity.
2) Information:

The biggest advantage that internet offering is information. The internet and the World
Wide Web has made it easy for anyone to access information and it can be of any type,
as the internet is flooded with information. The internet and the World Wide Web has
made it easy for anyone to access information and it can be of any type. Any kind of
information on any topic is available on the Internet.

3) Business:

World trade has seen a big boom with the help of the internet, as it has become easier
for buyers and sellers to communicate and also to advertise their sites. Now a day's
most of the people are using online classified sites to buy or sell or advertising their
products or services. Classified sites save a lot of money and time so this is chosen as
medium by most of people to advertise their products. We have many classified sites on
the web like craigslist, Adsglobe.com, Kijiji etc.

4) Social Networking:

Today social networking sites have become an important part of the online community.
Almost all users are members use it for personal and business purposes. It's an
awesome place to network with many entrepreneurs who come here to begin building
their own personal and business brand.

5) Shopping:

In today's busy life most of us are interested to shop online. Now a day's almost
anything can be bought with the use of the internet. In countries like US most of
consumers prefer to shop from home. We have many shopping sites on internet like
amazon.com, Dealsglobe.com etc. People also use the internet to auction goods. There
are many auction sites online, where anything can be sold.

6) Entertainment:

On internet we can find all forms of entertainment from watching films to playing games
online. Almost anyone can find the right kind of entertainment for themselves. When
people surf the Web, there are numerous things that can be found. Music, hobbies,
news and more can be found and shared on the Internet. There are numerous games
that may be downloaded from the Internet for free.

7) E-Commerce:



Ecommerce is the concept used for any type of commercial maneuvering, or business
deals that involves the transfer of information across the globe via internet. It has



become a phenomenon associated with any kind of shopping, almost anything. It has
got a real amazing and range of products from household needs, technology to
entertainment.

8) Services:
Many services are now provided on the internet such as online banking, job seeking,
purchasing tickets for your favorite movies, and guidance services on array of topics in
the every aspect of life, and hotel reservations and bills paying. Often these services are
not available off-line and can cost you more.

9) Job Search:

Internet makes life easy for both employers and job seekers as there are plenty of job sites
which connect employers and job seekers.

10) Dating/Personals:

People are connecting with others though internet and finding their life partners.
Internet not only helps to find the right person but also to continue the relationship.

E-mailing

Short for electronic mail, e-mail or email is text messages that may contain files, images,
or other attachments sent through a network to a specified individual or group of
individuals. The first e-mail was sent by Ray Tomlinson in 1971. By 1996, more electronic
mail was being sent than postal mail.

“Email, e-mail or electronic mail is the transmission of messages (emails or email
messages) over electronic networks like the internet.”

Email, sometimes written as e-mail, is simply the shortened form of “electronic mail,” a
system for receiving, sending, and storing electronic messages. It has gained nearly
universal popularity around the world with the spread of the Internet. In many cases, email
has become the preferred method for both personal and business communication.

How It Is Used

Messages sent by electronic mail normally reach a recipient’s account within seconds.
They frequently include more than just text; images and numerous types of formatted
documents are now easily included as attached files. Moreover, it is no longer necessary
to be sitting in front of a PC to send or receive an email. A variety of mobile devices, such
as tablet computers and smart phones, make it possible manage correspondence on the
go.

Most e-mail systems include a rudimentary text editor for composing messages, but many
allow you to edit your messages using any editor you want. You then send the message
to the recipient by specifying the recipient's address. You can also send the same



message to several users at once. This is called broadcasting.



Sent messages are stored in electronic mailboxes until the recipient fetches them. To see
if you have any mail, you may have to check your electronic mailbox periodically, although
many systems alert you when mail is received. After reading your mail, you can store it in
a text file, forward it to other users, or delete it. Copies of memos can be printed out on a
printer if you want a paper copy. E-mail can be distributed to lists of people as well as to
individuals. A shared distribution list can be managed by using an e-mail reflector. Some
mailing lists allow you to subscribe by sending a request to the mailing list administrator.
A mailing list that is administered automatically is called a list server.

To get a grasp of what email is it's best — the terminology indicates it — to think in equivalents
of "traditional" postal mail.

• The email message - Instead of using a pen to write a letter on paper, you're using
your keyboard to type an email message in an email program on your computer.

• Sending the email - When the email is finished and has been addressed to the
recipient's email address, you don't put a stamp on it and post it but press the Send
button in the email program. This makes the email message go on its journey.

• Email transport - Like postal services transport letters and parcel, email servers
transmit email messages from sender to recipient. Usually, emails are not delivered to
the recipient directly, though, but waiting at the "nearest" mail server to be picked up by
them.

• Fetching new mail - If you've got new mail in your mailbox, you go and fetch it. Similarly,
your email program can check for new email messages at your mail server and
download them for you to read.

DESKTOP PUBLISHING

(PAGEMAKER, CORELDRAW, PHOTOSHOP)

DESKTOP PUBLISHING:

Desktop publishing (abbreviated DTP) is the creation of documents using page layout
skills on a personal computer. When used skillfully, desktop publishing software can
produce text and images with attractive layouts and typographic quality comparable to
traditional typography and printing, so DTP is also the main reference for digital
typography. This technology allows individuals, businesses, and other organizations to
self-publish a wide range of printed matter—from menus and local newsletters to books,
magazines, and newspapers—without the sometimes-prohibitive expense of commercial



printing.



The same DTP skills and software used for common paper and book publishing are
sometimes used to create graphics for point of sale displays, promotional items, trade
show exhibits, retail package designs and outdoor signs. Although what is classified as
"DTP software" is usually limited to print and PDF publications, DTP skills aren't limited to
print. The content produced by desktop publishers may also be exported and used for
electronic media. The job descriptions that include "DTP" such as DTP artist often require
skills using software for producing e-books, web content, and web pages.

Terminology

There are two types of pages in desktop publishing, electronic pages and virtual paper
pages to be printed on physical paper pages. All computerized documents are technically
electronic, which are limited in size only by computer memory or computer data storage
space.

Virtual paper pages will ultimately be printed, and therefore require paper parameters that
coincide with international standard physical paper sizes such as "A4," "letter," etc., if not
custom sizes for trimming. Some desktop publishing programs allow custom sizes
designated for large format printing used in posters, billboards and trade show displays.
A virtual page for printing has a pre-designated size of virtual printing material and can be
viewed on a monitor in WYSIWYG format. Each page for printing has trim sizes (edge of
paper) and a printable area if bleed printing is not possible as is the case with most desktop
printers.

A web page is an example of an electronic page that is not constrained by virtual paper
parameters. Most electronic pages may be dynamically re-sized, causing either the
content to scale in size with the page or causing the content to re-flow.

Master pages are templates used to automatically copy or link elements and graphic
design styles to some or all the pages of a multi page document. Linked elements can be
modified without having to change each instance of an element on pages that use the
same element. Master pages can also be used to apply graphic design styles to automatic
page numbering.

Page layout is the process by which the elements are laid on the page orderly,
aesthetically, and precisely. Main types of components to be laid out on a page include
text, linked images that can only be modified as an external source, and embedded
images that may be modified with the layout application software. Some embedded
images are rendered in the application software, while others can be placed from an
external source image file. Text may be keyed into the layout, placed, or (with database
publishing applications) linked to an external source of text which allows multiple editors
to develop a document at the same time.
Graphic design styles such as color, transparency, and filters, may also be applied to
layout elements. Typography styles may be applied to text automatically with style sheets.
Some layout programs include style sheets for images in addition to text. Graphic styles
for images may be border shapes, colors, transparency, filters, and a parameter
designating the way text flows around the object called "wraparound" or "runaround."

Comparisons



With word processing



While desktop publishing software still provides extensive features necessary for print
publishing, modern word processors now have publishing capabilities beyond those of
many older DTP applications, blurring the line between word processing and desktop
publishing.

In the early days of graphical user interfaces, DTP software was in a class of its own when
compared to the fairly spartan word processing applications of the time. Programs such
as WordPerfect and WordStar were still mainly text-based and offered little in the way of
page layout, other than perhaps margins and line spacing. On the other hand, word
processing software was necessary for features like indexing and spell checking, features
that are common in many applications today.

As computers and operating systems have become more powerful, vendors have sought to
provide users with a single application platform that can meet all needs.

With other electronic layout software

In modern usage, DTP is not generally said to include tools such as TeX or troff, though
both can easily be used on a modern desktop system and are standard with many Unixlike
operating systems and readily available for other systems. The key difference between
electronic typesetting software and DTP software is that DTP software is generally
interactive and WYSIWYG in design, while other electronic typesetting software, such as
TeX, LaTeX and other variants, tends to operate in batch mode, requiring the user to enter
the processing program's markup language without immediate visualization of the finished
product. This kind of workflow is less userfriendly than WYSIWYG, but more suitable for
conference proceedings and scholarly articles as well as corporate newsletters or other
applications where consistent, automated layout is important.

There is some overlap between desktop publishing and what is known as Hypermedia
publishing (i.e. Web design, Kiosk, CD-ROM). Many graphical HTML editors such as
Microsoft FrontPage and Adobe Dreamweaver use a layout engine similar to a DTP
program. However, some Web designers still prefer to write HTML without the assistance
of a WYSIWYG editor, for greater control and because these editors often result in code
bloat.

What is the Print Media?

The print media is composed of newspapers, community newsletters, wire services,
magazines, and other publications. Within these publications, there are two main
divisions of labor: reporting and editing. Reporters are the newspaper writers who
investigate newsworthy events and interesting stories. Editors assign stories to
reporters, edit story content, and decide which stories to print.

Why is the Print Media Important?

The print media is an effective way to alert the public to the Weatherization Assistance



Program and its work. Readers often bypass paid advertising, but a story from an
independent journalist increases public awareness and builds local credibility. The



media reaches a broad audience of readers on a daily basis. Reporters and editors are
always looking for interesting, newsworthy stories. Attracting media attention can help
expand your influence and name recognition in target communities.

ADVANTAGES AND DISADVANTAGES OF PRINT MEDIA

One of the most popular and growing industries is the print media and the reason being

the fact that it is one of the easiest ways to reach targeted customers by advertisers and

marketers. These advertisers and businessmen make the most of all forms of print

media like magazines, newspaper, leaflets etc. If you want to know more about print

media, then read this article as we bring to you the advantages and disadvantages of

print media here. Read on to find out what are they.

Advantages of print media
• Flashy magazines are always popular among consumers and are often read by them

for a particular period of time in a month. The monthly magazines are the best way to
bring attention to any advertisements.

• Print media is an easy medium to spread awareness or advertise to any particular
geographical area. Like, a local newspaper is the best way to spread news about any
local event of the place.

• Some forms of the print media have a huge and trusted followers. This is definitely a
great boost to attract readership.

• Print media allows you to choose your own space for advertisement, thus, you can
manage your budget and expenses while planning for the advertisement.

Disadvantages of print media
• If you are targeting the global audience, then this is not the medium you should go for.

Instead, the internet has a much wider reach than print media in this.
• Placing an advertisement in print media requires a lot of planning and time. In this

case, you are faced with flexibility problem, particularly when you work in tight
deadlines.

• In fact, there is much limitations when it comes to targeting your audience as the
particular newspaper may not be available to the audience all the time. On the other
hand, a person can get access to the internet from anywhere and everywhere.

• Besides, most of the time, your advertisement might get lost among all other ads and
editorials. Plus, the lifespan of newspaper and magazines is very short as people have
a tendency to throw them or keep them aside after one day of read. There are both
advantages and disadvantages for print media. We have to keep all these in mind and
make the right planning to make the optimum use of print media.

Characteristics of Print Media



The characteristics of the print media are as follows:

1. The print media like newspapers and magazines gives us an in-depth coverage and
analysis of news stories around the world. These stories are permanent and readily
available to the common people in times of need. The news stories can be read, re-read
and retained.

2. The timeliness of news in the print media is limited. Unlike the electronic media, they
do not give us immediate news but it has the luxury of detailed representation,
interpretation and analysis.

3.A lot of variations are found in the print media in the forms of hard news, soft news, features,
gossips, page 3 news, etc.

4.Magazines serve special interests like fashion, food, politics, economics, etc.

PAGE MAKER:
PageMaker was one of the first desktop publishing programs, introduced in 1985 by Aldus
Corporation, initially for the then-new Apple Macintosh and in 1987 for PCs running
Windows 1.0.

PageMaker was awarded an SPA Excellence in Software Award for Best New Use of a
Computer in 1986.



PageMaker relies on Adobe Systems' PostScript page description language, and in 1994 Adobe
Systems acquired Aldus and PageMaker.

As an application relying on a graphical user interface, PageMaker helped to popularize the
Macintosh platform and the Windows environment.

Adobe PageMaker is a desktop publishing software program that allows you to view

entire pages of a publication, such as a report, pamphlet or booklet. Therefore, it's

easy to format a document's layout and control various design details, such as fonts

and graphics, prior to printing or distribution.

Adobe PageMaker provides graphic designers, print professionals or production artists

with the ability to create professional page layouts. If you're pursuing such a career, or if

you're interested in desktop publishing for educational or small business purposes, you

may want experience with this program.

System Requirements

Adobe PageMaker runs on both Windows and Macintosh computers. On Windows

machines, it's recommended that your system has 48 MB or more of RAM, 200 MB of



available hard-disk space and a high-resolution display. If you have a Mac, 45 MB of



memory is recommended in addition to the same storage and monitor requirements.

Adobe has released updates to ensure the product continues to function with newer

computer hardware.

Tools used in pagemaker

The functions of the Toolbox should be learned in order to make good use of the PageMaker
program.

When PageMaker is flashed up, the toolbox should be seen on the monitor. The Toolbar consists
of 14 separate boxes.

Text Tool

The text tool (the letter T) is located next to the pointer tool at the top of the Toolbox.. If
text is to be written, the T should be clicked. The text box will lighten up. The cursor can be
placed anywhere and text can be written.

The Pointer Tool
The pointer tool is the power tool. It is used for many applications such as moving
graphics, changing size of graphics, deleting graphics, altering drawing sizes and
shapes made from the drawing tools in the Toolbox and moving text to a new page.

Rotate Tool

The rotation tool is used to rotate a graphic or text. To rotate a graphic, Click on a graphic
,



Click on the rotation tool



Rotate the graphic

To rotate text,
Click in the document until the lines with the handles show up. Move the handle over
the desired text. Go to the toolbox and click on the rotate tool. With a mouse, move the
text how you want it presented



Cropping Tool

The Cropping Tool is used to cut out some of a graphic.
To crop a graphic,
Clicking on a graphic with the pointer tool or cropping tool. Click the cropping tool to activate
it.

Drag one of the corners or side black boxes until the section you want to cut out gets cut
out.

The next two tools are used to make lines.



Rectangular Tools

The next two commands are the rectangle tool and the rectangle tool with an X inside of
the rectangle. The box on the left is made for rectangles. Any line thickness and color
can be customized. The rectangle on the right-hand side, works well for placing
graphics and aligned text inside of the rectangle or square.

To change the pattern inside the rectangle,

Right click on the rectangle with the polygon tool or the pointer tool.Click fill and stroke. Make
choices

Elliptical Tools

The next two tools (9 - 10) do the same thing as the rectangular tools with the only difference



being the circular. 6.11.



The box on the left is made for elliptical design. Any line thickness and color can be
customized. The ellipse on the right-hand side is used is used to make ellipses for
which graphics and aligned text can be inserted inside of the circle.

To change the pattern inside the ellipse, Right click on the ellipse with the polygon tool or
the pointer tool. Click fill and stroke. Make choices

Polygon Tools

The next two tools make polygon shapes.
The box on the left is made for a polygon design. Any line thickness and color can be
customized. The polygon on the right-hand side is used is used to make polygons for
which graphics and aligned text can be inserted inside of the circle. To draw a polygon,

• Click a polygon tool
• Left click the mouse and drag the mouse until you get the size and desired shape.
• To change the pattern inside the polygon,
• Right click on the polygon with the polygon tool or the pointer tool.
• Click fill and stroke
• Make choices



To make a polygon with a different number of sides, Click the right polygon tool, Click
Polygon Settings

Put in a specific number

Click OK



To make a unique shape,

Click the right polygon tool

Make a single click on the page

Move the mouse to a new place

Click the mouse

Repeat for all new lines



Hand Tool



The hand tool is used in layout mode to move the pages to a desired position.

To move a page,
Left click the mouse on a page and drag the pages where you want them.

Magnifying tool

The magnifying glass is used to magnify the document.To magnify the page,Click the
magnifying tool. Click the page.

CorelDraw
CorelDraw (styled CorelDRAW) is a vector graphics editor developed and marketed by
Corel Corporation of Ottawa, Canada. It is also the name of Corel's Graphics Suite, which
bundles CorelDraw with a bitmap image editor, Corel PhotoPaint, and other graphics-
related programs (see below). The latest version is designated X6 (equivalent to version
16), and was released in March 2012.

Supported platforms

CorelDraw was originally developed for Microsoft Windows 3 and currently runs on
Windows XP, Windows Vista, and Windows 7. The current version, X6, was released on
20 March 2012.

Versions for Mac OS and Mac OS X were at one time available, but due to poor sales
these were discontinued. The last port for Linux was version 9 (released in 2000, it did not
run natively; instead, it used a modified version of Wine to run) and the last version for OS
X was version 11 (released in 2001). Also, up until version 5, CorelDraw was developed
for Windows 3.1x, CTOS and OS/2.

Characteristic features

Several innovations to vector-based illustration originated with CorelDraw: a node-edit tool



that operates differently on different objects, fit text-to-path, stroke-before-fill, quick



fill/stroke color selection palettes, perspective projections, mesh fills and complex gradient
fills.

CorelDraw differentiates itself from its competitors in a number of ways:

The first is its positioning as a graphics suite, rather than just a vector graphics program.
A full range of editing tools allow the user to adjust contrast, color balance, change the
format from RGB to CMYK, add special effects such as vignettes and special borders to
bitmaps. Bitmaps can also be edited more extensively using Corel PhotoPaint, opening
the bitmap directly from CorelDraw and returning to the program after saving. It also allows
a laser to cut out any drawings.

CorelDraw is capable of handling multiple pages along with multiple master layers.
Multipage documents are easy to create and edit and the Corel print engine allows for
booklet and other imposition so even simple printers can be used for producing finished
documents. One of the useful features for single and multi-page documents is the ability
to create linked text boxes across documents that can be resized and moved while the
text itself resets and flows through the boxes. Useful for creating and editing multi-article
newsletters etc.
Smaller items, like business cards, invitations etc., can be designed to their final page size
and imposed to the printer's sheet size for cost-effective printing. An additional print-merge
feature (using a spreadsheet or text merge file) allows full personalization for many things
like numbered raffle tickets, individual invitations, membership cards and more.

CorelDraw's competitors include Adobe Illustrator and Xara Photo & Graphic Designer.
Although all of these are vector-based illustration programs, the user experience differs
greatly between them. While these programs will read their native file types and vice versa,
the translation is rarely perfect. CorelDraw can open Adobe PDF files: Adobe PageMaker,
Microsoft Publisher and Word, and other programs can print documents to PDF using the
Adobe PDFWriter printer driver, which CorelDraw can then open and edit every aspect of
the original layout and design. CorelDRAW can also open PowerPoint presentations and
other Microsoft Office formats with little or no problem.

CorelDraw Graphics Suite

Over time, additional components were developed or acquired and bundled with
CorelDraw. The list of bundled packages usually changes somewhat from one release to
the next, though there are several mainstays that have remained in the package for many
releases now, including PowerTrace (a bitmap to vector graphic converter), Photo-Paint
(a bitmap graphic editor), and Capture (a screen capture utility).



The current version of CorelDraw Graphics Suite X6 (version 16), contains the following
packages:
 CorelDraw X6, an intuitive vector-illustration and page-layout application
 Corel Photo-Paint X6, an image-editing application
 Corel PowerTrace X6, a utility to convert bitmaps into editable vector graphics
 Corel Connect, a full-screen browser to search the suite’s digital content
 Corel Capture X6, a screen capture utility
 Corel Website Creator X6, new website creation software

CDR File Format

CDR file format is a proprietary file format developed by Corel Corporation and
primarily used for vector graphic drawings. There is no publicly available CDR file
format specification.

Other CorelDraw file formats include CorelDraw Compressed (CDX), CorelDraw Template
(CDT) and Corel Presentation Exchange (CMX).

In December 2006 the sK1 open source project team started to reverse-engineer the
CDR format. The results and the first working snapshot of the CDR importer were
presented at the Libre Graphics Meeting 2007 conference taking place in May 2007 in
Montreal (Canada). Later on the team parsed the structure of other Corel formats with
the help of the open source CDR Explorer. As of 2008, the sK1 project claims to have
the best import support for CorelDraw file formats among open source software
programs. The sK1 project developed also the UniConvertor, a command line open
source tool which supports conversion from CorelDraw ver.7-X4 formats
(CDR/CDT/CCX/CDRX/CMX) to other formats. UniConvertor is also used in Inkscape
and Scribusopen source projects as an external tool for CorelDraw files importing.



In 2007, Microsoft blocked CDR file format in Microsoft Office 2003 with the release of
Service Pack 3 for Office 2003. Microsoft later apologized for inaccurately blaming the
CDR file format and other formats for security problems in Microsoft Office and
released some tools for solving this problem.

In 2012 the joint LibreOffice/re-lab team implemented libcdr, a library for reading CDR
files from v1 to the currently latest X6 version and CMX files. The library has extensive
support for shapes and their properties, including support for color management and
spot colors, and has a basic support for text. The library provides a built-in converter
to SVG, and a converter to OpenDocument is provided by writerperfect package. The
libcdr library is expected to be used in LibreOffice 3.6, and thanks to public API it can
be freely used by other applications.

CorelDraw Tools:

Pick tool - Select, position, or transform objects.



Freehand Pick tool - Select objects by using a freehand selection marquee.
Position and transform objects.

Shape tool (F10) - Edit a curve object or text character by manipulating nodes.

Smudge Brush tool - Change the shape of an object by dragging along its
outline.

Roughen Brush tool - Distort the edge of an object by dragging along its outline.

Free Transform tool - Rotate, skew, mirror, and scale objects.

Smear tool - Change the edge of an object by dragging along its outline.

Twirl tool - Add swirl effects by dragging along the outline of an object.

Attract tool - Reshape objects by attracting nodes to the cursor.

Repel tool - Reshape objects by pushing nodes away from the cursor.

Smooth tool - Smooth object by dragging along its outline.

Crop tool - Remove the areas outside a selection.

Knife tool - Slice an object to split it into two separate objects.

Eraser tool (X) - Remove unwanted areas in a drawing.

Virtual Segment Delete tool - Remove overlapping segments in objects.

Zoom tool (Z) - Change the magnification level of the document window.

Pan tool (H) - Drag hidden areas of a drawing into view without changing the
zoom level.



Freehand tool (F5) - Draw curves and straight line segments.

2-Point Line tool - Draw a straight line by drawing from the starting point to the
endpoint.

Bezier tool - Draw curves one segment at a time.

Artistic Media tool (I) - Add artistic brush, spray, and calligraphic effects by using
freehand strokes.

Pen tool - Draw curves in segments, and preview each segment as you draw.

B-Spline tool - Draw curved lines by setting control points that shape the curve
without breaking it into segments.

Polyline tool - Draw connected curves and straight lines in one continuous action.

3-Point Curve tool - Draw a curve by dragging from the starting point to the
endpoint and then positioning the center point.

Smart Fill tool - Create objects from overlapping areas, and apply a fill to those
objects.

Smart Drawing tool (Shift+S) - Convert freehand strokes to basic shapes or
smoothed curves.

Rectangle tool (F6) - Draw squares and rectangles by dragging in the drawing
window.

3-Point Rectangle tool - Draw rectangles at an angle.

Elipse tool (F7) - Draw circles and elipses by dragging in the drawing window.

3-Point Elipse tool - Draws elipses at an angle.

Polygon tool (Y) - Draw polygons by draggig in the drawing window.

Star tool - Draw uniform, outlined stars.



Complex Star tool - Draw stars that have intersecting sides.

Graph Paper tool (D) - Draw a grid.

Spiral tool (A) - Draw symmetrical and logarithmic spirals.

Basic Shapes tool - Draw triangles, circles, cylinders, hearts and other shapes.

Arrow Shapes tool - Draw arrows of various shapes and directions.

Flowchart Shapes tool - Draw flowchart symbols.

Banner Shapes tool - Draw ribbon objects and explosion shapes.

Callout Shapes tool - Draw labels and speech bubbles.

Text tool (F8) - Add and edit paragraph and artistic text.

Table tool - Draw, select, and edit tables.

Parallel Dimension tool - Draw slanted dimension lines.

Horizontal or Vertical Dimension tool - Draw horizontal or vertical dimension

lines.

Angular Dimension tool - Draw angular dimension lines.

Segment Dimension tool - Display the distance between end nodes on single or
multiple segments.

3-Point Callout tool - Draw a call out with a two-segment leading line.

Straight-Line Connector tool - Draw a straight line to connect two objects.



Right-Angle Connector tool - Draw a right angle to connect two objects.

Right-Angle Round Connector tool - Draw a right angle with a rounded corner to
connect two objects.

Edit Anchor tool - Modify the connector line anchor points of objects.

Blend tool - Blend objects by creating a progression of intermediate objects and
colors.

Contour tool - Apply a series of concentric shapes that radiate into or out of an
object.

Distort tool -Transform objets by applying Push and Pull, Zipper, or Twister
effects.

Drop Shadow tool - Apply shadows behind or below objects

Envelope tool - Change the shape of an object by applying and dragging the
nodes of an envelope.

Extrude tool - Apply 3D efect to objects to create the illusion of depth.

Transparency tool - Partially reveal image areas underneath the object.

Color Eyedropper tool - Sample colors, and apply them to objects

Outline Pen (F12) - Set outline properties sucj as line thickness, corner shape,
and arrow type.

Outline Color (Shift+F12) - Choose the outline color by using color viewers and
color palettes.

Uniform Fill (Shift+F11) - Choose a solid fill color for an object by using color
palettes, color viewers, color harmonies, or color blends.



Fountain Fill (F11) - Fill an object with a gradient of colors or shades.

Pattern Fill - Apply a preset pattern fill to an object or create a custom pattern fill.

Texture Fill - Apply preset texture fills to objects to create the illusion of a variety
of textures, such as water, clouds and stone.

PostScript Fill - Apply an intricate PostScript texture fill to an object.

Interactive Fill tool (G) - Create a fill dynamically by using markers in the drawing
window and property bar to change the angle, midpoint, and color.

Mesh Fill tool (M) - Fill an object by blending multiple colors or shades arranged
over a mesh grid.

ADOBE PHOTOSHOP:

Adobe Photoshop is a graphics editing program developed and published by Adobe
Systems.

Adobe's 2003 "Creative Suite" rebranding led to Adobe Photoshop 8's renaming to Adobe
Photoshop CS. Thus, Adobe Photoshop CS6 is the 13th major release of Adobe
Photoshop. The CS rebranding also resulted in Adobe offering numerous software
packages containing multiple Adobe programs for a reduced price. Adobe Photoshop is
released in two editions: Adobe Photoshop, and Adobe Photoshop Extended, with the
Extended having extra 3D image creation, motion graphics editing, and advanced image
analysis features. Adobe Photoshop Extended is included in all of Adobe's Creative Suite
offerings except Design Standard, which includes the Adobe Photoshop edition.

Alongside Photoshop and Photoshop Extended, Adobe also publishes Photoshop
Elements and Photoshop Lightroom, collectively called "The Adobe Photoshop Family".
In 2008, Adobe released Adobe Photoshop Express, a free web-based image editing



tool to edit photos directly on blogs and social networking sites; in 2011 a version was
released for the Android operating system and the iOSoperating system.

File Format

Photoshop files have default file extension as .PSD, which stands for "Photoshop
Document." A PSD file stores an image with support for most imaging options available
in Photoshop. These include layers with masks, transparency,
text, alpha channels and spot colors, clipping paths, and duotone settings. This is in
contrast to many other file formats (e.g. .JPG or .GIF) that restrict content to provide
streamlined, predictable functionality. A PSD file has a maximum height and width of
30,000 pixels, and a length limit of 3 Gigabytes.

Photoshop files sometimes have the file extension .PSB, which stands for "Photoshop
Big" (also known as "large document format"). A PSB file extends the PSD file format,
increasing the maximum height and width to 300,000 pixels and the length limit to around
4 Exabytes. The dimension limit was apparently chosen arbitrarily by Adobe, not based
on computer arithmetic constraints (it is not close to a power of two, as is 30,000) but for
ease of software testing. PSD and PSB formats are documented.

Because of Photoshop's popularity, PSD files are widely used and supported to some
extent by most competing software. The .PSD file format can be exported to and from
Adobe's other apps like Adobe Illustrator, Adobe Premiere Pro, and After Effects, to make
professional standard DVDs and provide non-linear editing and special effects services,
such as backgrounds, textures, and so on, for television, film, and the web. Photoshop's
primary strength is as a pixel-based image editor, unlike vectorbased image editors.
Photoshop also enables vector graphics editing through its Paths,
Pen tools, Shape tools, Shape Layers, Type tools, Import command, and Smart Object
functions. These tools and commands are convenient to combine pixel-based and vector-



based images in one Photoshop document, because it may not be necessary to use more
than one program. To create very complex vector graphics with numerous shapes and
colors, it may be easier to use software that was created primarily for that purpose, such
as Adobe Illustrator or CorelDRAW. Photoshop's non-destructive Smart Objects can also
import complex vector shapes.

Language Availabilities

Photoshop is available in more than 20 languages. These are the following:

Chinese Simplified, Chinese Traditional, Czech, Danish, Dutch, English, Finnish, French,
German, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese,
Romanian, Russian, Spanish, Swedish, Turkish and Ukrainian. Also Arabic and Hebrew
as of Photoshop CS6.

Plugins

Photoshop functionality can be extended by add-on programs called Photoshop plugin
(or plug-ins). Adobe creates some plug-in, such as Adobe Camera Raw, but thirdparty
companies develop most plug-in, according to Adobe's specifications. Some are free and
some are commercial software. Most plug-in work with only Photoshop or Photoshop-
compatible hosts, but a few can also be run as standalone applications.

There are various types of plug-in, such as filter, export, import, selection, color
correction, and automation. The most popular plug-in are the filter plug-in (also known as
a 8bf plug-in), available under the Filter menu in Photoshop. Filter plug-in can either
modify the current image or create content. Below are some popular types of plug-in, and
some well-known companies associated with them:

 Color correction plug-in
 Special effects plug-in
 3D effects plug-in

Adobe Camera Raw (also known as ACR and Camera Raw) is a special plugin, supplied
free by Adobe, used primarily to read and process raw image files so that the resultant
images can be processed by Photoshop. It can also be used from within Adobe Bridge.

Tools

Upon loading Photoshop, a sidebar with a variety of tools with multiple image-editing
functions appears to the left of the screen. These tools typically fall under the categories
of drawing; painting; measuring and navigation; selection; typing; and retouching. Some
tools contain a small triangle in the bottom right of the toolbox icon. These can be
expanded to reveal similar tools. While newer versions of Photoshop are updated to
include new tools and features, several recurring tools that exist in most versions are
discussed below.



Pen Tool

Photoshop includes a few versions of the pen tool. The pen tool creates precise paths
that can be manipulated using anchor points. The freeform pen tool allows the user to
draw paths freehand, and with the magnetic pen tool, the drawn path attaches closely to
outlines of objects in an image, which is useful for isolating them from a background.

Measuring and navigation

The eyedropper tool selects a color from an area of the image that is clicked, and
samples it for future use. The hand tool navigates an image by moving it in any direction,
and the zoom tool enlarges the part of an image that is clicked on, allowing for a closer
view.

Selection

By using path selection tool, we can select path nodes.

Cropping

The crop tool can be used to select a particular area of an image and discard the portions
outside of the chosen section. This tool assists in creating a focus point on an image and
excluding unnecessary or excess space. Cropping allows enhancement of a photo’s
composition while decreasing the file size. The "crop" tool is in the tools palette, which is
located on the right side of the document.

Slicing

The "slice" and slice select tools, like the crop tool, are used in isolating parts of images.
The slice tool can be used to divide an image into different sections, and these separate
parts can be used as pieces of a web page design once HTML and CSS are applied. The
slice select tool allows sliced sections of an image to be adjusted and shifted.

Moving

Once an area of an image is highlighted, the move tool can be used to manually relocate
the selected piece to anywhere on the canvas.

Marquee

The marquee tool can make selections that are single row, single column, rectangular
and elliptical. An area that has been selected can be edited without affecting the rest of
the image. This tool can also crop an image; it allows for better control. In contrast to the
crop tool, the "marquee" tool allows for more adjustments to the selected area before
cropping. The only marquee tool that does not allow cropping is the elliptical.

Lasso

The lasso tool is similar to the "marquee" tool, however, the user can make a custom
selection by drawing it freehand. There are three options for the "lasso" tool – regular,



polygonal, and magnetic. The regular "lasso" tool allows the user to have drawing
capabilities. Photoshop will complete the selection once the mouse button is released.
The user may also complete the selection by connecting the end point to the starting
point. The “marching ants” will indicate if a selection has been made. The "polygonal
lasso" tool will only draw straight lines, which makes it an ideal choice for images with
many straight lines. Unlike the regular "lasso" tool, the user must continually click around
the image to outline the shape. To complete the selection, the user must connect the end
point to the starting point just like the regular lasso tool. "Magnetic lasso" tool is
considered the smart tool.

Quick Selection

The quick selection tool selects areas based on edges, similarly to the magnetic lasso
tool. The difference between this tool and the lasso tool is that there is no starting and
ending point. Since there isn’t a starting and ending point, the selected area can be added
on to as much as possible without starting over.

Magic Wand

The magic wand tool selects areas based on pixels. The user only needs to click once,
and this tool will detect pixels that are very similar to each other. If the eye dropper tool
is selected in the options bar, then the magic wand can determine the value needed to
evaluate the pixels; this is based on the sample size setting in the eyedropper tool.
When the image requires more than a few clicks, this tool becomes a disadvantage. The
user must decide what settings to use or if the image is right for this tool.

Eraser
The eraser tool does exactly what it’s called. It erases an image based on the layer it is
on. If the user is on the text layer, then any text that the tool is dragged across will be
erased. The erased area will convert the pixels to transparent, unless it is the background
layer. The size and style of the eraser can be selected in the options bar. This tool is
unique in that it can take the form of the paintbrush and pencil tools. In addition to the
straight eraser tool, there are two more available options – background eraser and magic
eraser.

Typing

Photoshop also provides tools for adding and editing text. The type tools create an area
where text can be entered, and the type mask tools create a selection area that has the
shape of text. The type tool creates vector-based text, so symbols, letters and numbers
in various fonts and colors can be re-sized while maintaining the same quality.

Retouching

There are several tools that are used for retouching, manipulating and adjusting photos,
such as the clone stamp, eraser, burn, dodge, smudge and blur tools. The clone stamp
tool samples a selected portion of an image, and duplicates it over another area using a
brush that can be adjusted in size, flow and opacity. The smudge tool, when dragged



across part of an image, stretches and smudges pixels as if they are real paint, and the
blur tool softens portions of an image by lowering the amount of detail within the adjusted
area.

Content-aware

Content-awareness is a useful aspect of Photoshop where image editing is done
automatically and intelligently. It comes in two forms, content-aware scaling, and content-
aware filling, in which elements in a background automatically recompose according to
the areas a user of the program decides to fill or scale. More specifically, content-aware
scaling works by rescaling an image and causing its content to adapt to the new
dimensions and preserving important areas of it. Content-aware filling functions by
matching tone, color, and noise of an area of the image that contained an object or detail
in which the user decides to remove.

Healing tools

With improvement retouching tools like the Clone Stamp tool and Healing Brush tool,
imperfections of an image can easily be removed. These tools essentially function by
locating a source point (or multiple source points) that can be scaled or rotated in order
to cover an imperfection or unwanted detail in a specific area of an image.

Puppet wrap

Similar to the content-aware tool, the puppet warp tool reveals Photoshop’s intelligence
by allowing a user to reposition an object in an image such as a flower or arm. This is
done by using points that outline the structure of an object and easily repositioning in the
wanted orientation.

Video Editing

In Adobe CS5 Extended edition, video editing is comprehensive and efficient with a broad
compatibility of video file formats such as MOV, AVI,MPEG-4, and FLVformats and easy
workflow. Using simple combination of keys video layers can easily be modified, with
other features such as adding text and the creation of animations using single images.



3D

With the Extended version of Photoshop CS5, 2D elements of an artwork can easily
become three-dimensional with the click of a button. Extrusions of texts, an available
library of materials for three-dimensional, and even wrapping two-dimensional images
around 3D geometry are all possible with this version of Photoshop. Realism can also be
added to an image using the 3D features of Photoshop such as animating imagebased
lights and depth of field.

Mobile integration

Third-party plug-in have also been added to the most recent version of Photoshop where
technologies such as the iPad have integrated the software with different types of
applications. Applications like the Adobe Easel painting app allows the user to easily
create paintings with their fingertips and use an array of different paint from dry to wet in
order to create rich color blending.

Camera Raw

With the Camera Raw plug-in, RAW images can be processed without the use of Adobe
Photoshop Light room, along with other image file formats such asJPEGs, TIFFs, or
PNGs. The plug-in allows users to remove noise without the side-effect of
oversharpening, add grain, and even perform post-crop vignetting.

HTML / DHTML , NOTEPAD & DREAMWEAVER
Web Script Language HTML

Introduction to HTML

HTML (Hypertext Markup Language) is used to create document on the World Wide
→eb. It is simply a collection of certain keywords called ‘Tags’ that are helpful in writing

the document to be displayed using a browser on Internet. It is a platform independent

language that can be used on any platform such as Windows, Linux, Macintosh, and so

on. To display a document in web it is essential to mark-up the different elements

(headings, paragraphs, tables, and so on) of the document with the HTML tags. To view

a mark-up document, user has to open the document in a browser. A browser

understands and interpret the HTML tags, identifies the structure of the document



(which part are which) and makes decision about presentation (how the parts look) of

the document.HTML also provides tags to make the document look attractive using

graphics, font size and colors. User can make a link to the other document or the

different section of the same document by creating Hypertext Links also known as

Hyperlinks.

WEBDESIGNING

Website: Collection of Webpages and Webpages is made by HTML Tags.

Internet: 24 Hours presence on Internet with World Wide Reach.

Web designing: Static Site:Without Database | Photoshop (Web Templates /

Homepage)

HTML | DHTML Dreamweaver | Flash Animation | Css & Div Tag.

Web development: Dynamic Site: Database Site | Java Script | ASP.NET | PHP | Ms-

Access | MySQL | Sql Server

Requirement for Website: Domain Name | Hosting (Server Space) | Website

HTML - Hyper Text Markup Language The language used to develop web pages is
called HTML. HTML is the language interpreted by a Browser. Webpage are also called

html documents. HTML is a set of special codes. HTML is specified on TAGS.

For creation of HTML files we required Two ways :

Editor : For writting purpose or making HTML files Note Pad is best editor it is
support coding language.

Browser : For output display there are of two type of browsers Internet Explorer
and Netscape Navigator.

The contents of HTML page is written in Tags / Attributes.

HTML Tags : Tags are instructions that one embedded directly into the text of
the document. An HTML tag is a signal to a browser that it should do something other

than just throw text up on the screen. By connection all HTML tags begin with an open

angle bracket (<) and end with a Closes angle Bracket (>) HTML tags can be of two
types :

Paired Tags : A tag is said to be paired tag if it, along with a companion tag, close the
text.



Singular Tag : The second type of tag is the singular or stand-alone tag. It does
not have a companion tag.

Tag Attributes & Value : Additional information supplied to an HTML tag is
known as Attributes of a tag. Attributes are written immediateley following the tag,

separated by a space. Like:

<HR Size=5 Color=”Red” Width=70% Align=”Right”>

Here HR = Tag

Size, Color, Width, Align = Attributes

5, Red, 70%, Right = Values

Basic structure of HTML Document :

Every HTML program has a rigid structure.

<HTML> Start Tag | Opening Script
<HEAD> Information placed in this section is essential to the inner working of

the

document and has nothing to do with the content of the document.

<TITLE> Explanation of page purpose, Display in Title Bar of I.E.

</TITLE> Closing Tag

</HEAD> Closing Tag

<BODY> Information and Links / Secondary Links / Footers means any type
of Text or Graphics for Page.

</BODY> Closing Tag

</HTML> Closing Tag | Closing Script

Paragraph Breaks : A blank line always separate paragraphs in textual material. The tag
that provides this functionality is <P>.<P>tag is used to create a new paragraph.

Line Breaks : When text needs to start from a new line and not continue on the same

line, the <BR> tag should be used.

Heading Style : HTML supports six different level of headings. The highest-level header
format is



<H1> and the lowest level is <H6>.

Align Attribute : Alignment attributes are often used with the text, image.

Align = Left / Center / Right <H1 Align=”Left”> SoftBrain</H1>

Drawing Lines : The tag <HR> draws lines and horizontal rules. The Attributes to the

<HR> tag are :

<HR Size=5 Color=”Red” Width=70% Align=”Right”>

Text Level Elements : Text level Elements changes the appearance to function of text.
Bold : Bold element <B> and </B> causes text to appear in a bold type

face. <B> SoftBrain </B>

Italic : Italic element <I> and </I> causes the text to appear in Italic type

face. <I> SoftBrain </I>

Underline : Underline element <U> and </U> causes text to underline. <U>
SoftBrain </U>

Strike : Strike element indicates that text enclosed in <S> and </S> will have

a line drawn in the middle of text.

<S>

SoftBrain </S>

Teletype : Teletype element changes the font like a monospaced type writter font.

<TT> SoftBrain </TT>

SuperScript : Raised one point text upper word 15th August or SoftBrainTM .

15 <SUP> th </SUP>August 15th August

Subscript : Text Raised down one point downward.

H<sub>2</sub>SO<sub>4 </sub> H2SO4

Controlling Font Size and Color : All text specified within the tags <Font> and </Font>
will

appear in the font size and color as specified as attributes of the Tag <Font>The
attributes :



Face = Sets the font to be specified font name.



Size = Sets the size of the text. Size can take values between 1 to 7.

Color = Sets the color of the text.

<Font face=“Arial” size=4 color=”green”> SoftBrain Informatic Technology

Pvt. Ltd.</Font>

Bgcolor Attributes : Specifies background color using color name. <Body
Bgcolor=”RED”>

Text Attributes : Specifies foreground color or the color of the text. <Body
Text=”Aqua”>

Using Special Characters :
Non-breaking space &nbsp;
Copyright Sign &copy; Copyright ©
Registered Trademark &Reg; Softbrain ®

Trademark & #8482; SoftbrainTM

LIST STYLE

Lists are the best method of organizing information and presenting it in a structure

fashion Basically there are three kinds of lists. They are:

Ordered List(Numbering) : An ordered list start with the tag <ol> and ends with </ol>.

Each List Item<Li>start with tag <Li>.If tag <Li>is not present at the beginning ,the listed

items appear on the same line. Using Attributes : Type Attribute type=”1” will give
Counting numbers (1,2..........) type=”A” will give Uppercase letters (A,B..........)

type=”a” will give Lowercase letters (alb..........) type=”I” will give Uppercase
Roman numerals.(I,II,III......) type=”i” will give Lowercase Roman
numerals.(ixia....... )

Start Attribute: The start attribute allows you to specify the beginning of the list’s
numbers.( Start=”1” )

Unordered List (Bullet):We use the tag <UL> and </UL> for unordered List.

Attributes of Unordered List type=”circle” type=”square”
type=”disc”



Definition list: The definition list uses the <DL> start tag and the </DL>end tag to create

a definition list. Definition list consists of two parts.

Definiton term=Appears after the Tag <DT>

Definition description=Appear after the Tag <DD>

Result In Internet Explorer : KEYBOARD

AN INPUT DEVICE

ADDITON OF GRAPHICS / IMAGES IN HTML DOCUMENTS

Other than text,HTML allows placing of static and animated images in an HTML

page.

The commonly used image file types are GIF(Graphic Interchange Format) JPEG(Joint

Photographic Experts Group) also called as JPG.To add an image in HTML document

,you just need to include the <IMG> tag with a reference to the desired image.The <IMG>

(image) tag is an empty element (i.e. it doesn’t require a closing tag).

<IMG SRC=”imagename.gif”>

<IMG SRC=”imagename.jpg”>

Image Element Attributes:

Align Attributes with Text : Align=Top / Middle / Bottom
Eg: <Img align =”middle” src=”picture.gif”>

Align Attributes with Floating Image: Align=Left / Right

Border : specifies the size of the border to place around the image.

Height : specifies the height of the image.
Width : specifies the width of the image.

Hspace : indicates the amount of space to the left and right of the image.

Vspace : indicates the amount of space to the top and bottom of the image.

Alt Attribute: ALT attribute for the <IMG.....>tag allows for substitution of a
description string of text to hold the place of the image. <Img Alt=”Success
Is A Journey” Src=”Image.jpg”>



Alt working for text



<a href=”filename.html” title =”Success Is A Journey” >link content</a>

CREATING TABLES

Table present information in the form of rows and columns.To include a table in

your web pages you first need to create the table structure and for that you use HTML’s

Table Tags.

<TABLE> The table’s beginning with a <TABLE>tag and the end with a

</TABLE>tag.

<TR> The table row element <TR>with an optional </TR>end tag creates a

horizontal row of cell.

<TH> The table heading <TH>with an optional </TH>creates leading cells.

<TD> The table data element <TD>tags with an optional </TD>end tag.

Table Attributes : <Align>Attribute :

<Table Align=”Left” / ”Center” /”Right”>

<Border>Attribute : <Table Border=5>
Bgcolor Attribute: <Table Bgcolor=”Color Name Or Color Value”>

<Tr Bgcolor=”Color Name”>

<Td Bgcolor=”Color Name”>

<Th Bgcolor=”Color Name”>

Background Attribute: This sets an image on the Background of table.
<Table Background=”Computer.jpg”>

Caption :This tag is optional and it contains tables description.

<Caption Align=Top/Bottom/Left/Right>Caption Text</Caption>
Width & Height Attribute: <Table Width=”300” Height=”400”>

Cell spacing Attribute: You can use cell spacing attribute to control the spacing
between each cell in the table.

<Table Cell spacing=”Number”>

Cellpadding Attribute: (Spacline between cell content and cell border)
<Table Cellpadding=”Number”>



Rowspan Attribute: The rowspan attribute is used in a cell to make the cell’s
content merge with another cell in a row. <Td
Rowspan=”Number”> <Th Rowspan=”Number”>

Colspan Attribute : Similar to ROWSPAN,COLSPAN attribte is used in a cell to
make the cells content merge with another cell in a column.

<Td Colspan=”Number”> <Th Colspan=”Number”>

LINKING DOCUMENTS

LINKS: HTML allows linking to other HTML documents as well as images.

Clicking on a Section of text or an image in one webpage will open an entire webpage

or an image. The text or an image that provides such linkages is called Hypertext, a

Hyperlink or a Hotspot. Every Hyperlink.

1. Appears in blue color.

2. The hyperlink text / image is underlined.

3. When the mouse cursor is placed over it, the standard arrow mouse cursor changes

to the shape of a hand.

The blue color, which appears by default, can be over ridden. To change these

link colors there are three attributes that can be specified with the <BODY>tag. These

are:

Link: Change the default color of a hyperlink to whatever color is specified with this tag.
Alink:( Active Link)Changes the default color of a hyperlink that is activated to
whatever color is specified with this tag.

Vlink: (Visit Link)Changes the default color of a hyperlink that is already visited to
whatever color is specified with this tag.

The Anchor Tag: Anchor elements are used to link between two or multiple HTML
documents.”Anchor” tag starts with <A>and enclose with </A>.The <A>tag requires the

HREF attribute and (hyperlink reference) attribute accepts the URL of the linked page.
<A HREF=”filename.html”>content</A>



Every hyperlink has two components: The source and the destination.
<a href=”http.// www.yahoo.com/”>OPEN YAHOO SITE</A>

Images As Hyperlink : Just as text can act as a Hyperlink, so also images can act as
hyperlinks.

<A href=”abc.html”><img src=”image.jpg”></A>

External Link: links with other html document.

Internal Link: link in a same document. The anchor element is used to create both
external and internal links.

Name Attribute: Named Anchor are used to create links to a specified section within
document.

This is a two step process: At Top of page after Body Tag

<A NAME=”LOCATION”>

At bottom of page before Body Tag <A
HREF=”#LOCATION”>Content</A>

MARQUEE
Marquee Tag: For scrolling text and image.

<Marquee>-----------------------</Marquee>

Marquee Attributes

<Marquee behavior=”slide”> </marquee>In this text scrolls for one time only.

<Marquee behavior=”alternate”> </marquee>In this text will scroll
continuously left to right.
<Marquee behavior=”scroll”> </marquee>In this text will scroll continuously.

For direction of scrolling
<Marquee behavior=”slide” direction=”right”/”up”/”down”>

For background color/width/height
<Marquee behavior=”slide” bgcolor=”red” direction=”right” width=”500”

height=20>

For speed controlling in marquee

http://www.yahoo.com/


<Marquee scroll amount=1 maximum slow & 1000 maximum fast>

<Marquee scroll delay=1000 maximum slow & 1 maximum fast>

MULTIMEDIA

Multimedia refers to “Multiple Medium” that is the ability to add sound and moving
pictures to your webpages.

Adding Video : <embed src="movies.mpg" height="200" width="200" >

Adding Sound : Webpage contain basically two varieties of sounds that play
whenever the visitor accesses the webpages that is the background sound, and when

the visitor clicks something. The most common sound file formats are MIDI (Musical

Instrument Digital Interface), WAV (as in Wave), AU (Audio) and (Audio Interchange File

Format).

Sound files can be added in many of the ways. we can use the <A> anchor tag so

that the visitor has the option whether to hear the sound or not. For example :

<A href=”music.wav”> Click Here For Background Music </A>

As the user clicks on the text, the background sound starts. So the visitor has the

option whether to hear the sound or not.

Second option requires <Bgsound> tag : <Bgsound src=”Sound url”>

Here the src attribute specifies how many times the sound should play. If loop is

specify loop = No or infinite to play the sound is an endless loop.

Adding Animated Gif’s : (Graphics Interchange Format)

<img src=’A.gif” width = 100 height = 100>

FORM Creation in HTML

Creating A Form : Webpages can be interactive if they collect information from
the user. An HTML form is used for creating inteactive web pages.The information

entered by the user is passed back to a web server where it might be recorded in a

Database for further use.So,a form is simply a collection of fields of information.These



fields of information can be in the form of text boxes,radio buttons,pull down menus



etc.Common uses of forms are Online order forms,Feedback forms,e-mail registration

forms,or any web page in which input is required from the user in order to complete a

given task.An HTML form consists of two parts.The first part,the user can see and which

he fillout and next one is the part, the user can’t see.The second part specifies how the

server should process the user’s information.Here we commenly used PHP script.

The Form Tag : A form must start with a <FORM>tag and end with a </FORM>tag.It has
mainly two attributes:

1. Action

2. Method
Syntax:<Form action=”URL” method=get/post>Form

Elements............</Form>

Action is used to specify e-mail address that will receive the form information.If

you have written a form handler

to which the data in the form will be sent,then you will have to add an action=”←RL”

attribute to specify the location of the handler.

The Method attribute tells the browser how to send the user’s data to the
server.There are only two possible values for the method attribute: Method=”get” or

Method=”post’. The default value is “post”.

Using Form Control Elements : The form element can contain different elements to

create form controls.

Input Element : The <input>tag allows user to input information.

Text: Used to create the single line text boxes.

Password: Similar to text,except the characters you type are not seen on screen.
Checkbox: As on or off switch.

Radio: Similar to a checkbox,except that in a group of radio buttons only one radio
button can be on at a time.

Submit: Submits a form to be processed.

Reset: Clears all the input on a form.



Button: creates a button similar in appearance to a submit button.



File: Can be used to send a file from the surfer’s computer along with the rest of the form
data.

Form Creation:

Fieldset and legend tag : <Fieldset> tag is used to group more form controls together.

The <legend> tag, which is optional these tags require closing tag.The Syntax is :

<Fieldset>

<Legend>Group Label Text</Legend>

Control 1 Control 2 Control 3 Control 4

</Fieldset>

<html>

<head><title>Feedback Online Form</title></head>
<body bgcolor=”black” text=”white”>

<form>

<fieldset>
<legend align=”right”>Form info@softbrain.org</legend>

Input Element : The <input>tag allows user to input information.The <input>element
consists of <input>tag along with type attribute(to specify what type of form control you

want),the Name attribute(to indicate the field name),and other optional attribtes.The type

attribute can accept text,checkbox,radio buttons etc.as its value.Below is a list of all

possible values of Type.

<input type=”text” name=”text-id” value=”default-text” size=”n”
maxlength=”n” read only>

The name attribute is used as an identifier for the contents of the form

component when the form is submitted.This name is not visible to the user and must be

unique within the form.The value attribute is optional and is used to supply intial text to

the text field.The content of this attribte will be shown on the text field,unless the user

mailto:info@softbrain.org


changes it.We can specify the physical size of the text input box by using size



attribute.The default value is usually a length of 20 characters.You can,also set the

number of characters a user can input.The maxlength attriubte does this.This setting

should not be less than the value of the size attribute.Otherwise your user won’t be able

to type to the end of the box and might get confused.The default value of maxlength is

unlimited.The read only attribute is used to disable the contents of the text. The <label>
tag is used for given bold heading names in form.

Text field: the most common type of form<input>is text.It presents the user with a
prompt for a single line of text.These fields are commonly used for a

name,address,email address etc.

<input type=”text” name=”text-id” value=”default-text” size=”n” maxlength=”n”>

<label>Full Name</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;&nbsp;&nbsp;&nbsp;

<input type=”text” name=”t1” size=25 maxlength=25 value=” ” ><br>

<label>Full Address</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;

<input type=”text” name=”t2” size=25 maxlength=25 value=” ” ><br>
Checkbox: A checkbox is simply an empty box and contain a checkmark when
activated. An input tag with attribute type=”checkbox” offers the user an “on” or “off”
switch.It is similar to a radio button,but any number of checkboxes may be switch on at
same time.If a checkbox is switched “on” when the form is submitted,its value attribte is
submitted as the form data for the named form component.Each checkbox has a
seprate name specified by the name attribute. The syntax is:

<input type=”checkbox” name=”box id” value=”checkbox” checked>

<label>Internet / E-Shopping</label><br>



&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;



<input type="checkbox" name="c1" value="checkbox" checked>

&nbsp;&nbsp;Computer&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="checkbox" name="c2">

&nbsp;&nbsp;Laptop&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="checkbox" name="c3">

&nbsp;&nbsp;Ipod&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="checkbox" name="c4">

&nbsp;&nbsp;UPS&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="checkbox" name="c5">

&nbsp;&nbsp;Mobiles&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;<br>

Radio Button: Radio buttons allows the user to choose one of the several options.On
selecting one of the option the other options are automatically deselected.The buttons

appear as small circles. with prompt and the selected one appears with a solid dot in

it.You can indicate the default choice by using a checked attribute.You have to use a

unique value for the name attribute for all radio buttons in a particular set.Syntax:

<input type=”radio” name=”radio id” value=”radiobutton” checked>

<label>Gender</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<input name="radiobutton" type="radio"

value="radiobutton">&nbsp;&nbsp;&nbsp;&nbsp;Male

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;

<input name="radiobutton" type="radio"
value="radiobutton">&nbsp;&nbsp;&nbsp;&nbsp;Female<br>

Pull Down Lists: This element creates a menu control. Using this either a drop down
menu or a list box can be displayed in the web page. Also this element must contain



more than one option. Here you use <Select> instead of <Input> and it has a closing



tag</select>. These fields allow user to select single or multiple responses..The name

attribute establishes a name for the select field and is used for form processing. The

size option is simply the number of options you want to show in the window. By default,

its value is one specifying size value greater than one turns the pull down list into a

scrolling list. You can use the Multiple attribiute to set the select field to accept only one

option. To select multiple options press Ctrl Key and click on the options.The <Option>

tag includes the list items. For each list item, there must be an <Option> tag. The

closing tag is optional. You can use Value attribute to specify the text to be submitted

when the particular item is selected. Use selected attribute to indicate the default menu

item.

<label>Year</label>
<select name=”Text id” size=”n” mulitple>

<option value=”Choice Id 1” selected>2000</option>

<option Value=”Choice Id 2”> 2001 </option>

</select>

<label>Date of Birth</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;MM&nbsp;&nbsp;&nbsp;

<select name="s1" size=1>

<option name="01">january</option>

<option name="02">february</option>

<option name="03">march</option>

<option name="04">april</option>

<option

name="05">may</option></select>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

DD&nbsp;&nbsp;&nbsp;

<select name="s2" size=1>

<option name="01">01</option>



<option name="02">02</option>



<option name="03">03</option>

<option name="04">29</option>

<option name="05">30</option></select>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

YY&nbsp;&nbsp;&nbsp;

<select name="s3" size=1>

<option name="01">2001</option>

<option name="02">2002</option>

<option name="03">2003</option>

<option name="04">2004</option>

<option name="05">2005</option>

</select><br>

Text Area Tag: It is an extension of text element. The input element type=”Text” creates
a single line text box and Textarea tag creates a multiple line text box. It sets an area

with in a form in which the user can type a larger section of text. The text area tag

presents a multiple text window with the size specified by the rows and cols attributes.

Rows gives the height and cols give the width of the text area.

<Textarea name=”text-Id” rows=”n” cols=”n”>Type any Text here...

</Textarea>

<label>Type Your Message Here</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<textarea name=”ta” rows=15 cols=60></textarea><br><br>

File Control: This control lets the user submit a file on their computer along with the
form.The size attribute specifies the physical size of the fields input box. The accepts

attribute is used to restrict the file types allowed in a file upload.



<Input type=”file” name=”file-id” size=”n” accepts=”file-type”>



<label>Attach your Resume</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="file" name="file"><br><hr>

Password: Password field is exactly similar to text field,except that it displays
****(asterisks) instead of the actual input.These fields are mainly used for confidential

contents.

<input type=”password” name=”passwordid” value=”default text”>

<label>Login : </label><br>

<label>User

Name<label> &nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs

p

;&nbsp;&nbsp;&nbsp;

<input type="text" name="t1" size=25 maxlength=25 value=" " ><br>
<label>Password<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&

nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="password" name="pass" size=25 maxlength=25><br><hr>
Button Value: Creates a button similar in appearance to a submit button,exept that this
kind of button doesn’t do anything in particular.←sing button value of type attribute you
could have buttons of your choices. You normally require these buttons for executing
various scripts. These buttons have no default functions like submit &

Reset.The name attribute assigns a name to the button and is used for form processing.

The value attributes accepts a text that appears on the button. The button size will be

controlled directly by the text lenght. The ONCLICK attribute gives the name of the

script that is to be activated when the button is clicked.

<Input type=”button” name=”button id” value=”click here”
onclick=”Script”>



Image Button: Exactly the same as a submit button,except that you can specify any
image instead of the normal gray button appearance. An input element with

type=”Image” creates an image button.Instead of text an image of your choice is

displayed.The attributes for an image button are similar to the attributes for <IMG> tag.

Here you have to specify SRC or Images for aligning them in left, center or right

<input type=”image” name=”img” src=”pic.jpg” height=50 width=100>

Submit Button: Every form must have a submit button as after filling up the form, the
visitor needs to submit the information to you. An input tag with type=”Submit” provides

a button that submits the information in the complete form to the URL, given as the

action attribute of the form tag.By default,”Submit” is written over the button is taken

from the value attribute. The button size will be controlled directly by the text length.

<input type=”submit” name=”sub” value=”Submit”>

Reset Button: The reset value of the type attribute cleans all form entries to the default

once or leaves them blank if no defaults are specified.As the reset button can simply

wipe off all the work done, therefore it should be well labeled and should never be

placed before submit button.

<input type=”reset” name=”res” value=”Reset”>

</fieldset>

</form></body></html>

FRAMES

Frames are used to create a document that divides the browser window into different
parts and display a different web page in each of them.A frame set document is a

document that defines one or more frames by using frameset and frame

elements.Frames can communicate with each other so that an action performed on a

page in one frame can change the contents and behavior of another frame.A common

frame layout uses an index frame with links on the left,and a content frame on the



right.As you click on the links on the left frame,the corresponding HTML page will

appear on the right frame.One frame can be used to keep some information static while

the other frame can contain the actual content of different sections of website.

The <Frameset>Tag: The splitting of a browser screen into frames is accomplished
with the <frameset>and </frameset>tags embedded into the HTML document. The

<frameset>tag required one of the following two different attributes depending on

whether the screen has to be divided into rows or columns.

Rows & Cols: Row attribute is used to divide the screen into multiple rows.Cols
attribute is used to divide the screen into multiple colums.It can be set equal to a list of

values.Depending on the required size of each Rows and Columns.The value can be:

1.A number of pixels.

2. Expressed as a percentage of the screen resolution.

3. The symbol,’*’ which indicates the remaining space.
Example:<Frameset Rows=”50%,50%></Frameset>

Result: It divides the browser screen into two equal horizontal sections.
<Frameset Cols=”50%,50%></Frameset>

Result:It divides the browser sceen into two equal vertical sections.

The <frame>tag: Once the browser screen is divided into rows(horizontally)and
columns(vertically),each different HTML document.This is achieved by using the

<Frame>tag which takes in the following attributes:

Name=”name”: Gives the frame a unique name so it can be targeted by other
documents.The name given must begin with an Alphanumeric character. <Frame
Name=”AA”>

Src “Url”: Indicates the URL of the document to be loaded into the frame.

Creating Framed Documents: Creating frames is actually quite simple.First of all you
need to decide as how do you want to divide the browser’s window of the

webpage.Then write the html document that you want to put in the page segments.In



addition to this a master document is to be written which is used to specify what goes



where.Suppose we want to divide a page into two rows and four columns.Then the

HTML code for the frameset will be:

<html>

<head><title>FRAME ONLINE....</title></head>

<frameset>

<frameset cols="30%,*">

<frameset rows="50%,50%">

<frame name="aa">

<frame name="bb">

</frameset>

<frameset rows="50%,50%">

<frame name="cc">

<frame name="dd">

</frameset>

</frameset>

</frameset>

</html>

The <Frameset>and <Frame>tag: The master page doesn’t have a <body>

tag.Instead,it uses

<Frameset> tags. The <Frameset>tag is included after the <Head>tag and it establishe

frames within the HTML document.It does all the dividing.It requires a closing tag and



there may be any number of frameset tags within an HTML document.The cols attribute



is used for vertical frames whereas the rows attribute is used for horizontal frames.The

width or height are specified as a comma-delimited list of sizes in pixels,percentage or

as a proportion of the remaining space by using “*”.

Another basic tag is the <FRAME>tag.It contains the frame content and it tells the

browser what to put in each frame.Each frameset must include a

<FRAME>definition for each division.As in our example there were four partitions and so

four <FRMAE>tags.Notice that frame does not have a closing tag.

Frame Border Attributes: By default,most browser use a frame border.Border
attributes that control the frame border.To turn off frame border set border=0 and for

turn on border set border=8.You can use these attributes both in the <frameset>or

<frame>tags.To remove all the borders from your frames add them in the

<frameset>tag and to remove the border from individual frames include these attributes

in the corressponding<frame>tag.You can also set the color of the border by Just add

bordercolor=”purple”.



Controlling Scroll Bars: Scrolling controls the appearance of horizontal and vertical scroll
bars in a frame.This takes the value Yes / No / Auto.

In simple words,if the frame’s content goes beyond the frames width,most browsers

add scroll bars so that the user can see the full content.Even through scroll bars are

useful to see all the frame’s content,sometimes they can be unnecessary and visually

disturbing.You can control the use of scroll bars in a frame by including scrolling

attributes.

Yes means the frame gets scroll bars-whether they are needed or not.
No means there will be no scroll bars,even if your frame content is much

large.The browser will simply display as much as it can.

Auto is default If scroll bars are needed,they appear,it they are not needed they stay
conveniently out of the way.

Targeting Named Frames: Whenever a hyperlink which loads a document in a frame
is created,the file referenced in the hyperlink will be opened and will replace the current

document that is in the frame.

In a situation where the new document needs to be opened in a different frame while

keeping the document from which the new document was browser open in a different

frame,a simple HTML coding technique must be used.

Since the hyperlink must open an HTML file in another frame,the frame in which the

HTML file is to be opened need to be named.This is done by using the name attribute of

the <FRAME>tags.The name takes one parameter,which is the frame name.The

hyperlink tag will have to be supplied with the following information:

1. The filename.html file that has to be opened.

2. The name of the frame where the filename.html file has to be opened. The
attribute via which the frame name is specified is the TARGET attribute,which is a

part of the <A> </A>tag.This information is given as:

TARGET=”framename”



<a href=”filename.html” TARGET=”framename”>Link Content</a>

WEB EDITOR NOTEPAD
There will be times when you will want to edit textual files. Textual files are different from

documents created by WordPad, Word, WordPerfect or some other word processing

program in that they contain no imbedded codes. Editing these files with a word

processing program can introduce special characters that make these files unusable.

Instead, use Notepad which allows you to edit the file as pure text.

Textual files will normally have a TXT file extension, but there are several special purpose

files in Windows that must be pure text. Some of the more important of these include your

CONFIG.SYS, AUTOEXEC.BAT, WIN.INI and SYSTEM.INI (These files existed in earlier

version of Windows, but have been eliminated in Windows XP). You may get to the point

of wanting to play with these files. If so, use Notepad to edit these and not WordPad as

your system cannot use the resulting WordPad file. If you decide you want to create a web

page, but don't have an HTML editor, you will want to use Notepad so as not to introduce

those nasty characters associated with WordPad, etc.

In addition to having a tool to use in editing those special files on your system, learning

Notepad can provide a good foundation for learning some of the other tools that come

with Windows 95/98/ME/XP as well as a number of the applications that you may want to

add to your system later. Notepad is simple to learn but has some features in common

with other programs.



The first thing I want to point out in the above is that I have entered some text into Notepad.

Okay, let's look at some of the features of Notepad. Let's start off by looking at each of

the menus across the top of Notepad. Before we go to the individual menus, notice

something about the menu bar itself. See the underlined letters in each of the menu items

(File, Edit, Format, View, etc.) (Under Windows XP, the underlines are only visible when

you hold down the <Alt> key - previously the underlines were always visible)? These are

meaningful. If you hold down the <Alt> key and press these letters, you will select that

menu. Obviously you can select each menu with the mouse, but this gives you an

alternative way of getting into them. So, you can get into the File menu by pressing <Alt>F.

File Menu



This is the File menu. Notice a couple of things about this menu. Notice the "..." at the end

of several selections. This indicates that selecting these items will take you to a dialog box

that will allow you to carry out that operation. Notice the code down the right side of the

menu - Ctrl+N, Ctrl+O, etc. These are hotkeys you can use from within the document

without having to go into the menu. For example, holding the <Ctrl> key down and

pressing N is the same as going into the File menu and selecting New. These hotkeys

can save you some time in getting to these functions. I wouldn't try to memorize these

hotkeys right now, but just make a mental note of them - you'll learn them over time as

you find them appropriate to your situation.

New - This will start a new document. If you are currently working on a document that you

haven't saved, the system will prompt you to save the old document before starting a new

one.

Open... - This allows you to bring an existing document into Notepad to view and/or edit it.

You'll see the following dialog box when you make this selection:



This is the standard Open dialog box used by most Windows programs. It consists of a

toolbar across the top that shows you which folder you are currently in along with a couple

of control buttons for getting to where you want to go. The main part of the Open dialog

box shows you the files/folders that match the criteria for this application. Next is where

the system will tell you the name of the file it thinks you want. Right now, it doesn't know

so it assumes you want to look at all TXT files. Next is where you can tell the system what

type of files you are interested in looking at. By default, Notepad looks at Text Documents

(*.TXT), but you can change this to look at anything else. Finally, you can either Open the

selection or Cancel this operation.

Save - If you are making modifications to an existing file, Save will put the changes back

into the file after confirming that you really want to make the changes. If the file you are

working on is a new file, Save works the same as Save As....

Save As... - Save As... brings up a dialog box similar to the Open dialog box above. In

Notepad you get to save the file wherever you want, but the best place would be in My



Documents. It's easy enough to change folders and save a file anywhere on the system

you want. See Naming a File for some suggestions on how to organize your data.

Page Setup... - The Page Setup... dialog box allows you to customize some of the things

you see when you print your document. For example, you can change the size of your

paper, customize the header and footer on each page as well as the margin at the top,

bottom and either edge of the paper. The Page Setup... dialog box looks like this:

Print... - This is a standard print operation. It brings up the Print dialog window where you can

modify the printer information.

Exit - This shuts down Notepad. If the file you've been working on has not been saved, you

will be prompted to save the file before Notepad exits.

Edit Menu



The Edit menu contains those functions that allow you to manipulate the information you

have on the screen. In this case, there are four items that appear dim in the menu. The

reason for this is that these items are not available at the present time. In most cases, you

have to have something selected for these items to work. Windows does a pretty good job

of communicating with you to tell you what you can and cannot do. Also notice that most

of the items in the Edit menu have a key combination on the right (Ctrl+Z, etc.). These are

hot keys that can be used from within the document without having to go to the Edit menu.

For example, you can do a Copy from within a document by holding down the <Ctrl> key

and pressing the "C" key. I don't recommend that you try and memorize these hot keys

just now. Instead, I would recommend that you just make note of them as you use the

menu items and over time pick up on those you use most frequently.

Undo - Notepad does have a rather neat feature called the Undo. In essence, this is your

Oops button. If you make a mistake and suddenly say "Oops", you can select the Undo

and reverse whatever it was you just did. Unless I'm mistaken, the Undo item will only

work on the most recent change you've made to your document.

Cut - Again, this item is only available if you have something selected in your document.

Otherwise you have nothing to Cut. You can select some piece of your document by

holding down the left mouse button and dragging across the letters/words/sentences that

you want to select. Your selection will have white letters and a blue background.



Now you will be able to Cut this selection. Cut removes the selected text from your document
and puts it on the Clipboard. The information is not totally deleted, but is being held in case
you want to put it somewhere else.

Copy - Copy is very similar to Cut. The only difference is that with Copy, your selected

text is not removed from the document. Instead, a copy of your selected text is placed on

the Clipboard for you to use later.

Paste - Once you have some text on the Clipboard (using either Cut or Copy above), you

can move to wherever you would like to put this text and Paste it back into your document.

In other words, the combination of Cut and Paste allows you to move text around within

your document while the combination of Copy and Paste allows you to duplicate

information.

Delete - When you Delete text from your document, it is gone. If you do this by accident,

you can use the Undo function to bring it back, but otherwise it is gone. Delete does not

place the selected text on the Clipboard.

Find... - As you've already seen, this function opens a dialog box that allows you to enter

the text you want to search for along with a couple of pieces of information to help Notepad

perform the search. If the text is found, it will be selected ready for you to Cut, Copy or

overtype.

Find Next - This function simply repeats a previous Find......This is useful if you have the same

text in several different places within your document.



Replace - This function allows you to locate some text within your document and replace

it with some other text. It even has the ability to perform its function globally through the

document, but be careful of using this as it can get you into trouble. For example, suppose

you wanted to replace "eat" with "ate" globally throughout a document. This function

would do it, but it would also change "eaten" to "ateen", "cheat" to "chate" and "defeat" to

"defate".

Go To... - In Goto line, type the line number you want the cursor to jump to. You do not

have to have line numbers in your document for this command to work. Lines are counted

down the left margin beginning at the top of the document.

Select All - If there is something you want to do with all the text in your document at the

same time, all you have to do is select the Select All function and your entire document

will be selected. Now you can either Cut or Copy all the text to your Clipboard.

Time/Date - The Time/Date function is a neat feature of Notepad. Some people like to

keep a journal and in a journal, you might want to have the date and time as part of the

document. Obviously, you can type in the date and time, but with the Time/Date function,

Notepad will automatically insert the date and time like this: 7:47 AM 2/27/98.



Format Menu
Word Wrap - In some cases, you may want the text you type to appear on the same line,

but most of the time, you'd like to be able to see all the text on the screen at the same

time. If you only have a little bit of information, you might be able to enlarge the Notepad

window to see all the text. Another way of handling this is to select the WordWrap function.

This will take words that don't fit in the Notepad window and wrap them down to the next

line. A check mark appears when word wrap is turned on. Wrapping text enables you to

see all the text on the line, but it doesn't affect the way text appears when it is printed.

Font... - This allows you to change the font used to display the file you have open. It
doesn't change the font of the file itself. It simply allows you to view/edit files using

whatever font you wish.

View Menu



This menu only contains one item, Status Bar which will place an extra line at the bottom
of the Notepad window to keep you informed of what has or will be done as you work in

Notepad.

Help Menu

Most programs in Windows have a Help menu that provides information about using that

particular program. The Help menu may not answer all your questions about a program,

but I would encourage you to explore what is there before you look elsewhere. Most

companies marketing software today are providing more Help and less hardcopy

documentation.

Help Topics - Notepad is a very simple program to use as it doesn't contain a lot of bells

and whistles. As a result, the Help Topics is not very long. You should be able to explore

all of Help Topics in just a few minutes. I would encourage you to do so for two reasons.

First, you'll know nearly everything there is to know about Notepad. Second, you'll become

familiar with the format of the Help facility Microsoft uses so you'll know what to expect in

other Microsoft products.



About Notepad - The function of the About for any program is simply to let you know what

version of the program you are running. From time to time, the programmer might include

some additional information about your system, but don't expect this. Here's what my

version of About Notepad looks like:

Web Browser Internet Explorer

Basic Terms

One of the more popular and fastest growing areas in computing is the Internet.

The Internet is a collection of large computer networks, each of which is a collection of



smaller networks. A network is composed of several computers connected together for

the purpose of sharing information and resources. Consider your computer at Floyd

College. Your computer is connected to the local network at the college, which is in turn

connected to Peachnet, which is connected to the Internet. The software used to connect

computers is called Transmission Control Protocol/Internet Protocol, or TCP/IP.

The World Wide Web

Modern computers have the ability to deliver information in a variety of forms such

as graphics, sound, video, animation, as well as text. The ability to deliver information in

these different forms is called multimedia. On the Internet this multimedia capability is

available in a form called hypermedia. Hypermedia is any variety of computer media

including text, graphics, video and sound. On the Internet, hypermedia is usually

accessed through the use of a hyperlink. A hyperlink, or link, is a special software pointer

that points to the computer that contains the information in whatever format the information

exists. The collection of hyperlinks throughout the

Internet creates a network of links called the World Wide Web. Each computer in the Web

that contains hypermedia that can be referenced by hyperlinks and accessed by other

computers is called a Web Site. Hundreds of thousands of Web sites around the world

can be accessed through the World Wide Web.

URL (Uniform Resource Locator)

The URL of a Web page is a unique address of each individual Web page at the

Web sites on the Internet. A typical URL is composed of three parts. We will use the

URL below to explain the function of each part.

The first part of any web address is the protocol. A protocol is a set of rules that

computers follow. Most web pages use http, which stands for hypertext transfer protocol.

HTTP describes the rules for transmitting hypermedia documents electronically. The

protocol is entered in lower case as http and is followed by a colon and two forward

slashes. The colon and the two forward slashes are required punctuation. Other protocols



used on the internet include FTP which stands for file transfer protocol, gopher which

gives the rules for menu driven document transfer, and telnet which describes the rules

for remote terminal sessions.

The second part of a URL is the domain name. The domain name is the Internet

address of the computer on which the Web pages are located. In our example above, the

domain name is www.softbrain.org The last part of the domain name gives an indication

of the type of organization responsible for the Web site. For example, com at the end

indicates a commercial site, gov indicates a government site, and edu indicates an

educational site.

The third part of the Web address is the file specification of the web address. This

part of the Web address shows the filename of the web page as well as which folder or

folders contain the Web page. This is called the path name of the page.

HTML (HyperText Markup Language)

Web pages are created using a special formatting language called hyperText

Markup Language. HTML formatting codes are used to display the pictures and graphics

used to create Web pages. When you are viewing a Web page, you can see the HTML

code used to create the page by selecting the “↑iew” pull-down menu and then clicking

on “Source”.

Home Pages

A home page is the introductory page of a Web site. All other web pages for that site

can usually be reached through the home page.

Internet Browsers

A browser is a program that makes using the World Wide Web easier by removing

the complexity of having to remember the rules, syntax and commands for accessing Web

pages. Internet Explorer is the browser that you will be using in this course. Another

popular browser is Netscape Navigator.

http://www.softbrain.org/


Starting Internet Explorer
Before you can use Internet Explorer, it must be installed on your computer and

you must be connected to the Internet through either a local area network such as the one

at Floyd College or a modem. If the program is installed, you start Internet Explorer either

by double clicking on its icon on the desktop or by clicking on the start button, Programs,

and then Internet Explorer. When the program starts, you should see the Floyd College

home page. The title of the wen page will be displayed in the title bar.

The Internet Explorer Window

The Internet Explorer window contains several features to make your work on the

Internet easy. Several of these features are common to all Windows 95 applications such

as the title bar at the top with the menu bar containing pull-down menus below it.

Below the pull-down menus is the standard toolbar. Each of the main features of the Internet

Explorer screen is discussed below:

Menu Bar

The menu bar contains several buttons which are used to group commands into

groups. File contains the commands which relate to file operations such as saving a file

or printing a file. The Edit menu contains commands for editing your work. To display a

menu choice such as File, click on the word File in the menu bar. A list of choices should

appear below the word file. To select one of these menu choices, click on the appropriate

choice from the pull-down menu.

Display area

Most web pages are too large for the entire page to be seen on the computer screen

at one time. When viewing a page in Internet Explorer, you will usually see a scroll bar at

the right side of your screen, which can be used to scroll down and view the rest of the

document. Use the arrows on the top and bottom of the scroll bar to move up and down

through the document.



Some of the words on a web page will be displayed in blue letters. This is the

default color of text which is a hyperlink. A hyperlink is a pointer that sends your computer

to another place on the Internet simply by clicking on the link. Pictures and graphics can

also be hyperlinks. As your mouse pointer is moved over a hyperlink, the pointer changes

to a pointing hand to show you that whatever is displayed on that portion of the screen is

a link (pointer) to another place on the Internet.

Standard Toolbar

The buttons on the standard toolbar allow you to perform common tasks quickly

and more easily than doing those same tasks using the choices on the pull-down menus.

Two very important buttons are Back and Forward. These buttons allow you to move

through the web pages that you have viewed in Internet Explorer. The back button takes

you back one screen at a time while the forward button moves you forward one screen at

a time. Each button on the toolbar is normally gray. Color is added when the mouse

pointer is placed over a button.

Another important button on the standard toolbar is the STOP button. Some web

pages are very large and take considerable time to load and display. You might see the

first part of a page and decide that you do not need this page or you might decide that you

do not want to wait for the entire page to load. Clicking the STOP button will stop a web

page from being downloaded.

Address Bar

The Address Bar contains a white text box which displays the URL for the web

page currently displayed. The URL of a web page is its Internet address. These will be

discussed in more detail below. You can also type a web address into this box and press

ENTER to load the web page in Internet Explorer.

Internet Explorer Icon



The Internet Explorer Icon rotates while a connection to a web site is being made,

a web page is being loaded into memory, and a web page is being displayed on your

screen.

Status Bar
The Status Bar displays the URL of a link when the mouse pointer passes over the

link. It also provides information about the progress of your request to load a new web

page.

Toolbars

Several toolbars are available in Internet Explorer. Each one contains buttons that

enable you to easily move between web cites and stop a page from being downloaded.

Internet Addresses

All internet addresses have the same general format as shown below:

http:// www.softbrain.org

The first part, http://, lets the computer know that you are looking for a web server, not a

news or mail server. The middle section, www.softbrain.org, is the name of the computer

which contains the files you are looking for. The part that appears after the slash names

the folders and filenames of the documents you are looking for. The .html indicates the

type of document you are looking for, in this case HyperText Markup Language which is

the standard language in which all web documents are written.

↔ou can leave off the “http://” when typing an internet address in Internet Explorer.

Internet Explorer also assumes that the address will be in the form www.softbrain.org and

it is not necessary to type the www and the com. These will be filled in by internet explorer

if you leave them out while typing an internet address.

http://www.softbrain.org/
http://www.softbrain.org/
http://www.softbrain.org/


Note: Many computers on the internet are case sensitive so you need to make sure that

every letter that should be capitalized is capitalized. Also make sure that you are using a

forward slash “/” when necessary instead of the backslash “\”.

The Links Toolbar

The links toolbar provides a set of links to get the new user oriented to the internet. It

comes with connections to a variety of places including Best of the Web, Microsoft’s Home

Page, The Web Gallery, Product News, and Today’s Links. If you select one of the links

shown on this bar, Explorer opens that Web Page. From there you can access information

in diverse areas by following the links shown on the screen. As an example, if you choose

Best of the Web, you can access information on travel, entertainment, sports, and much

more just by following the links. Travel through the layers and eventually you will reach

an article discussing the subject in which you are interested.

Forward and Back Buttons

Two of the most useful buttons on your screen are shown in the upper left corner of your

screen on the standard toolbar. These are the forward and back buttons. Many times as

you explore on the internet, you will need to move back to a page that you have already

visited. By clicking the back button you can move back through the pages you have visited

one at a time. Then you can click the Forward button to move forward through the pages

as you browse for information.

Note: Once you move back to your first page, the Back button will be gray indication

that you have traveled as far as possible in this direction.

Note: You can only use the forward button after you have first gone back. Until

you go back, the forward button will be gray indicating that this option is

unavailable.

Home Button

If you become hopelessly lost in your internet explorations, you can always click the home

button to return to your Starting Page. This page could be out of date especially if it is

one that is updated frequently, so you might need to click on the refresh button to display

the latest version of the page.



Links

The World Wide Web is made of millions of web pages that are joined together by hypertext

links that provide a truly “point and click” environment for accessing information on your

computer. These links are really pointers that instruct your computer where to go on the

Internet to access the information you requested. By default, links are displayed in blue text,

but a web page can display its links in any color. There is one additional way that you can

identify a link. When the mouse pointer is moved over a hypertext link, the pointer changes

to a hand. When the mouse pointer changes to the pointing hand, you will see the URL of the

link displayed in the status bar located at the bottom of your screen.

Using Links

Links are activated by placing the mouse pointer on the link and clicking once with the left

mouse button. When you click on the link, Internet Explorer loads whatever document,

file, or web page that is attached to that link. While a document is being loaded, the small

globe in the upper left-hand portion of the screen will spin. Explorer will load the text of a

web page before it loads the graphics to allow you to begin reading the contents of the

page while the graphics, which load much slower, are being displayed. White boxes will

be displayed to mark the location of the graphics that will be shown later. When the globe

stops spinning, the page is completely loaded.

Note: If the globe stops spinning half-way through a turn or the message “connecting to

host” is displayed at the bottom of the screen for an extended period of time, then you

have a problem with the web page you are trying to load. Either the site was busy or just

not working for some reason. If this happens, click the “STOP” button located on your

toolbar at the top of the screen.

The Right Mouse Button

Once a web page is displayed, you might want to save the page for later use, or you might

want to use a graphic on the page as wallpaper. To perform either of these tasks, use

the right mouse button. Let’s suppose that you find an image that you want to save on

your hard disk for later use. Point to the image with your mouse and click the “right” mouse

button. A shortcut menu will pop up giving you choices such as saving the image or using



the image as wallpaper. In our example we have found an image that we want to save

on our hard disk, so we will select “Save Picture As” from the shortcut menu that appears.

You will be asked to name the image you are saving and select a location for saving the

file. Click OK when you are finished. ↔ou could also select “Set

As →allpaper” to make the picture the wallpaper that will be displayed on your desktop.

Using History

Internet Explorer provided other ways to move around in the pages you have visited than

just using the Back and Forward buttons. The History List allows you to instantly move to

any site that you have recently visited. History keeps track of not only the sites you have

visited today, but also keeps track of the sites you have visited in the past few weeks. The

exact length of time a site stays in history is determined by the user, but the default time

is two weeks. To use this feature, click on the History button at the top of your screen and

select the site you wish to revisit from the list.

Saving a Web Page

If you are doing research, you are going to need to save the information that you locate

so that you can use it at a later time. Web sites change so often that you cannot be

assured that the files you find on Wednesday will still be there on Thursday. For this

reason, saving files is an extremely important function of computer applications. To save

a web page, follow these steps:

1. With the web page open, click on the file pull-down menu.

2. Select the location where you want to store the file.

3. Give the file an appropriate name.

4. Click the save button in the dialog box.

Note: When you save a web page, all you are saving is the html code. The graphic

that were on the original site will be missing.



Adding Links to the Favorites Menu
When you are searching on the Internet, you will undoubtedly find certain sites that you

will wish to visit often. You can add these sites to a list of "favorite" sites. This is also

called a bookmark. Bookmarks on the internet are just like bookmarks in a book. The

mark your place.

To add a web page to your list of favorites, follow these steps:

1. While viewing the page you wish to bookmark, click on the "favorites" pulldown

menu.

2. Select "Add to Favorites".

3. In the name box, type the name that you wish Internet Explorer to use in your list

of favorites.

4. Click OK and this site will be added to your list of favorites.

Accessing the Favorites Menu

To view a page that you have listed as a favorite, simply click on the "Favorites" button on

the standard toolbar and select the web page that you wish to go to.

WEB FRAMEWORK DREAMWEAVER
Dreamweaver is a web authoring program that uses a →↔SI→↔G “what you see is what

you get” interface. The HTML code is being created and is accessible to you if you want

to play with it.

Finally, let’s get started with Dreamweaver.

Launch Dreamweaver



1. Start Dreamweaver. You should see a startup screen.3

Dreamweaver lets you publish your Web site by easily uploading your Web site to a →eb

server. Right now we won’t be worrying about that. For now, you will be creating and

viewing your site locally (which means the site will be located on your computer).

We need to define your site:

Create a New Site

2. From the Site menu, choose Manage Sites… The Manage Sites Box should appear.

3. Click New and then choose Site from the pop-up menu.

4. Click on the Advanced Tab under Site Definition for Unnamed Site 1.

Local Info

Local Info is where we put in the information about the files that are on your local computer

(which is where all your files are or will be for now).

5. In the Advanced Tab, under Category, choose Local Info. 4

6. Next to Site Name, type: My First Dreamweaver Web site. You will use this name when

you go into Dreamweaver to retrieve the files associated with this site. This name has to

be unique within Dreamweaver.

7. Next to Local root folder, click on the yellow folder icon to browse for where you want to

store your web site on your local computer. You may wish to create a new folder to sore

your files in. I stored my Web site on F: (my flash drive) in a folder I called My WebSite.

This is now your Root Folder

8. Click DONE. You should see a Files panel on the right side of your screen. The Local View

in the Files Panel will display all the files for your Web site that are in the Root Folder on

your computer. Later we will add information about connecting to the server. The Remote

View shows which files have been uploaded to the server.



9. Once we’ve entered all this information about local and remote servers, it will be set up for

us next time we use Dreamweaver on this computer. ←nfortunately, it doesn’t work that

way on lab computers. If you move to another computer, you will have to set up your Web

site on the new computer as well. 5

WHAT’S A ROOT FOLDER?
The local root folder is where you will keep ALL the files for your web site. You can create

subfolders under it, but consider it to be the parent of all parent folders.↔ou’ll keep all of

the files and subfolders for your Web site (including html pages, images, multimedia files,

etc.) either in the root folder or a subfolder under the root folder..

Making your first Web Page:

10. Under the File menu at the top, choose New.

11. In the New Document dialog box, make sure you have Blank Page selected, the Page

Type is HTML, and the Layout is <none>.

12. Click Create. You should now see a blank Web page in the Document Window.

13. Under the File Menu, choose Save.

14. In the Save As box, find your Web site folder and save your file as index.html

15. Click Save. In the Files panel, you should now see index.html. Congratulations! ↔ou’ve

created your first →eb page using Dreamweaver. ←nfortunately, it’s pretty boring at the

moment.

Save the Page

RULES OF THUMB for naming web files:

• Do not use spaces or special characters, such as those found about the number keys on the

keyboard, in your file names. You can use dashes and underscores. (e.g., my_page.html)



• Always use a 3- or 4-character file extension for every file you use on the Web. In the case

of a regular Web page, always use .html or .html.

• Be very specific about capitalizing because most Web servers are case-sensitive.

Give your Web Page a Title In the document toolbar, find the Title box.

16. On the document toolbar, locate the Title field. 6
17. Type in a title for your page. Feel free to be creative (but not indecent). Hit Enter.

18. The title doesn’t show up on the page, but will appear in tabs and across the top of

browsers. Adding Some Content Add Content to the Page

19. In the Document window, type in a good title. This one will be the head of your Web page.

If you can’t think of anything, you can always use, “Aardvark Adoption Society of

Delaware”.

20. Add a subtitle. Again, it can be anything you want. If you’d prefer, it could be, “→e speak

for

Aardvarks who can’t speak for themselves.”

21. Now that you’ve got a good title, add some content. Logically, it should go with the title.

Type one or two lines now for now. →e’ll add more later. (If you can’t think of anything, feel

free to throw in some of the Aardvark content).

Now let’s format the content:

22. On the Web page, highlight the title.

23. In the Property Inspector, click on the Format drop down arrow, and choose Heading 1.

Note: If you do not see the Property Inspector, choose Window >> Properties.

24. On the web page, highlight the second line of text.

25. From the Format menu on the Property Inspector, choose Heading 2.



Note: When formatting your text, keep in mind that text sizes in HTML are relative sizes. This

means that,

when your page is viewed in a browser, the text size will depend on the default text size

settings on each user’s computer. Relative sizes give users the ability to adjust the text

size to suit their individual needs.

This option is especially important for people with visual impairments, but it means that

the appearance of your pages may vary from computer to computer. Playing with Font

Properties

26. Highlight the Subtitle. Change the font size to 24. 7

27. Highlight any word on the page and click the Bold icon ( ) on the Property Inspector. The

selected word appears bold.

28. Highlight the title click the gray square to the right of the Size popup menu in the Property

Inspector. A grid of colored squares appears, and the cursor changes to an eye dropper.

29. Click the eyedropper on the desired color. The field to the right of the color swatch reflects

the code →eb browsers need to correctly display the color you’ve chosen.

30. Click anywhere on the page to deselect the text. The previously selected text appears in

the new color.

Alignment

31. 1. Highlight the title and subtitle on the page.

32. Click the Align Center button ( ) on the Property Inspector. The titles should now be

centered on your page.

Creating Lists

33. First we need to add a list. 8



34. Type in a title for your list and then type in a list of items. Make sure there are at least 3

items in your list. Make sure you hit return after each item. (Feel free to use a list from the

aardvark homework if you can’t think of your own.)

35. Highlight the list title and choose Heading 3 from the Format menu on the Property

Inspector.

36. Highlight the list items and click the Unordered List button on the Property Inspector.
37. The items appear as a bulleted list.

38. Now type in another List title and another list of items.

39. Highlight the title and select Heading 3.

40. Highlight the rest of the items and click the Ordered List button on the Property inspector

(next to the ordered list button). The items should now appear in a numbered list.

41. Save your work. Get into the habit of saving your work regularly.

Page Properties

In this section you will learn how to set your page’s background color, as well as the default

text and link colors. These settings differ from what you’ve done so far on the Property

Inspector because they’ll apply to all the text and links on the page—not just a selected

piece of text.

42. From the Modify menu at the top of the workspace, choose Page Properties.

43. To change the text color, click the bottom right corner of the text color box.

44. Using the eyedropper, choose a color by clicking on any of the color swatches.

45. Similarly, you can change the background color for the page using the Background color

setting. 9

46. You can also change the color of links, active links, and visited links. An active link is a link

just when the user clicks it. A color change lets the user know that s/he clicked on a link.



A visited link is one that the user has already clicked on and visited. A color change lets

the user knows /he’s already visited that link.

47. Select “Links” from the Category menu at left, then make your selections for link, visited

link, and active link colors as you did in Step 3.

48. Click the Apply button to see how your color choices look on the index page. The Page

Properties dialog box will remain on the screen.

49. →hen you’re satisfied with the colors you’ve picked, click OK.

Note: You can add a background image if you want. Browse to find an image by the

background image.

See what it looks like. Now you know that’s an option. →e’ll talk about this option more later.

For now, go back to a solid color background.

Note: If you changed the color for any text using the Property Inspector, those changes will

override general page color choices.

Web Page Preview

As you create a page in Dreamweaver, the page may not look exactly like it would in a browser.

To preview the page in a browser:

50. Choose File >> Preview in Browser >> ie explore or Netscape or press the F12 key.

A web browser, such as Netscape or Internet Explorer, opens and loads the web page.

51. Take a look at your page to see how it will appear on the Web.

52. When finished, close the browser and switch back to Dreamweaver.

NOTE: Colored or underlined text can be mistaken for links. Choose your color scheme

so that the links stand out from rest of the text. The text and links also should stand out

from the background for readability. When selecting colors, keep it simple. Too many

colors can be distracting or confusing.



Adding Images

Note: Any editing or resizing of an image should be completed before it is added to a web

page.

53. First you need an image. Feel free to find one on your own that suits the theme of your

web page. If you don’t feel like it, I’ve included an image on my →eb site that you can

download.

54. Next, add it to your Web page.
55. Place your cursor below the sub-header in your document and press Enter twice.

56. 2. Choose Insert >> Image. The Select Image Source dialog box will appear.

57. 3. Using the dialog box, locate and select an image, then click OK. 10

58. 4. You will first encounter a prompt to add accessibility attributes:

59. Type a brief description of the image in the Alternate text box, then click OK.

60. Because you’re trying to use a file that lies outside your root folder (my website), you’ll

receive the following message:

61. Click Yes. The Copy File As dialog box will appear.

62. Click the Save button to place a copy of the image file inside your my website folder.

63. The image will appear on your web page.

64. Click the Refresh button on the Files panel ( ) and the image file will appear in the list of

local files.

Delete an Image

65. In the Document window, click on the image to select the image.

66. Press the Delete key. The image disappears.



67. To reverse the deletion, use the Undo command. From the Edit menu, choose Undo. The

image should re-appear on the page.

Create a Second Page

Next, you will create a second page for your Web site.

68. From the File menu, choose New…The New page dialog box appears.

69. Click the Create button. The new file will appear in the document window.

70. Save your new page in the my website folder as Page2.html
71. In the Title field, type an appropriate title for this page. →e’ll eventually make it into a

Calendar of Events Page, if that helps you decide on a title.

72. Save your work.

Page Planning: When planning your Web site, you will need to decide how to

organize each Web page. What will be placed on each page. Divide your site into

pages for simple access. If your readers want to read or print only a calendar of

events, you don’t want them to have to print the entire site to see it. ↔our site

planning will also include how the pages will be linked together.

Page Navigation

Now that we have two pages, you can link them together. →e’ll link the index.html page to

the Page2.html and vice versa. It’s easy in Dreamweaver!

73. Use the tabs on the Document toolbar to toggle back to the index page.

74. On the index page, type some descriptive text that describes your Page2.html.

75. Highlight the text you want to make a link.

76. In the Property Inspector, click on the Browse for File icon to the right of the link box.



A Select File dialog box appears. 12

77. Using the dialog box, locate and select the file Page2.html.

78. Click the OK button. Cool! You just made a link!

79. The selected linked text is underlined and appears in the link color you chose. In the

Property Inspector, the Link field reads: “Page2.html

80. Save your work and preview the page in a browser.

81. Test the link. When finished, return to Dreamweaver.

82. Now, try linking Page2.html back to the index page.
83. Save your work and test the new link in a browser.

Note: The text you use for your link should be brief but descriptive, giving your visitors an idea

of where the link will take them even before they click it.

Let’s compare: click here for more information lacks detail.

Compared to Calendar of Upcoming Events , which is clear and concise.

84. Link to a Web Page

85. Next let’s add an external link. By that I mean let’s link to a →eb page that is located

somewhere on the →orld →ide →eb. →e’ll need to use the full (absolute) ←RL to link to

this page.

86. Go to the bottom of your index.html page and type “More info on Aardvarks”.

87. Highlight the text you just typed.

88. In the Link box in the Property Inspector, type http://en.wikipedia.org/wiki/Aardvark/ and

press Enter.

89. The text you selected should now link to →ikipedia’s web page on Aardvarks. To make

sure the link works properly, preview the page in a browser.

http://en.wikipedia.org/wiki/Aardvark/


90. Switch back to Dreamweaver to continue editing your page.

Add an E-mail Link

Now you’ll make your e-mail address a link so that visitors can send you questions and

comments via email.

91. At the bottom of your page, type “Send me an email” and highlight the word email.

92. From the Insert toolbar (across the top, below File Edit, etc.), click on the envelope icon

to insert an email link.

93. Place your cursor in the E-mail box and type your email address:

94. Hit OK. Your e-mail address appears as a link.
95. Save your work. Please note that the email link will try to open a desktop email program

if you have one on your computer. However, if the computer you’re working on doesn’t

have an email program set up, testing this link won’t work.

Note: One of the advantages in creating a course Web site is adding appropriate links to

other sites on the Web. You may want to compile a list of links that support your

instructional goals. This allows you to supplement your page with appropriate Web

resources. Plus it’s always fun to look around at other relevant pages to learn new things

about your topic and create your own relevant Webliography.

Creating a Link within a Page

Create the Target of the link

96. Place your cursor at the top of your page

97. Choose Insert >> Named Anchor. The Named Anchor dialog box will appear.

98. In the Anchor Name box, type a name for the anchor. This should describe the content in

that section of the page.



99. Click OK. A yellow anchor will appear just before the text. If the yellow anchor symbol

does not appear, then choose View >> Visual Aids >> Invisible Elements.

Create a link to the anchor

100. At the bottom of the page, type “Back to Top”. Highlight this text.

101. On the Property Inspector, click on the point-to-file icon to the right of the Link field and

drag it to the schedule anchor symbol. (You literally click on it and, without releasing the

mouse, drag it over the anchor symbol in your Web page).

As the arrowhead moves over the anchor, the anchor name preceded by the pound sign

(#) will appear in the link field. The selected text is now a link, and is underlined with a

different text color.

The form that this type of link uses is different from a standard link. In the link field, a pound

sign appears followed by the name of the anchor. The # (pound sign) indicates that the

link is to an anchoron the Web page.

Note: When planning your Web site, you will need to decide how to organize links between all

the pages.

A good practice is to place links to other pages at the top and the bottom of each page.

Also, each page should be linked to your home page (index.html).

Page Layout with Tables

We can use Tables to lay out the format of text and images. A table has rows and columns

and may be

used for layout in a number of ways, including placing text or images side by side on a

page. In this section, you’ll make a table that shows the Calendar dates and events for an

Aardvark Sanctuary.

Create a Table



102. Place your cursor at the top of Page2.html after the text. Now, you’ll insert a table with 3

rows and 2 columns.

103. From the Insert menu, choose Table. The Table dialog box appears.

104. Under Table size, adjust the settings as follows:

Rows = 3

Columns = 2

Table width = 75 %

Border thickness = 1 15

105. Click OK. The table will appear on your page.

106. Place your cursor in the upper-left cell of the table and type: “Schedule of Events” 107.
On the second row, in the left-hand cell type: Date

108. Press the [Tab] key to move to the next cell in the table.

109. Type: Event

110. Press the [Tab] key again to move to the next row.

111. Type in a date. Move to the next cell, and type in a description of an event. As you type

in a long paragraph, the words wrap within a cell.

112. Press the TAB key, and a new row is automatically added to the table. Enter the date and

event description in the fourth row.

Merge Cells

We want the Schedule of Events to be centered across the entire table. To do that, we first

need to merge the two top cells in the table.



113. Click and drag your cursor from left to right across row 1. ↔ou’ll now merge those two

cells into one.

114. Choose Modify >> Table >> Merge Cells. Now, in row 1, you should see one large cell.

Insert an Image

115. Place your cursor in the right-hand cell of the last row. Press the [Tab] key to add a new

row.

116. Place your cursor in the right-hand cell of that new row. Choose Insert >> Image. The

Select Image Source dialog box appears.

117. Navigate to an image – either one you’ve downloaded and is on your flash drive or one

from my Web site that you can download.

118. Click OK. The image you chose will appear in the table cell.

Add a new row to the table.
After you have created a table, you may need to add information in the middle of the table.

You can add rows or columns to expand the table.

119. Click in the third row of your table.

120. Choose Modify >> Table >> Insert Row.

A new row appears in the table.

121. Click in the second column of the new row and insert another image (your choice). The

image appears in the cell.

122. Click in the cell to the left of the image and type some relevant information in the cell.

Delete a row

The table can also be adjusted by removing unnecessary rows or columns.



123. Click in the second row of your table.

124. From the Modify menu, choose Table, and then choose Delete Row. The row and its
contents are deleted. Table

Resize columns and rows

Depending on the content you add to your table you might find that columns are too wide or
narrow.

You can adjust the column width to better fit the content in your table.

125. Place the cursor over the line dividing the columns. The cursor turns into a twoheaded
arrow.

126. Click and drag the two-headed arrow toward the right to the middle of the table. The
columns are re-sized.

127. Place the cursor over the right side of the table. Click and drag the two-headed arrow to
resize the table again.

128. Save and preview the page.

Try changing the size of the browser window. Notice that the table size changes as the
browser window size changes – why? The reason the table size is not constant is because
the width of the table is expressed as a percentage of the total width of the browser
window, in this case, 75%. If you wish to lock the table to a specific size, you have to
express the table dimensions differently.
Table dimensions can also be expressed as fixed using “pixels”. A pixel is a single point
in a graphic image. Screens are divided into thousands (or millions) of pixels, arranged in
rows and columns. On a 17→eb page, a recommended pixel size for a table’s width would
be no higher than 600. (Assuming a screen resolution of 800 x 600).

When your table is selected, you can view and change the table width on the Property
Inspector.

Experiment with cell color and other options

129. To add background shading to a cell or row, select the cell(s) and click on the bottom
corner of the Bg color box on the Property Inspector

130. Click on a swatch with the eyedropper to choose a color.

131. Try various formatting options for the rest of the table using the Property Inspector.
Change the size, color or style of the text, and try the alignment options.

132. Save your work and preview.



PROGRAMMING LANGUAGE IN C:
Why we use Language ?

We use language due to following reasons : 
It stores data
 How to interact between input and output
 The operator uses to transform and combine data.

What is C ?

By 1960 languages come into existence. COBOL was being used for commercial
purposes, FORTRAN for Engineering and Scientific applications. An International
committee was setup to develop languages. This committee came out with a language
called ALGOL60. ALGOL-60 never really became popular because it seemed too
abstract, too general. To reduce the abstractness and generality a new language called
Combined Programming Language (CPL) was developed at Cambridge University. CPL
was an attempt to bring ALGOL 60 new version, but CPL turned out to be so big, having
so many features, that it was hard to learn and difficult to implement. BCPL (Basic
Combined Programming Language) developed by Martin Richards at Cambridge
University aimed to solve this problem by bringing CPL down to its basic good features.
But unfortunately it turned to be less powerful and too specific. Dennis Ritchie inherit the
features of CPL and BCPL and made a language named C. C forms the basis for many
advanced, highly powerful and effective programming languages. C is a programming
language developed at AT&T’s Bell Laboratories of USA in 1972. It was designed and
written by a man named Dennis Ritchie. In the late seventies C began to replace the more
familiar languages of that time like PL/I, ALGOL etc. No one pushes C. C seems so
popular, because it is reliable, simple and easy to use. The concept of C derives its origin
from a primitive form of C which was called Basic Combined Programming Language
(BCPL) developed by Ken Thompson of Bell Laboratories which he referred to as ‘B’ . By
now it might not be difficult to guess that a name as cryptic as C was conferred to it
because it was considered to be a modified more adaptive successor of “B”. C’s
compactness and coherence is mainly due to the fact that it’s a one man language.



C Basics

Before we embark on a brief tour of C's basic syntax and structure we offer a brief history of
C and consider the characteristics of the C language.

In the remainder of the Chapter we will look at the basic aspects of C programs such as
C program structure, the declaration of variables, data types and operators. We will
assume knowledge of a high level language, such as PASCAL.

It is our intention to provide a quick guide through similar C principles to most high level
languages. Here the syntax may be slightly different but the concepts exactly the same.

C does have a few surprises:

• Many High level languages, like PASCAL, are highly disciplined and structured.
• However beware -- C is much more flexible and free-wheeling. This freedom

gives C much more power that experienced users can employ. The above
example below (mystery.c) illustrates how bad things could really get.

Characteristics of C
We briefly list some of C's characteristics that define the language and also have lead to
its popularity as a programming language. Naturally we will be studying many of these
aspects throughout the course.

• Small size
• Extensive use of function calls
• Loose typing -- unlike PASCAL
• Structured language
• Low level (BitWise) programming readily available
• Pointer implementation - extensive use of pointers for memory, array, structures

and functions.

C has now become a widely used professional language for various reasons.

• It has high-level constructs.
• It can handle low-level activities.
• It produces efficient programs.
• It can be compiled on a variety of computers.



Features of C

Low Level Language Support Program Portability

Powerful and Feature Rich Bit Manipulation

High Level Features Modular Programming

Efficient Use of Pointers

Features of C Programming
Language :

C Programming is widely used in Computer Technology, We can say that C Programming
is inspiration for development of other languages. We can use C Programming for different
purposes. Below are some of the Features of C Programming language -

1 . Low Level Features :

1. C Programming provides low level features that are generally provided by the
Lower level languages. C is Closely Related to Lower level Language such as
“Assembly Language“.

2. It is easier to write assembly language codes in C programming.



2 . Portability :

1. C Programs are portable i.e they can be run on any Compiler with Little or no Modification

2. Compiler and Preprocessor make it Possible for C Program to run it on Different PC

3 . Powerful

1. Provides →ide verity of ‘Data Types‘
2. Provides →ide verity of ‘Functions’

3. Provides useful Control & Loop Control Statements

4 . Bit Manipulation

1. C Programs can be manipulated using bits. We can perform different operations at bit
level. We can manage memry representation at bit level.

2. It provides wide verity of bit manipulation Operators. We have bitwise operators to
manage Data at bit level.

5 . High Level Features :

1. It is more User friendly as compare to Previous languages. Previous languages such
as BCPL,Pascal and other programming languages never provide such great features
to manage data.

2. Previous languages have there pros and cons but C Programming collected all
useful features of previous languages thus C become more effective language.

6 . Modular Programming
1. Modular programming is a software design technique that increases the extent to

which software is composed of separate parts, called modules
2. C Program Consist of Different Modules that are integrated together to form complete

program

7 . Efficient Use of Pointers

1. Pointers has direct access to memory.

2. C Supports efficient use of pointer .

C Program Structure

A C program basically has the following form:



• Preprocessor Commands
• Type definitions
• Function prototypes -- declare function types and variables passed to function.
• Variables
• Functions

We must have a main() function.

A function has the form:

type function_name (parameters)
{

local variables

C Statements

}

If the type definition is omitted C assumes that function
returns an integer type. NOTE: This can be a source of problems in a program.

So returning to our first C program:

/* Sample program */

NOTE:

main()
{

printf( ``I Like C n'' );
exit ( 0 );

}

• C requires a semicolon at the end of every statement.
• printf is a standard C function -- called from main.
• n signifies newline. Formatted output -- more later.
• exit() is also a standard function that causes the program to terminate. Strictly speaking it is not

needed here as it is the last line of main() and the program will terminate anyway.

Let us look at another printing statement:



printf(``.n.1n..2n...3n''); The

output of this would be:

.

.1
..2
...3

C Keywords

Keywords are the set of predefined words whose functionality has been expressed to the
compiler and whenever called upon they furnish their task with utmost comfort. The
keywords cannot be used for any function other than what it is defined for, not even as
variable names. This code of conduct it will result in giving a new meaning to the keyword,
which is not permissible by the computer . There are 32 keywords in C which are used at
various points in a program to launch the proficiency of the language.

C Instructions

The different types of constants, variables and keywords the next logical step is to learn
how to learn they are combined to form instructions. There are four types of instruction in
C :

 Type Declaration Instruction
 Input/ Output Instruction
 Arithmetic Instruction
 Control Instruction

Type Declaration Instruction : We can declare the type of variables used in C Program
by using this instruction. Any variable used in a program must be declared before using
it any statement. The type declaration statement usually written at the beginning of the C
program.
eg. int EmpCode;

float Bsalary;
char EmpName

Input/ Output Instruction :We can perform the function of supplying input data to a program
and obtaining the output results from it.
Arithmetic Instruction: We can perform arithmetic operations between constants and
variables.
Control Instruction : We can control the sequence of execution of various statements in
a C program.

Variables



A program is made of data and instructions to manipulate those data. Note that data have to
be stored somewhere, and thus will need some memory space in the RAM.

A variable is an entity that is used to store data. Without variables, there is no way (or actually
NO PLACE) to store data. A variable has

 a name (more specifically a symbolic name)
 an associated physical memory space (portion in a RAM)
 a data type
 a value (depends on data type)
 a scope
 a lifetime

How do you declare a variable?

In C, the syntax for declaring a variable is as follows:

<variable name>

The symbol <item> means that it is required to specify the item enclosed within a pair of
angled brackets. A semicolon signifies the end of a declaration. A missing semicolon will
cause the compiler to generate a syntax error. Variables should be named following the
C naming conventions.

Example:
char ch;

int i;

float f;

double d;

It is possible to declare several variables of the same type on the same line. In such a
case, a comma should be inserted between two variables. A missing comma will
generate a syntax error.

Example:

char ch1, ch2; int x, y, z; float hourly_rate,
number_of_hours, salary; double

numerator, denominator;

Basic Data Types



The language of C support several types of Data, each of which is represented in a varied
manner with in the memory. The data in the memory can be of integer type or of character
type or of integer with decimal points. Whenever an integer or a character is used in a
program the computer should be able to identify where to store it in the memory.
The basic data types are depicted in a tabular format to get a better understanding of the
basics of C programming.

Data Type Description Memory Range Format
Requirement Specifier

Int whole numbers 2 bytes -32768 to %d, %i
long - 4 bytes +32767 %ld

Char Characters 1 Byte 0 to 255 %c, %s

Float Numbers with 4 Bytes 1.0E-37 to %f
Decimals 1.0E+37

Double Numbers with 8 Bytes 1.7E-308 to %lf

Int : The particular data type deals in storing only whole integer numbers and they are
incapable of dealing with fractions or number with decimals. The number which they can
deal with a range from -32768 to +32767. An int requires 2 bytes of memory by most
computers.

Char : The char data type holds individual characters or alphabets and they require only
1 byte of memory. Most compilers permits a range of 0 to 255 regarding the char data
type.

Float : A float data type is involved in restoring floating point numbers or to put it simply,
it is used to store numbers with decimal point . The float desires 4 bytes for storage and
has a fractional precision of 6 digits.

Double : A double data type is also used for the restoration of floating point numbers. The
difference lies in the precision and storage space. Double offers a great precision, of about
15 digits and compiler requires 8 bytes to store a double. The ranges with in which the
float can be represented are 1.7 E - 308 to 1.7 E + 308 resp.

Qualifiers Used With Basic Data Types

To expand the horizon of the basic data types, making it more flexible and adaptable to
get into various situations with preciseness and accuracy. The qualifier tagged to the data
types are LONG, SHORT, SIGNED AND UNSIGNED. To make any data type a qualifier,
the name of the qualifier has to be tagged before the data type.



Long : As the name suggests the qualifier long extended the range of the data type to
which it is prefixed. It can be applied to only the int and double data types and it expands
the spectrum of range from a maximum of 2,147,483,647 to -2.147,483,647. A long int
requires memory that is more than an ordinary int and therefore takes 4 bytes for storage.
To make an integer a long qualifier just add the word long before it.

Short : This qualifier is most interesting because if an ordinary int has the same memory
value as that of long i.e. 4 bytes a short will have 2 bytes, but if an int has memory of 2
bytes a short will have the same memory i.e. 2 Bytes.

Signed : By using signed data qualifier that data type can accommodate both positive
and negative numbers. When a variable is signed it has the same positive and negatives
ranges as a regular int. By default an int is a signed data type.

Unsigned : The qualifier unsigned is tagged mostly to int and it also has the same
memory requirement as that of ordinary int i.e. 2 bytes. Unsigned integer have a range
from 0 to 65535.

Constants

ANSI C allows you to declare constants. When you declare a constant it is a bit like a variable
declaration except the value cannot be changed.

The const keyword is to declare a constant, as shown below:
int const a = 1; const
int a =2;

Note:

 You can declare the const before or after the type. Choose one an stick to it.
 It is usual to initialise a const with a value as it cannot get a value any other

way.

The preprocessor #define is another more flexible (see Preprocessor Chapters) method
to define constants in a program.You frequently see const declaration in function
parameters. This says simply that the function is not going to change the value of the
parameter.The following function definition used concepts we have not met (see chapters
on functions, strings, pointers, and standard libraries) but for completenes of this section
it is is included here:

void strcpy(char *buffer, char const *string)

The second argiment string is a C string that will not be altered by the string copying standard
library function.

Operators in C :



Operators can briefly be defined as the tools used for solving various mathematical,
conditional, relational and logical problems. The operators that you will be dealing with are
arithmetic operators , unary operators, relational and logical operators . The item in
between which the operators are placed are called operands.

Arithmetic operators :
Arithmetic Operators can be considered the main point of all the operators. Arithmetic
operators are tools that help us in computing various mathematical operations.

Operators Function Performed
+ Addition

Subtraction

* Multiplication

/ Division
% (Modulus) Finds the remainder

Unary Operators :
There are two types of unary operators :-

 The increment operator (denotes as ‘ ++ ’ )
 The decrement operator ( denotes as ‘ -- ’ )

When the increment operator is prefixed to a variable which holds an integer it increases
the value of the number by one. Similarly the decrement operator decreases the value by
one.

Relational and Logical Operators :

Operators Significance

< Less than

<= Less than or equal to

> Greater than

>= Greater than or equal to

Equality Operators Significance

== Equal to

! = Not equal to

Logical Operators Significance

&& And



| | Or

! Not

Assignment is = i.e. i = 4; ch = `y';

Increment ++, Decrement -- which are more efficient than their long hand equivalents, for
example:-- x++ is faster than x=x+1.

The ++ and -- operators can be either in post-fixed or pre-fixed. With pre-fixed the value is
computed before the expression is evaluated whereas with post-fixed the value is
computed after the expression is evaluated.

In the example below, ++z is pre-fixed and the w-- is post-fixed:

int x,y,w;
main()
{
x=((++z)-(w--)) % 100;
}

This would be equivalent to:

int x,y,w;

main()

{

z++;
x=(z-w) % 100;
w--;

}

The % (modulus) operator only works with integers. Division / is for both integer and float division. So be
careful. The answer to: x = 3 / 2 is 1 even if x is declared a float!!

RULE: If both arguments of / are integer then do integer division.



So make sure you do this. The correct (for division) answer to the above is x = 3.0 / 2 or x= 3 / 2.0 or (better)
x = 3.0 / 2.0. There is also a convenient shorthand way to express computations in C. It is very common to
have expressions like: i = i + 3 or x = x*(y + 2) This can written in C (generally) in a shorthand form like
this:

which is equivalent to (but more efficient than):

So we can rewrite i = i + 3 as i += 3 and x = x*(y + 2) as x *= y + 2.

NOTE: that x *= y + 2 means x = x*(y + 2) and NOT x = x*y + 2.

Comparison Operators

To test for equality is ==

A warning: Beware of using ``='' instead of ``=='', such as writing accidentally

if ( i = j ) .....
This is a perfectly LEGAL C statement (syntactically speaking) which copies the value in
"j" into "i", and delivers this value, which will then be interpreted as TRUE if j is nonzero.
This is called assignment by value -- a key feature of C.

Not equals is: !=

Other operators < (less than) , > (grater than), <= (less than or equals), >= (greater than or
equals) are as usual.

Pointers

C supports the use of pointers, a type of reference that records the address or location of
an object or function in memory. Pointers can be dereferenced to access data stored at
the address pointed to, or to invoke a pointed-to function. Pointers can be manipulated
using assignment or pointer arithmetic. The run-time representation of a pointer value is
typically a raw memory address (perhaps augmented by an offsetwithin-word field), but
since a pointer's type includes the type of the thing pointed to, expressions including



pointers can be type-checked at compile time. Pointer arithmetic is automatically scaled
by the size of the pointed-to data type. Pointers are used for many different purposes in
C.Text strings are commonly manipulated using pointers into arrays of characters.
Dynamic memory allocation is performed using pointers.

Statements in C Language
C needs some kind of managerial system which instructs the computer what function has
to be performed at which time. The control statement act as a manager. You will amazed
at the functions the different control statements handle. For example in a program you
may have a statement in which a multiplication operation is to be performed and in the
next an addition operation and after the next line there may be a statement which may
want itself to be repeated 8 times and another statement may like itself to be skipped and
attended to at a later stage. All these conditions are managed by the control statements.

The sequence control structure is one of the basic uncomplicated control statements. The
idea is very simple. In the sequence control instructions the statements to be executed
are done so in a serial manner one after the other. The C compiler first executes the
opening line and then moves on to the next and so on. In a serial fashion and the entire
program is executed in this manner.

Conditional Statement
C program executes program sequentially. Sometimes, a program requires checking of
certain conditions in program execution. C provides various key condition statements to
check condition and execute statements according conditional criteria.These statements
are called as 'Decision Making Statements' or 'Conditional Statements'.Followings are
the different conditional statements used in C :

1. If Statement
2. If-Else Statement
3. Nested If-Else Statement
4. Switch Case

If Statement:The if statement can be used to test conditions so that we can alter the flow of a
program. Code:

#include<stdio.h>
int main()

{
int mark; char pass;
scanf("%d",&mark);
if (mark > 40) pass
= "y";

return 0;



}

If-Else Statement:The if statement first tests if a condition is true and then executes an instruction
and the else is for when the result of the condition is false. Code:

#include<stdio.h> int
main()
{

int mark; char pass;
scanf("%d",&mark);
if (mark > 40)
{

}
else
{

}

pass = "y";
printf("You passed");

pass = "n"; printf("You
failed");

return 0;
}

The Switch Statement:The switch statement is just like an if statement but it has many
conditions and the commands for those conditions in only 1 statement. It is runs faster than
an if statement. In a switch statement you first choose the variable to be tested and then you
give each of the conditions and the commands for the conditions. You can also put in a default
if none of the conditions are equal to the value of the variable. For Loop, While Loop, Break
and Continue

Control structures are basically of three types –

• Sequence statements
• Iterative statements
• Selection statements

Sequence Statements : All the State in a program except the iterative & statements.
They are generally the individual statements which performs the task of input, output,
assignment declaration etc.



Iterative Statement are those repeated execution of a particular set of instructions
desired number of times. These statements are generally called loops for their execution
nature.

Types of Looping Statements:

Basically, the types of looping statements depends on the condition checking mode.
Condition checking can be made in two ways as : Before loop and after loop. So, there
are 2(two) types of looping statements.

• Entry controlled loop
• Exit controlled loop

1. Entry controlled loop :

In such type of loop, the test condition is checked first before the loop is executed.

Some common examples of this looping statements are :

• while loop
• for loop

2. Exit controlled loop :

In such type of loop, the loop is executed first. Then condition is checked after block of
statements are executed. The loop executed atleat one time compulsarily.

Some common example of this looping statement is :

do-while loop

In C language the iterative statements (loops) can be implemented in the three loops and they
are

The For Loop Syntax-

for (initialization; condition; incrementation)
{

body of loop
}

For Loop will perform its execution until the condition remains satisfied. If the body of the loop
consists of more than one statement then these statements are made compound by placing the



open and closed curly brackets around the body of the loop. For loop is a count loop. The
initialization condition and increamentation may be done in the same statement. For loop will not
execute at least once also if the condition is false at the first time itself.

The While Loop

Syntax –
Initialization;
While (condition)

{
Body of loop;

Incrementation;
}

In this loop, initialisation, condition and incrementation is done in the three different
statements. This loops is count as well as event loop. In case of while loops the body of
the loop will consist of more than one statements because each time one statement will
be of incrementation. Hence the open and closed curly brackets are required.

Do-While Loop Statement:
The third loop statement available in C is do-while statement syntax :- Initialization;
Do
{
Body of loop;
Increamentation;
}while(condition)

An introduction to Arrays

The concept of arrays depends on other data types, which was meant to facilitate the
storage of abundant amount of number and wasting an entire delivery of space in the
memory. It would be like buying a two dozen books and ultimately using one and dumping
the rest in the garbage. Arrays can be defined as a collection of similar elements. An array
of elements can be formed only if all the elements are of one particular data type i.e. all
of them are either integer or character or a floating point number, but there cannot exist
an array which hosts an combination of these data types.

Advantage of Arrays

The usage of arrays is crucial to any professional programming. Arrays just make the life
of a programmer a bit easier. It relieves him of a burden of having to keep naming the
variables. An array is a single variable holding multiple data. Each data is referred to by
its element number, If for instance, you wish to store a list of Items you could just name
the variable ‘item_code’ and keep storing the data by referring to item_code (1),
item_code (2),item_code (3),......etc.



Array Declaration

Like other variables an array needs to be declared so that the compiler will know what
kind of an array and how large an array we want. In our program we have done this with
the statement int sal [20] ;
Here int specifies the type of the variable, just as it does with ordinary variables and the
word sal specifies the name of the variable. The [20] however is new. The number 20
tells how many elements of the type int will be in our array. This number is often called
the “dimension” of the array. The bracket ( [ ] ) tells the compiler that we are dealing with
an array.

Types of Arrays

The array are divided in to two parts :
 Single Dimensional Arrays
 Multidimensional Arrays

Single Dimensional Arrays :

The single dimensional arrays as the name suggested, handles only a single advance of
similar elements. That is to say you can only have one row of elements and the size of a
single dimensional array depends on the programmer. Basically the single dimensional
arrays facilitate the accommodation of many similar elements in a single variable. The
succeeding sections after which you will have a cloud less view of the single dimensional
arrays.

Multidimensional Arrays :

The multidimensional arrays are two or more arrays clubbed together. They can be of two
dimensional type or three dimensional types or more, but you can restrict the research
only to two and three dimensional arrays. An example of the two dimensional arrays is
the matrix because like the matrix the two dimensional arrays have two matrices one
symbolizing the row elements and the other the column elements. The three dimensional
array is a shade different because the first array list the number of tables of the two
dimensional arrays. The rest of the two arrays are similar to the twodimensional array in
the sense that one is for the row and the other is for the column.

Array Initialization

The initial step of declaring of an array is done. You have given it a variable name and
also declared its size but upto this stage the array is empty. It is like a box without any
book in it. Similarly declaration of variable is done but some values have to be passed into
it. You must be aware of initializing an ordinary variables but how do you initialize an array
in which more than one value has to be initialized into one array variable.

Entering Data into an Array :



You have declared an array by giving it a specific name and size you can try and explore
the individualities of each element in the array, that is to say how each element is
addressed in an array . Array element indexing always start with 0.
Number [ 0 ] 1st element
Number [ 1 ] 2nd element
Number [ 2 ] 3rd element
Number [ 3 ] 4th element
This means that [0] will hold the first value, [1] the second, [2] the third & so on If you want to
access the fourth element of the array “sal” you have to write sal [3].

C describes two distinct methods :

a) Static Initialization
b) Dynamic Initialization

Static :

The array once initialized in this cannot be altered by the user. This means that each time
the program is executed, the same values are utilized and they can be altered only from
the code. It doesn’t require the user to input values for the array. This type of initialization
is done at the time of the declaration of the array. The value to be inserted are mentioned
in the braces int sal [4] = { 101,102,103,104,105 } ;
int a [ 2] = { 201,202,320 } ;
In the static initialization the number of values to be allocated in mentioned in the square
bracket and the element are mentioned in the curly braces. The elements are initialized
in a static mode.

Dynamic :

In static initialization you noticed that the elements of the array are initialized while
declaring the array, but there is problem. If you want to alter the values or if you want the
user to supply the values then static initialization will turn out to be a raw thing. That is
where dynamic initialization takes control of the reigns. The user can be allowed to enter
the values of his choice into the array and when the program return the values are not
retained and they cover the way for new values. Dynamic initialization can be done using
the For Loop
for ( i = 0 ; i< = 10 ; i++)

{
printf ( “Enter values “ ) ;

scanf ( “%d”, &sal [ i ] ) ;
}

Array Inside the Memory

The element stored in a serial order or they are stored randomly .
int sal [ 8 ] ;



The statement indicates that an array variable is to be created which is of an integer data
type and the array can hold 8 elements. In the memory 16 bytes will be reserved because
each integer will be 2 Bytes long. The array is initialized with some numbers, this array
will host some unrelated numbers. Once the array is initialized the elements are stored
in a continuous manner.

201 202 203 204 205 206 207 208

3112 3114 3116 3118 3120 3122 3124 3124
The number entered by the user are registered in a successive pattern and each element takes
2 bytes. This is exactly how it represented in the memory of a computer.
The number below the element location is the address of the location and each element has
its unique address in the memory by which it is identified.

Multi Dimensional Arrays :

Multi dimensional array requires separate brackets for each subscript. One dimensional
array has a pair of square brackets, a two dimensional array will have two pairs of square
brackets, three dimensional array three pairs of square brackets and so on.

Two Dimensional Array :

A two dimensional array can be visualized as an array below an array. Two dimensional array
will have two pairs of square brackets.
Syntax :- datatype arrayname [statement 1] [statement 2]
The two dimensional array is often referred to as a matrix. The statement one and two are
the subscripts that the two dimensional array will hold. One will specify the row and
expression, two will specify the column and they indicate the number of array elements
associated with each subscript.
int A [ 4] [ 2 ] ;

Column 0 Column 1
Row No 0 4200 10
Row No 1 6500 20
Row No 2 7850 30
Row No 3 3450 40

Thus the element in A [0][0] will be 1000 and the element A[3][3] will be 40. The rest of
the numbers can be figured by having a look at the above table. In the memory the
element are placed in a sequential pattern such that the element [0][0] will be first
followed by the element in [0][1] followed by [1][0] and so on.

Character Arrays

C is also flexible that it extends it’s services to character also. It means that arrays can be
formed using even characters. One such array of characters is called string. A string is a
collection of characters that are in a particular order.
char name [10] = “Ankush” ;
In the above example name is an array with an element holding capacity of 10 and it
holds a string called “Ankush” The first element is stored in the [ 0 ] th position of the array



name. That is, the alphabet A will stored in the [ 0 ] th position , n will be in the [ 1 ] st
position and so on till [ 9] th element.
A doubt may arise that while the array can accommodate 10 values only 6 have been
entered. What happens to the rest? Since only 4 values have been accommodated the
7th value will be a null character ( \0 ) which represents the end of the string. This will
placed automatically at the end of the string if any of the array indexes are vacant.
A blank space cannot exist between any two characters while taking input from the user unless
accompanied by a specific format specifier.

Strings

A group of integers can be stores in an integer array. Similarly a group of characters can
be stored in a character array. Character array are many a time also called strings. Most
languages internally treat strings as character arrays, but some how conceal this fact
from the programmer. Character arrays or strings are used by programming languages to
manipulate text such as words and sentences. A string constant is a one dimensional
array of characters terminated by a null ( ‘ \ 0 ’ ) for example , char name [ ] = { ‘ I ’, ‘ T ’
, ’ T ’ , ’ C ’ , ‘ O ’ , ‘ M ’ , ’ P ’ , ’ ← ’ , ‘ T ’ , ‘ E ’ , ‘ R ’, ‘
\0 ’}
Each character in the array occupies one byte of memory and the last character is always
‘ \ 0 ’. →hat character is this ? It looks like two characters, but it is actually only one
character, either the \ indicating that what follows it is something special. ‘ \ 0 ‘ is called
null character. Note that ‘\0’ and ‘0’ are not same. ASCII value of ‘ \0 ‘ is 0 whereas ASCII
value of ‘ 0 ‘ is 48 It shows a way a character array is stored in memory. The elements of
character array are stored in contiguous memory locations. The terminating null ( ‘ \ 0 ‘ )
is important, because it is the only way the functions that work with a string can know
where the string can know where the string ends. A string not terminated by a ‘ \0 ‘ is
really a string, but merely a collection of characters.

With C compiler a large set of useful string handling library functions are provided.

Function Use

strlen Finds length of a string

strlwr Converts a string to lowercase

strupr Converts a String to Upper Case

strcat Appends one string at the end of another

strcpy Copies a String into Another

strcmp Compares two strings

strdup Duplicating a String

strrev Reversing a String



strlen ( )

This function counts the number of characters present in a string.
void main ( )

{ char array[ ] =”Hello “ , new[ 20 ] ;

int size, size1, size2 ; printf ( “Enter a

String “ ); scanf ( “ %s ”,new ) ;

size = strlen ( array ) ; size1= strlen

(“SoftBrain Computers “ ); size2 = strlen

(new ) ;

printf ( “ \n Length of string %s are %d ” ,array,size ) ; printf ( “ \n Length of Second
string %s are %d ” ,”SoftBrain

Computers” ,size1 ) ;

printf ( “ \n Length of Third string %s are %d “ , new,size2 ) ;

getch( ) ;

}

strcpy ( )

This function copies the contents of one string into another. The base addresses of the source
and target strings should be supplied to this function.
void main ( )

{
char source [ ] =” SoftBrain Computers “ ;
char target [20], old [10], new [10] ;
printf (“ Enter a String “ ) ; scanf (“ %s ” ,

old ) ; strcpy ( target, source ) ; strcpy
( new ,old ) ;
printf ( “\n Source String are %s and target String are %s “ , source, target ); printf ( “\n
Second Source String are %s and Second target String are %s “ , old, new );

getch ( ) ;
}

On supplying the base addresses strcpy ( ) goes on copying the characters in source
string into target string till it doesn’t encounter the end of source string ( ‘ \0 ‘ ). It is our
responsibility to see to it that the target string’s dimension is big enough to hold the string
meal, character by character .

strcmp ( )

This is a function which compares two strings to find out whether they are same or
different. The two strings are compared character by character until there is a mismatch



or end of one of the strings is reached, which ever occurs first. If the two strings are
identical, strcmp ( ) returns a value 0. If they are not, it returns the numeric difference
between the ASCII values of the non-matching characters.

Function

A function is a self contained block of a statements that perform a coherent task of some
kind. Every C program can be thought of as a collection of these functions. Sometimes
the interaction with this person is very simple sometimes it’s complex.
You have a task which is always performed exactly in the same way... say a servicing of
your motorbike. →hen you want it to be done, you go to the service station and say “ I’s
time, do it now ↔ou don’t need to give instructions, because the mechanic knows his job.
↔ou don’t need to be told when the job is done. ← assume the bike would be serviced in
the usual way, the mechanic does.
A simple C function which operated in much the same way as the ,mechanics. We will be
looking at two things a program that calls or activates the function and the function itself.
void main ( )

{ message ( ) ;
printf (“ \n Thanks after return of first function “ ) ;

getch ( ) ;
}
message ( )
{
printf ( “ \n →elcome to the first function program “ ) ;
}

Note :
Any C program contains at least one functions.
If a program contains only one function, it must be main ( ) .
In a C program if there are more than one functions present, then one ( and only one ) of
these functions must be main( ), because program execution always begins with main ( )
.
There is no limit on the number of functions that might be presented in a C program. Each
function in a program is called in the sequence specified by the function calls in main( ).
After each function has done its things, control returns to main ( ). When main ( ) runs out
of function calls, the program ends.

Functions may be divided into three categories.

 Without arguments without return value
 With arguments without return value
 With arguments with return value

Without arguments without return value
For functions of this type neither the caller function nor the called function take any
arguments. When a function is called the control jumps directly to the function and



executes the statements that are specified within the called function. After the statement
is the called function are executed, the control returns to the main program.

With arguments without return value

For function this the caller function transport some values to the called function or the
function definitely where these values are used for some specific function or computation
but once the computed value is found out within the called function the value is not
returned back to the caller function .

With arguments with return value

In this type of functions the values as the arguments are being passed into the called
functions where they will be computed and a definite result is relayed back to the caller
function and the value will be printed from there.

Advantage of Functions :

A programmer can identify whatever actions are performed repeatedly on various parts
of the program, write them as a function and call the function from various part of the
program whenever needed. This approach avoids code duplication. Instead of duplicating
the same code in different parts of the program, you just write the function once and call
it from different parts of the program thus reducing the executable file size and redundancy
of code, making the maintenance of code easy.
In a multi tasking system like Unix there is a direct relationship between the amount of
memory a program consumes and the speed with which it runs You will in general find
that large programs which demand a lot of memory sluggish.
Breaking down your program into subroutines lends your program a structure. You can
divide your task into multiple sub-tasks, develop a function for each sub task, and
integrated them into a single program. Once a function is written and completely tested, a
programmer can expect it to smoothly fit in with the rest of the program modules.
Once a function is written, tested and found to be working as per the expectations , the
function can be loaded into a library, and can be used in an all together different
application. This approaches encourages code reusability.

The types of variables are :
 Local Variables
 Global Variables

Local Variables :

The fact that main is a function and you can declare any number of variables within it.
So if a rule holds good for one function why can’t it for other functions ? It definitely can.
You can declare a variable inside any function belonging to any size and type. Thus
variables declared inside a function are called local variables and are valid and can be
used within that function. The life of these variables exists until they are within the function.
It is same as the value of a particular variables in a program cannot exist for all the
programs. Any attempt to break the rules will result an error.



Global Variables :

Before you can accuse C of being inefficient in certain areas it pops up with an alternative.
The alternative for reducing the before mentioned problem is declaring the variables
globally. The global variables are otherwise called external variables and unlike the local
variables which are confined only to the function which has them, the global variables can
be used anywhere in the program The global variables are declared outside the main i.e.
before beginning the program and the values hold good through out the program. The
storage for global variables is in a fixed region of memory set aside for this specific
purpose by the compiler. The effectiveness of declaring globally can be felt when many
functions in a program use the same data.
Defining a variable as global is particularly advantageous because its value is made
available to all other functions. But the only risk factor involved in this is that if any function
manipulates or alter the global variable then any other function using the same variable
at the same time gets the altered value.

Recursion in Functions

Recursion in general terms means repeating itself. A recursive function is a process where
the function call itself repeatedly until a particular condition is satisfied. It is more like the
loop conditions . But the difference lies in that each action or recursion is based in the
result of the previous one.
A recursive result triggers the recursive action for the next result until the condition is
satisfied. For a problem to be solved recursively there are two conditions to be satisfied.
The problem must be written in a recursive form, The recursion must have a condition
which seals the recursion.

C program to check odd or even using modulus operator

#include<stdio.h>

main()
{ int
n;

Printf ("Enter an integer\n");
Scanf ("%d",&n);

if ( n%2 == 0 )
Printf ("Even\n");

Else
Printf ("Odd\n");

return 0; }



We can use bitwise AND (&) operator to check odd or even, as an example consider
binary of 7 (0111) when we perform 7 & 1 the result will be one and you may observe
that the least significant bit of every odd number is 1, so ( odd number & 1 ) will be one
always and also ( even number & 1 ) is zero.

C program to check odd or even using bitwise operator

#include<stdio.h>

main()
{ int
n;

printf("Enter an integer\n");
scanf("%d",&n);

if ( n & 1 == 1 )
printf("Odd\n"); else
printf("Even\n");

return 0; }

Find odd or even using conditional operator

#include<stdio.h>

main()
{ int
n;

printf("Input an integer\n");
scanf("%d",&n);

n%2 == 0 ? printf("Even\n") : printf("Odd\n");

return 0;
}

C program to check odd or even without using bitwise or modulus operator

#include<stdio.h>

main()



{ int
n;

printf("Enter an integer\n");
scanf("%d",&n);

if ( (n/2)*2 == n )
printf("Even\n"); else

printf("Odd\n");

return 0; }

In c programming language when we divide two integers we get an integer result, For
example the result of 7/3 will be 2.So we can take advantage of this and may use it to
find whether the number is odd or even. Consider an integer n we can first divide by 2
and then multiply it by 2 if the result is the original number then the number is even
otherwise the number is odd. For example 11/2 = 5, 5*2 = 10 ( which is not equal to
eleven), now consider 12/2 = 6 and 6 *2 = 12 ( same as original number). These are
some logic which may help you in finding if a number is odd or not.

Prime number program in c language

#include<stdio.h>

int main()
{
int n, i = 3, count, c;

printf("Enter the number of prime numbers required\n");
scanf("%d",&n);

if ( n >= 1 )
{
printf("First %d prime numbers are :\n",n);

printf("2\n");
}

for ( count = 2 ; count <= n ; )
{
for ( c = 2 ; c <= i - 1 ; c++ )
{ if ( i%c

== 0 )
break;



} if ( c
== i )

{
printf("%d\n",i);
count++;

}
i++;
}

return 0; }

Download Prime number program.

Output of program:

C program for prime number or not

#include<stdio.h>

main()
{
int n, c = 2;

printf("Enter a number to check if it is prime\n");
scanf("%d",&n);

for ( c = 2 ; c <= n - 1 ; c++ )
{
if ( n%c == 0 )
{
printf("%d is not prime.\n", n);
break;



} } if
(c == n )

printf("%d is prime.\n", n);

return 0; }

C program for prime number using function

#include<stdio.h>

int check_prime(int);

main()
{
int n, result;

printf("Enter an integer to check whether it is prime or not.\n"); scanf("%d",&n);

result = check_prime(n);

if ( result == 1 )
printf("%d is prime.\n", n);
else

printf("%d is not prime.\n", n);

return 0;
}

int check_prime(int a)
{ int
c;

for ( c = 2 ; c <= a - 1 ; c++ )
{
if ( a%c == 0 )
return 0;

} if ( c ==
a ) return
1; }

There are many logic to check prime numbers, one given below is more efficient then above
method.
for ( c = 2 ; c <= (int)sqrt(n) ; c++ )
Only checking from 2 to square root of number is sufficient. There
are many more efficient logic available.



FINANCIAL ACCOUNTING
Purpose of keeping Accounts or Need For Proper Accounts
Systematic recording of business and professional transactions in money terms is a
necessity to estimate, ascertain and forecast the business results. A business enterprise
must keep a systematic record of its daily transactions. So that it can know where it stands
and adjudge its performance. This systematic recording of transactions is termed as
accounting or book-keeping.

The basic purpose of accounting is to present a complete financial picture of the business
enterprise with the help of two financial statements. The Profit and Loss
Account showing how much profit has been earned or loss suffered and the Balance Sheet
showing the assets and liabilities of the Business and Proprietor’s interest in the
enterprise. The account books are the financial records which are of interest for the
owners and numerous other parties a such as Creditors, Employees, Government, Banks,
Financial, Institutions etc. The uses of the account/ financial statement, to the



various groups of person are as follows:

Ascertainment of true profits.

Ascertainment of liabilities to out siders.

Ascertainment of growth in capital.

Planning for business.

Cost determination and cost control with price fixation.

Optimum utilization of source, resources to keep the fixed assets intact and in
workable position.

Control over assets and properties.

Legal requirements as regards taxation etc.

Whether the taxes have been duly paid by the enterprise or not.

Whether the enterprise has complied with all the legal requirements.

Whether or not the enterprise to which they have lent money is running
successfully and maintaining its capital intact.
Whether the enterprise is earning adequate to pay back its loan and interest in time .

Whether the enterprise are sufficient to secure and repay the loan given by them to the
enterprise.

To ascertain the profits earned by the enterprise, so that they can get bonus or wages
revision fixed on that basis.

Whether in view of present financial health of the enterprise their job is secured and
permanent.

Whether they will be paid in time.

Whether their money is secured in such enterprise.

Whether to continue supplying goods on credit and allow higher credit.



Whether it is worth while to invest in the enterprise or withdraw their investment, as
debenture holder or other persons who have given loans to the enterprise.

What Is Accounts ?

Accounting: is the art of recording, classifying and summarizing in a significant manner
and in term of money transactions and events which are in part at least, of a financial
character, and interpreting the results there of “Book keeping is the art of recording
business dealing in a set of books.”

Object of Book- Keeping are :

To record correctly all business transactions, which involve transfer of money or goods.

To indicate the effect of each transaction and combined effect of all transactions upon the
financial position of the party entering into the transaction.

Legal Requirements For Maintaining Books Of Accounts
Cash book, journal and ledger are the basic account books which are supported by
vouchers , purchase and sale bills memos.

Apart from being a business necessity, maintenance of proper books of accounts is
necessary under section 44 - AA of the income -tax Act 1961. It provides for compulsory
maintenance of account by persons carrying on business as well as profession.
Every person carrying on legal, medical, engineering or architectural profession, or the
profession accountancy or technical consultancy or interior decoration or authorized
representative or film artist or company secretary whose gross receipts (not income) from
such profession exceeds Rs. 1,50,000/-. In any of the three years immediately proceeding
the current year is required to maintain proscribed books of accounts.
Penalty Under Income Tax Act :
If a person fails to keep and maintain accounts books or retain them for the prescribed
period of 8 years (16 year for cash book and ledgers) he is liable to penalty Rs.
25000/- under section 271A of the Income Tax Act.
Accounting Terminology

: Business is a generic term including any activity undertaken for the
purpose of making profit. It refers to any establishment or organization setup for the
conduct of trade, commerce or industry.

Profession is practice of intellectual skill by a person in a
particular field requiring specialized training on the part of the person engaged in it ,
for example a doctor, a lawyer, an accountant, an architect ,a chartered accountantetc.



One who owns the business is called the owner or proprietors. He provides the necessary
capital, attends to business activities, undertakes the risk of running the business, is
entitled to receive the profits and is liable for the losses resulting there from. An owner is
different from the business, in the accounting terminology. He is called a Sole proprietor
in one man business, partner in a partnership firm.
Accounting Equation : It means that in mathematical terms total assets of a business are
always equal to the aggregate of its liabilities and capital. i.e.

Total Assets = Liabilities + Capital
Capital : Capital means the amount invested by the proprietor in the business. Suppose
“Sudeep” starts a business with Rs. 1,00,000/-. The amount of Rs. 1,00,000/- invested by
Sudeep in the business is called the capital of the business. For the business, capital is
a liability towards the owner.
Drawing : Drawing refer to the amount of cash or value of goods withdrawn by the
proprietor out of business for his personal use. Suppose “Ramesh” withdraws Rs.20,000/-
from his business for purchase of “scooter” for his domestic use. The amount of Rs.
20,000/- withdrawn by the proprietor for his personal use is called drawings.

Goods : The things or items in which a business deals are called as “Goods” for the
business example in a stationary shop goods means “Stationary Items “. In a Furniture
Shop/ Business goods means “Furniture Items”.
Debtors : The term “debtor” represents the persons who have purchased goods on credit
from the business and have not paid for the goods sold to them. For example if goods
worth Rs. 10,000/- have been sold to “Mahesh”, he will continue to remain the debtor of
the business, so far, he does not make the full payment. Thus “debtor” is a person from
whom the business have to receive some money on account of goods supplied /sold (on
credit).

Creditor : Creditor is a person to whom a business owes money for the goods purchased
from such person on credit. Suppose a firm purchased some goods on credit from
Mahajan Traders for Rs. 30,000/- . In such a case Mahajan Traders will continue to remain
the creditors of the firm so far the full payment of Rs 30,000/- is not made to it.

Income/ Revenue : It is the monetary gain resulting from the sale of goods or services
during a given period and is measured by the price charged from customer, clients or
tenants for goods and service furnished to them. It also includes interest and dividends
earned on investments and rent received from letting out property.

Expenses : Expense refers to an expenditure whose benefit is enjoyed and finished
immediately. Examples of expenses are : Rent of Building, Salary Paid to Employees,
Wages paid to Labour, payment of Taxi charges etc. Expense is the cost of use of things
or services For the purpose of generating revenue. Expenses are voluntarily in curved to
generate income.



Losses : Losses are unwanted burden which the business is forced to bear. Loss of
goods due to theft or fire, or flood or accident are termed as “loss” in accounting. Losses
are different from expenses in the sense that expenses are voluntarily incurred to generate
income, where as losses are forced to be borne. Losses are outcome of the activity. They
are beyond control.

Assets : Assets mean right of ownership over anything valuable. This refers to properties
that can be expressed in terms of money like plant and machinery, vehicles, stocks, cash
etc. It also includes money due to the business from debtors For goods and services or
for money lent. Rights available to a business such as patent or copy rights goodwill,
trademark etc. are also included in assets.

Net Worth : Net worth of a business is the excess of its total assets over its total liabilities
to outsiders. Net worth is the amount payable or recoverable from the owners of the
business.

Profit (Income) : Excess of all revenues over all costs and expenses is called profits (income).

Purchases : Purchases means purchase of goods. Goods purchased on cash are called
“cash purchases” and those purchased without payment at the time of purchase are
called “credit purchases”.

Purchase Returns : Goods returned to the seller, being in excess of the quantity ordered or
found to be defective, or for any other dispute, are called purchase return.
Sales : Sales refer to sales of goods to customers. Sales for cash are called “cash sales” and
when payment is not received at the same time it is called Credit Sale.

Sales Returns : Goods returned by the costumer due to some defects, or excess quantity etc.
are called as sales returns.

Voucher : A voucher is a written documentary proof originating and supporting a
business transaction. It is the basis of recording a transaction in the books of account. For
example cash-memos, pay-in-slips, invoices etc.

Meaning of Book Keeping
‘Book-Keeping’ is a composite term made of ‘book’ and ‘keeping’ The word ‘book’ refers
to books of account and ‘keeping’ refer to maintenance in a systematic manner. Book
keeping is the systematic record of business transactions in a set of books. Business
involves a number of transactions such as buying, selling, receiving, paying etc. which
cannot be remembered for a long period. As such , it becomes necessary to write or record
the transactions in book of account in a scientific manner. Book-keeping is, therefore the
art of applying the principles of accounting, in keeping books of account.
According to Mr. J.R. BATLIBOI , “ Book-Keeping is the art of recording
business transactions in a set of books.”
Recording of Business Transactions Is To Be Done In A Proper Set Of Books



By proper set of books, we mean the various books of account or registers maintained by
a businessman from which he wants to ascertain the necessary information regarding the
affairs of his business.
The two most impotent books of accounts maintained by a business are:

rnal Cum Cash Book

Instead of above, the following subsidiary books all or some, according to requirements
may be prepared:

ok

Book Keeping involves the following steps:
All business transactions which are financial in nature desirably having documentary proof are
accounting transactions.

Transactions

Accounting: Accounting may be defined as the art of recording, classifying and
summarizing the day to day transactions of the business and interpreting the results there
off.
Difference between Book Keeping and Accounting:
Book Keeping is a narrow term, concerned with the art of recording the day to day
transactions of the business in proper books of account.

The term Accounting is wider in meaning and is concerned with recording, classifying and
summarizing the daily business transactions and interpreting the results there of. Book
Keeping is infect the part of Accounting.



Advantages of Book-Keeping & Accountancy

: Due to limited memorizing
power, a

businessman may not remember all his business transactions for a long period.
Accounting helps him

in keeping a permanent record of his business transactions.

: It helps the businessman
in

ascertaining the profit or loss made by his business, over a period of time ( By
preparing Profit & Loss Account).

By preparing Balance Sheet, the
business man comes to know about the asset, liabilities, capital etc. of the business at a
point of time.

: Nowadays a businessman is required to pay a number of
taxes that is Income Tax, Sales Tax, Excise-duty etc. Fair assessment of these taxes is
possible only if proper and systematic records of income, sales and production of the
business have been maintained.

: A businessman can daily know the amount
due from his debtors and amount due to his creditors if he has maintained proper records of
his transactions with debtors and creditors.

Objective of Accounting

Accountings :

Book Keeping : To maintain Account books



Book

Objective Of Financial Accounting
Financial Accounting is the art of recording, closing and summarizing in a sufficient
manner and in forms of money transaction and events which are in part at least of a
financial character and interpreting the result there off.



The objective of financial A/C is

To protect business properties : This
is only possible on A/C of

supplying the following information to the manager etc.
The amount of proprietor’s funds invested.
How much the business has to pay.
How much the business is recover from others.
How much the business has in the form of fixed assets :

material

it owes and what its wons.

Golden Rules of Accounting

There are basically three types of accounts :

Basic Principle :

The transactions of a business which relate to individuals,
business enterprises or other organizations are classified as transactions relating to
personal account under personal account a person either receives something from
the business or gives something to the business like any person RAM, VIJAY, SUNITA,
LAL &CO, BANK, HOSPITAL, SHOPS,CLUB,HOTAL,CINEMAHALL, whose capacity is
of receiver/ giver.

Personal Account Is A Operator

DEBIT THE RECEIVER
CREDIT THE GIVER



Account

Example : Cash paid to SH. K.L.SHARMA Rs 10000/- Sh.K.L .Sharma --->

Receiver ---> Dr. cash received from Mann Rs 5000/-Cr.

Mann ---> Giver ---> 5000/- Cr.

:

Remaining transactions of a business have been grouped under
“Real Account” These include all transactions which represent receipts by the
business, whether of properties, goods or services and all out goings from business
like all sale, purchase , cash, assets, land and building, machinery vehicle, means assets
and liabilities which has money value other than Personal Account.

Real Account Is A Source Of Operation

DEBIT WHAT COMES IN
CREDIT WHAT GOES OUT
Example : CASH ---> COMES IN ---> DR

CASH ---> GOES OUT ---> CR.

Nominal Account :

The transactions of a business relating to incurring of an
expenditure or loss and earning of income or gain are classified by Nominal Account like
: discount, rent, loss due to fire, insurance, traveling, salary, wages, rent,
commission, freight, octroi, bank charges, donation etc.

Nominal Account Is A Result Of Operation
f Nominal Account

DEBIT ALL EXPENSE &LOSS
CREDIT ALL INCOME &GAINS.

Example : Rent Paid Rs 3000/-
Rent ---> Exp. ---> Dr.
Interest recieved Rs. 300/-
Interest ---> Income ---

>
Cr.

Double Entry System
Transaction
Every business event or transactions has two aspects. If it increases any asset it either
increases liabilities correspondingly or reduces some other asset. Likewise, incurring of



an expenditure involves decrease in an asset or increase in some liability.



So recording the double effect of any transaction is known as double entry system. As
the assets of a business are always matched by an equal amount of financial claims
against them, all the accounting transactions maintain this equality and no entry for
recording of an accounting transaction is complete unless the debit is equal in value to
the credit entry. This is the rule of Double Entry.
Double Entry system facilitates automatic checking of arithmetical accuracy of books of
accounts through preparation of Trial Balance. Once two sides of Trial Balance have
agreed, it normally leads to a confidence that books of accounts are arithmetically correct.
Under this system position of any particular aspect of a business can be easily
ascertained in the manner that Debtor’s account or supplier’s account gives complete
information about balance outstanding in their account at any point of time.
Voucher
Voucher is documentary evidence in support of a transaction. These documents may be
internal or external. Under the double entry system, recording of a transaction originates
from a Voucher. Followed by an entry in the prime books of record that is journal or cash
book. Type of Voucher is specified by Narration. Narration is the proof or evidence of any
Entry or Transaction. Narration is of different types:
like

---> Capital Introduce ---> Cash
deposited into Bank

---> Bill.M No.
---> C.M No.
---> C.M No., R.No.
---> Chq. No.
---> D.D. No.
---> To Mohan For the month of April 99
---> To paid for the month of March 99

Some different types of vouchers are used in business:

This Voucher is used to record all payment and other expenses paid in cash. In case of
expenses the relevant support of expenses such as cash memo or bill etc. should be
attached so far as possible. In case of cash payment exceeding rupees fifty it is necessary
to affix revenue stamp on the voucher to make it legally enforceable. The signature of
recipient should be obtained on voucher across the revenue stamp.

: This Voucher is prepared for recording all receipts of money
whether by cash or by cheque and on whatever Accounts.

: A journal voucher is prepared to record transactions other than
those involving cash. Journal voucher is prepared to ensure that each approved liability
is recorded as incurred.

Journal : Journal is a systematic recording of transactions on the basis of
VOUCHERS as an when they occur. It is a book of primary entry or foundation for
accounting.
Procedure for recording transaction in the Journal :



In each transaction identify the head of accounts.



Classify the identified Accounts.
Apply the appropriate rules of Debit/ Credit .

Record the debit account firstly in the particulars columns with the date and amount in
the debit column.
Then enter the credit account by starting with “To giving a little margin in the left hand
side and put the amount in credit column.
Give the brief narration of the transaction in the particular column in respect of the entry.
Example :

Cash Received from Sharma 1000/- Cash -
-> comes in --> Real --> DR 1000/-
Sharmas --> giver --> Personal --> Cr 1000/-

Cash A/c Dr. 1000/-
To Sharma’s A/c 1000/-
(on receipt of cash from sharmas)

Rent paid to Mr. Mohan for Jan 2001 Rs. 5000/-
Rent --> Nominal --> Exp. & Loss --> Dr. 5000/-
Cash --> Goes Out --> Real --> Cr. 5000/-
Rent A/c Dr. 5000/-

To cash A/c 5000/-
(Being paid Rent for the month of Jan 2001 To Mr. Mohan )

Some Important Heads of Expenditure

Rent A/C
Water &Electricity A/C
Telephone & Trunk Call A/C
Office Expenses A/C
Miscellaneous Expense A/C
Salary A/C (Administration staff)

Wager A/C (Factory Labour)
Professional charges A/C
Audit Expense A/C(C.A. / Auditor)

Legal Expense A/C (Advocate+ Stamps)
Printing & Stationary A/C
Postage & Telegram A/C
Traveling & Conveyance A/C
Petrol & Maintenance A/C
Donation A/C (Receipt required above Rs 50/-)
Purchase A/C
Staff Welfare A/C
Entertainment A/C



Business Promotion or Advertisement A/C
Repair & Maintenance A/C
Freight & Cartage A/C
News paper & Periodicals A/C
Furniture & Fixture A/C
Drawing A/C
Insurance A/C
Parking Charges A/C
Interest A/C
Sales promotions A/C
Discount and allowances A/C
Bad debts A/C
Mahurat Expense, A/C
Bank Changes A/C Depreciation
A/C

Chapter 6

Account Books

Cash Book

A cash book is a record of all cash receipts and payments kept and maintained from day
to day and giving the cash balance in hand at the end of a specified period not exceeding
a month. A cash book records all cash transactions with their further classification and
summarization. There are two types of transactions recorded in cash book.

: It’s having only one effect and comes in outer column of cash book. Cash Dr.
or Cash Cr. In cash Book, Cash A/C not to be mentioned.

Non Cash is having Double effect Cr. and Dr. and comes in Inner column.

The cash book is normally divided into two parts :

The left hand side is used for recording all receipts of cash or whether it is loan or
income or the proprietor’s capital introduced into the business and the right hand side
records all payment, whether payment for expenses or repayments of loans and for

Cash Balance at the end of the day total of receipts minus total of payments.

Ledgers

Ledgers is the main book of account which classifies and summarizes transactions and
events into groups according to their nature. For example all the transactions relating to
purchase are recorded in a separate account namely ‘Purchase Account’ those relating



to sales in a ‘Sales Account’, expense of different nature are recorded in different
accounts so that expenses of a particular type are reflected at the same place.
Ledger Posting:
Accounts for each item are indexed and maintained in ledger and the entries in the ledger
are posted from cash book and it is very simple. All cash and non cash credit entry in
credit side and debit entry in debit side And a balance account may have a debit balance,
a credit balance or nil balance.
Trial Balance
After preparing the cash book and ledger the next stage is to prepare “Trial Balance”.
What is a Trial Balance
Trial Balance is a statement prepared with the debit and credit balances of ledger
accounts to test the arithmetical accuracy of the books of Accounts.
Special Features of Trial Balance
The Trial Balance is prepared on a specific date.
It is prepared with the debit or credit balances of Ledger Accounts.
It contains the list of all ledger accounts including each balance.
The amount column of Trial Balance is divided as “Debit Column” and “Credit Column”.
The total of the debit and credit column of the amount must be equal.
If the total of debit and credit side doesn’t tally, it means that certain mistakes have

been committed somewhere in Cash Book, Ledger, Journal.
Cash in Hand is taken from the cash book.
Closing stock is kept out of Trial Balance.
Opening stock from Balance Sheet of Previous year.

Why is Trial Balance Prepared?
The Trial Balance is prepared for the following objects.
To check the arithmetic accuracy of the books of accounts.
To obtain the summarized position of ledger Accounts.
Basis for preparing Final Accounts like “Trading and Profit and loss Account” and

“Balance Sheet”.

Final Accounts

Assets & Liability
Assets : Assets are the resources raised by the business from the funds made available
either by the owner or others.

Kinds of Assets



Fixed Assets : There are acquired for relatively long periods for carrying on business
and are not meant for resale like Land, Building, Machinery, Furniture & Fixture,



Copyright, Goodwill , Trademark, Computer, Typewriter, Air Conditioner and Television
etc.

Investment and Advances : Other than in the regular business are called investment.

Current Assets : These are those assets held in the business which are expected to be
converted into cash within 12 months i.e. is in short run e.g.

Cash in hand
Cash at bank
Marketable Securities
Debtors
Advances to Staff
Advances to Supplier
Earnest Money
Prepaid Expenses
Closing Stock

Liabilities
Capital : Share Capital or Equity Capital.

Secured Loan : The loan taken against security is called secured loan . It is called long
term loan (>12 months) from bank.

Unsecured Loan : This is short time (<=12 months) loan without security from friends,
relatives etc.

Current Liabilities : Creditors bills payable, advances received from supplier, securities
received, out standing expenses. Which is expected to be paid within 12 months .

Adjustment In Profit & Loss A/c with Journal Entries :

Salary and Salary payable (Salary Dues will be shown as Salary payable).

Salary A/C Dr.
To Salary payable A/C Cr.

In Profit & Loss A/C it will be added in the salary A/C and in Balance sheet it will be shown
as salary payable.

Telephone any telephone bill out standing

Any telephone bill received before 31st march not yet paid will be shown as due.

Telephone A/C Dr.

To Telephone Expenses Payable A/C

In Profit & Loss A/C it will be added in Telephone & Trunk call expenses A/C in Balance
sheet it will be shown as liability.



Water & Electricity Payable



Any water electricity bill received before 31st March not yet paid will be shown as due.

Water & electricity A/C Dr

To water & electricity payable A/C

Advance Given

Insurances paid in Advance will be deducted from expenditure and in Balance sheet it is
shown as an asset.

Prepaid insurance A/C Dr.

To insurance A/C Cr.

Income due (but not received is also known as accrued income - Receivable)

Accrued Tuition fees A/C Dr.

To Tuition Fees A/C Cr.

Tuition fees will be added in the income shown in Profit & Loss A/C and accrued Tuition
Fees will be shown as an asset.

Loss of stock by fire : There are two types of loss of stock

Uninsured loss Insured loss

Closing: Accounts are closed on 31/3 and financial accounts are prepared to know the
standing of the business during the previous year with regard to Profit and Loss and
Assets and Liability.

: Cost of production

: Gross Profit

: Net Profit
:

Balance of Assets and Liabilities

Closing stock : Raw Material, Work In Progress, Finished Goods
Opening stock : Raw Material, Work In Progress, Finished Goods
Profit & Loss A/c : A Profit and loss Account shows the total revenues/ incomes from
the sale of goods or services, during an accounting period and the total expenses incurred
during that period in earning the revenues, Excess of revenues over expenses is the net
profit or net income. If total expenses are in excess of revenues, the net result is loss.

Balance Sheet : A Balance sheet is a statement showing the state of affairs of a
business as on a specified date. The state of affairs includes what the business owns
and what the business owes. It displays the properties, assets and other rights owned
by the business on the right hand side. The liabilities to outsiders and amounts



invested by owners as capital on the left hand side. Balance sheet reflects as to what



proportion of the total assets belongs to proprietors of business and what proportion to
outsiders. It is a formal representation of the accounting equation

BASIC CONCEPTS OF TAXATION

Types of Tax: Taxes are basically of two types i.e. Direct Tax and Indirect Tax

1. Direct Tax: where the incidence and impact of Tax is on the one and same person,
then it is called a Direct Tax. In other words we can say that where the Tax is charged
directly on the Person, it is a Direct Tax e.g. Income Tax.

2. Indirect Tax: where the incidence of Tax is on one person and its impact falls on the
other person, then such Tax is called an Indirect Tax. In other words we can say that
where the tax is charged on the Person indirectly, it is an Indirect Tax e.g. Sale Tax,
Service Tax, VAT Tax etc.

Income Tax : Tax planning is crucial as it reflects on your financial situation and also
involves planning for post-retirement life. The Income Tax Act has provisions for
benefits, exemptions and deductions to help you reduce your taxes and save money.
Income tax is an annual tax on income. The Income Tax Act (Section 4) provides that in
respect of the total income of previous year of every person, income tax shall be
charged for the corresponding assessment year at the rates laid down by the Finance
Act for that assessment year.

Previous Year : Income tax is calculated on the income received or accrued during a
financial year, and that year is known as the previous year.

Assessment Year : Assessment year is the year after the previous year.
Assessee : An assesses is a person who pays tax or any other amount under the Income
Tax Act.

Person : Section 2(31)of the Income Tax Act defines a person as An individual, A Hindu
undivided family, A company, A firm, An association of persons or a body of individuals
whether incorporated or not, A local authority, Every artificial person not falling within
any of the proceeding categories.

Assessing Officer : An assessing officer is the Income Tax officer, or the assistant
commissioner of Income Tax officer, or the deputy commissioner of Income Tax, or the
joint commissioner of Income Tax, who has jurisdiction over an assessee.The assessing
officer makes the assessment and collects taxes under the Act.

CALCULATE YOUR TAX

Step 1: Asses your income. Each of these heads recognizes an income from a
different area or profession and is classified under different heads. Each of the heads of
income allows certain deductions or exemptions as per rules.



Step 2: Aggregate the gross income. The next step is to sum up the income under
the different heads to arrive at the gross total income.

Step 3: Calculate the net taxable income. From the gross total income, the
Income Tax Act allows certain deductions under chapter VI A to arrive at the net taxable
income.

Step 4: Calculate tax. On this net taxable income, calculate the tax payable as per
the tax-slabs given in the finance act every year.

Step 5: Deduct rebates. Tax rebates are available under section 88, 88B and 88C on
certain conditions. Deduct these rebates from tax payable.

Step 6: Final tax payable. If you have paid any advance tax or have tax deducted
at source, reduce the same from the balance tax amount. Any additional tax should be
paid as self-assessment tax before filing the income tax return.

Gross Total Income (GTI) : Section 14 of the Income Tax Act provides that for
the purpose of charge of income tax and computation of total income all income shall be
classified under the following heads of income:

1. Income from “Salaries”.

2. Income from “House Property”.

3. Income from “Business or Profession”.

4. Income from “Capital Gains”.
5. Income from “Other Sources”(any income that does not come under any of

the above heads)

The total income from all the above heads of income is calculated in accordance with the

provisions of the Act as they stand on the first day of April of any assessment year.

Salary : Section 17(1)of the Income Tax Act gives the definition of salary. Essentially,
income from salary consists of all types of cash amount paid to an employee for
services rendered to an employer. You should have an employee-employer relationship
and such cash amount is taxable as ‘salary’. It includes basic pay, dearness allowance,
overtime, bonus, incentives, allowance, and Children allowances. Some of these
allowances are exempt from taxes under section 10 subjects to limits, after which
standard deductions are allowed under section 16 and then the final net income is
computed.

Salary from more than one source : Salaries received from more than one employer
during a year are taxable under salary. Such salaries are aggregated or clubbed



together.



House Property : This is the second head for taxable income. The IT Act classifies
house property under two distinct heads: self-occupied property and let out property.
The house owner has to ascertain an annual value on these properties, which is taxable
income.

Self-occupied property : Simply put, the annual value of the house where the owner isresiding,
and which has no been let out, is taken as ‘nil’.

Let out property : For the property that has been let out or deemed to be let out, the
taxable value of the property shall be the higher.

PROFIT FROM BUSINESSOR PROFESSION : This is the third head under which taxable
income has to determined and in the case of individuals, it is applicable to those who
are self-employed, the sole proprietor of the business, or a professional. Business can
be explained as any trade, commerce, or manufacture, or any concern in the nature of
trade, commerce or manufacture. Profession includes any profession that requires
manual or intellectual skills. Professions include categories such as doctors, lawyers,
singers etc. Any profits or gains from business or profession or any other service shall
be treated as income from business or profession. Important expenses can be claimed
as deductible expenses, some of which are:

Rent, Taxes, Repairs And Maintenance Of Buildings, Salary, Bonus, And
Commission To Employees Expenditure Incurred On Entertainment, Traveling,
Advertising Etc.

Capital Gains : This is for those who have made a profit or a loss by selling a capital
asset and by making capital gains thereon. Capital asset is property of any kind held by
a person whether or not it is connected with his business. However, it does not include
inventory, raw material or stores for the purpose of business, or any personal goods
such as clothes and moveable property, and jewellery. Rural agricultural land and gold
bonds and gold deposit bonds, too are not considered capital assets.Short and long
term assets asset’s nature along with its holding period (the number of years of
possession) determine whether an asset is a long or short-term one.

INCOME FROMOTHER SOURCES : This is the Income that cannot be classified under any of
the above heads such as salary, house property, etc. Interest income from securities,
company fixed deposits, savings accounts, bank deposits, pension received by legal
heirs and lotteries come under this head.



Service Tax : Service tax is tax of 21st Century. Service Tax is a form of indirect tax
imposed on specified services called “taxable services”. Service tax cannot be charged
on any service which is not included in the list of taxable services. Over the past few
years, service tax been expanded to cover new services. The intention of the
government is to gradually increase the list of taxable services until most services fall
within the scope of service tax.

Value Added Tax ( VAT ): VAT or Value Added Tax is a consumption tax, which is
charged at each stage of production based on the value added to the product at that
stage. Many States in India have adopted VAT in place of sales tax. In the sales tax
structure, there are problems of double taxation of commodities and multiplicity of taxes,
resulting in a cascading tax burden.VAT is a modern and simplified system of taxation
where the tax is levied and collected at each stage on the value additions with a
provision for set off against tax paid at the various stages / tax paid on inputs. VAT is a
system of indirect taxation, which has been introduced in lieu of sales tax. It is the tax
paid by the producers, manufacturers, retailers or any other dealer who add value to the
goods and that is ultimately passed on to the consumer. VAT has been introduced in
India to ensure a fair and uniform system of taxation. It is an efficient, transparent,
revenue-neutral, globally acceptable and easy to administer taxation system. It benefits
the common man (consumer), businessman and the Government.

Banking System : The Banking Sector is the most dominant sector of the financial
system in India, and with good valuations and increasing profits, the sector has been
among the top performers in the markets. Banking dates back to 1786, the first bank
established in India, then the nationalisation of banks in 1969. In India the banking
sector is Separate as public or private sector banks, cooperative banks and regional
rural banks. Foreign banks has been given a different head followed by upcoming
foreign banks in this section. Bunch of services are at customers demand in today’s
banking system. Different types of accounts and loans, facilitating with plastic money
and money transfer across the globe.

Types of Business
There are four types of business :
Proprietorship : (Single person or sole proprietor)
No formalities are required,

No registration or whatever.
Firm : (Partnership)
Member 2-20 Registration - Not compulsory, but it is advisable to get it registered with
the registrar of firms.It is registered in Estate Office in Registrar’s Office . Registration is



applied on Form no 1. Registration fee is Rs 3.00 deposited through Challan no. 32A



.Challan Code no- Head of A/c 1475 - Other General and Economic Account. Under
Partnership Act, 1932 partnership Deed on stamp paper of Rs 25.00 and attached to
application Form no. 5 is used for incoming and outgoing members.
Private Limited Company :
Its having member 2 to 50 at least two directors.
Registration is compulsory. Registration is done in Registrar of Companies, Jalandhar for
Himachal, Punjab and Chandigarh.
We cannot start without Registration.
It can not issue shares.
Registration fee is based on Capital It has
contributory capital of all members.
Public Limited Company :
Members 7 to no limit.
Registration is compulsory in the Office of Registrar of Companies near busstand,
Jalandhar.
It can issue shares.
It has share capital of all share holders.
Depreciation : Depreciation A/C is change in the value of fixed Assets through wear
and tear and obsolescence due to passage of time or Reduction in the value of fixed
assets, except Land. These are called Adjustment entries. Rate of depreciation is same
for every type of business.

Land : No depreciation
Building : Residential : 5% value is decreased every year

Commercial Area : 10%
Furniture : 10% is ordinary Business: 15% is Rush Area (School, Club,

Academy)
Vehicle
Business

: 20% in ordinary business, 40% if used for Transport

Machinery : Less than 5000/- or 100% Depreciation will be charged.
Fridge/ AC/ T.V/ Typewriter/ Remaining Electronics item etc - 25%, computer 60%
Income Tax And Accounts
Accounts books should not only show a true and fair view of the business profits and its
state of affairs but should also enable the taxing authorities to calculate the taxable
income of the business The account books should there fore be maintained in a manner
that is acceptable to the income tax authorities. Books of accounts must be prepared in
such a manner that the account are not rejected by income-tax authorities on ground that
:
Income cannot be properly determined there from.

The accounts are not correct & complete.

The method of accounting has not been consistently followed by the assesses.



There are sufficient and strong reasons to indicate that the accounts are unreliable.



Where there are defects and omissions and tax-payer fails to explain them
unsatisfactorily.

Where there is no quantitative tally between purchases and sales and there are
suspicious features.

If only a part of sales or purchases can be verified and rest can not be verified or some
purchases are omitted from records.

The absence of proper documentary evidence to support the entries in the account
would remake the account liable for rejection.

If it appears that the cash book has been written up at a stretch and not form day to
day.

Where the account show an abnormally low rate of profit.

Income Of Five Types

Computerized Financial Accounting
Introduction To Tally
Among the most important application of computers in the offices is the Financial
Accounting. It has made the life of accountants very easy. Gone are those days of
spending long hours to tally the accounts manually. These days most of the companies
use computerized financial accounting for their accounts purposes. Even most of the
Chartered Accountants use them. Now the software used by them may differ from user
to user.
In this recent years on the Indian market, one financial accounting software which has
taken the fancy of most of the accountants is called Tally.
Tally Screen
The following can be see on the Tally screen initially.
As you can see from Gateway to Tally, there are 3 options here :
Select Company
Create Company
Quit
I am sure you do not want to quit at this stage. Since you have not created a company,
so you would not be able to select any company. Hence the only logical selection here
would be Create a Company. So let us do it.
CREATE A COMPANY



To create the company, you would click at Create a Company, or F3 key, various items
on the screen are described below :



Name : Type here the name of the company you want to create.
Mailing Name : Type here the mailing name of the company. Address
: Type here the address of your company.

Income Tax Number : In the case your company has been allotted an income tax
number, just fill it up here.

Local Sales Tax Number : If your company has been allotted any number under the
Sales Tax Act, then fill it up here.

Inter-State Sales Tax Number : Again fill this number if it has been allotted to your
company.

Currency Symbol : You have to specify the currency symbol which you are going to use.
Maintain : There are three different ways you can use Tally.

The options are:
Accounts only
Accounts-with-Inventory
Inventory only

Accounts only Use this option if you do not have any inventory transactions. Using this
option you would not be allowed to have any inventory transactions.
Accounts-with-inventory Though this is selected by default, you can always differ to
use your own option. Using this you would be able to use both Financial as well as
Inventory Management.
Inventory only Use this if you have to use Tally for inventory only. You would not be able
to do any accounting related processing if this option is used.
Books Beginning From : Type here the date from which you actually want tally to
maintain your accounts.
Use Security Control :This option allows you to provide security password to your
company. Basic Currency Information
The best part of Tally is that you can work in any currency accounting system. You can
in fact use any foreign currency too. In this section you have to provide information related
to this.
Basic Currency Symbol : Specify the symbol of your base currency.” For example for
an Indian company the base currency is Rupees, whose symbol is “Rs.”, therefore specify
this symbol here. Tally uses this symbol in reports, whenever necessary. Formal Name
: Now that you have decided on the currency symbol, you can decide about the currency”,
name too. Remember, Rupees is also available in other countries too, for example,
Nepalese Rupees. If you wish you can write, here Indian Rupees.
Number of Decimal Places : In this option you can specify a value from zero to four to
denote the fractional part of the currency. For example, the fractional part of the Indian
Rupee is Paisa for which the number of decimal places is two. The default option is also
two.
Show Amount in Millions? : By default this option is No, which means that the amount
will be displayed in lakhs and crores. In case you want the amount to be displayed in



American system of millions, then select Yes.



Is Symbol SUFFIXED to Amount? : Most currencies have the symbol prefixed to the
amount, for example, Rs. 165.00 or $375.00, but some currencies take the symbol to the
right of the digits, for example 600 Yen or 1000 Lira. Depending upon the currency you
wish to deal in, choose an appropriate option. The default choice for the option in No.
This means that the symbol be on the left hand side of the digits.
Put a SPACE between Amount and Symbol? : In order to insert a space between the
currency symbol and the amount choose Yes and to remove the space specify No.
With this you end the options for creating a new company. Press <Enter> to get a small
window which prompts to answer in Yes or No whether to accept the figures as it is or
not. Press Y to accept and create the company.

A created company would look like the one shown on the page. Now we have to enter
other information about the company.
Various items which can be seen on the screen are defined as following:
Current period: It displays the financial period in which you are working.

Current date : It displays the date on which you are entering vouchers or viewing reports.

List of Selected Companies : It displays the list of companies you selected. The
company on the top of the list in bold is the currently active company. In order to change
the currently active company, click on another company in the list or press <F3>.

Date of Last Entry :It displays the date of last voucher entered in the currently active
company.

Gateway of Tally :This menu displays the primary options available to the user. These
menus are briefly mentioned here.
Accounts Info :This option permits you to handle all the information related to financial
accounts. It allows you to work on creation and maintenance of masters like Ledgers,
Cost Centers, Cost Categories and other related information.
Inventory Info :Using this option you can handle information relating to the inventory
accounts. It enables you to work on stock items, stock groups, stock categories, units of
measurement and other inventory related information.
Voucher Entry : This is the most frequently used option. It allows you to make daily
vouchers.
Balance Sheet :This option displays the balance sheet of your company as per the last
voucher entered.
Profit and Loss A/C : This option allows you to take a look at gross profit and net profit
for both opening and closing stock.
Ratio Analysis :This option enables you to have a bird’s eye view of your company.
Just by looking at the ratio of assets and liabilities loans and profit, you can judge the
financial status of your company in a flash.



Display :This option enables you to view all reports like, Trial Balance, Account Books,
Statement of Accounts, Inventory Books, Statement of Inventory, Cash Flow, List of
Accounts, etc.
Multi-Account Printing :Choose this option to print Account Books, Inventory Books
and Day Book.

The Buttons : They are on the right hand side of the screen.
F1: Select Company : This enables you to select companies and add them to the List
of Selected Companies.
F1: Shut Company : This enables you to shut down a selected company and remove it
from the list of active companies.
F2: Date :In order to change the date.
F2: Period : Using this option you can change the financial accounting period of a
company.
F3: Change Company : This option is accessible only if more than one company is
present in the list of selected companies. Choose this option when you want to work on
another company that is in the list.
F3: Create Company : This option enables you to create another company by bringing
up the Company Info menu.
F4: Backup :This option gives you a provision of backing up the company’ information
on floppy disk. When you choose this option, Tally prompts you to select a company
whose backup you wish to take.
F4: Restore : This option allows you to retrieve the information of company whose
backup had been taken by you.
FII: Features : This enables you to get the special features like integrating accounts and
inventory, invoicing, cheque printing, etc.

LIST OF GROUP UNDER TALLY

ACCOUNT PAYABLE
SUNDRY CREDITORS & SUNDRY DEBITORS
SUSPENSE ACCOUNT
TEMPORARY ACCOUNT
UN SECURED LOANS & SECURED LOANS
ACCOUNT RECIEVEABLE
ADMIN. EXPENSES
BANK ACCOUNT & BANK OCC A/C
BRANCH/ DIVISIONS
CAPITAL ACCOUNT
CASH IN HAND
CURRENT ASSETS
CURRENT LIABILITIES
DEPOSITS (ASSETS)
DUTIES AND TAXES



EXPENDITURE ACCOUNT
EXPENCE (DIRECT)
EXPENCE (INDIRECT)
FIXED ASSETS
IMMOVABLE PROPERTIES
INCOME (REVENUE)
INVESTMENT
LOAN & ADVANCES (ASSETS)
LOAN (LIABILITY)
MFG./ TRDG. (EXPENCE)
MISC. EXPENCES (ASSETS)
PROVISIONS
PURCHASE ACCOUNT
RESERVES & SURPLUS
RETAINED EARNINGS
REVENUE ACCOUNTS
SALES ACCOUNTS
STOCK IN HAND
SUBSIDIARY FARMS & SUNDRY FARMS

Banking System

Introduction

The Banking Sector is the most dominant sector of the financial system in India, and with

good

valuations and increasing profits, the sector has been among the top performers in the

markets. Banking dates back to 1786, the first bank established in India, then the

nationalization of banks in 1969. In India the banking sector is Separate as public or

private sector banks, cooperative banks and regional rural banks. Foreign banks has

been given a different head followed by upcoming foreign banks in this section. Bunch

of services are at customers demand in today’s banking system. Different types of

accounts and loans, facilitating with plastic money and money transfer across the globe.

Banking Industry in India



The General Bank of India was set up in the year 1786. Next came Bank of

Hindustan and Bengal Bank. The East India Company established Bank of Bengal

(1809), Bank of Bombay (1840) and Bank of Madras (1843) as independent units and

called it Presidency Banks. These three banks were combined in 1920 and Imperial

Bank of India was established which started as private shareholders banks, mostly

Europeans shareholders.

In 1865 Allahabad Bank was established and first time exclusively by Indians,

Punjab National Bank Ltd. was set up in 1894 with headquarters at Lahore. Between
1906 and 1913, Bank of India, Central Bank of India, Bank of Baroda, Canara Bank,

Indian Bank, and Bank of My sore were set up. Reserve Bank of India came in 1935.

During the first phase the growth was very slow and banks also experienced

periodic failures between 1913 and 1948. There were approximately 1100 banks, mostly

small. To streamline the functioning and activities of commercial banks, the Government

of India came up with The Banking Companies Act, 1949 which was later changed to

Banking Regulation Act 1949 as per amending Act of 1965 (Act No. 23 of

1965). Reserve Bank of India was vested with extensive powers for the supervision of

banking in India as the Central Banking Authority. During those day’s public has lesser

confidence in the banks. Side by side of it the savings bank facility provided by the

Postal department was comparatively safer.

Government took major steps in this Indian Banking Sector Reform after

independence. In 1955, it nationalized Imperial Bank of India with extensive banking

facilities on a large scale especially in rural and semi-urban areas. It formed State Bank

of India to act as the principal agent of RBI and to handle banking transactions of the

Union and State Governments all over the country.

Seven banks forming subsidiary of State Bank of India was nationalized in 1960

on 19th July 1969, major process of nationalization was carried out. It was the effort of

the then Prime Minister of India, Mrs. Indira Gandhi. 14 major commercial banks in the

country were nationalized. Nationalization of Indian Banking Sector Reform was carried

out in 1980 with seven more banks. This step brought 80% of the banking segment in

India under Government ownership.



After the nationalization of banks, the branches of the public sector bank India

raised to approximately 800% in deposits and advances took a huge jump by 11,000%.

Banking in the sunshine of Government ownership gave the public contained faith and

huge confidence about the ability of these institutions.

This phase has introduced many more products and facilities in the banking

sector in its reforms measure. In 1991, under the chairmanship of M Narasimham, a

committee was set up by his name, which worked for the liberalization of banking

practices. The country is flooded with foreign banks and their ATM stations. Efforts are

being put to give a satisfactory service to customers. Phone banking and net banking is

introduced. The entire system became more convenient and fast. Time is given more

importance than money.

Reserve Bank of India (RBI) : RBI is the central bank of the country since 1934. It
regulates, controls credit, issue licenses and functions as banker of all banks and the

government.

Various Banking Operation & Bank Deposited: Banking is an important aid to
business. A bank may be defined as an institution which deals in money. The bank pay

a certain amount of money as interest, on the money they have borrowed. Similarly they

charge interest on the money lent. Interest is always calculated at a certain rate

presented per annum. The rate of interest on loans advanced is always greater than

that on deposits. The difference between the two rates is the banks margin of income.

Looked at from a different point of view, a bank may be said to be a dealer in the

money market. In the money finance market, money is the item that is bought and sold.

Banks act as middleman between the savers and borrowers of money. The difference

between the banks selling price and purchase price is the banks income. There are

three main types of accounts which a person can open with a bank, namely fixed

deposit, saving bank deposit and current accounts.



Fixed Deposit Account: A customer can deposit his money with a bank for a fixed
period. Such an account is called ‘fixed deposit account’ usually varies from fifteen days

to five years. The amount deposited cannot be withdrawn before the expiry of

the fixed period. The bank normally allows a higher rate of interest on fixed deposits.

The rate of interest increases with the period of deposit. Bank offer very high rates of

interest on such deposits because it is assured of funds for the period. If the depositor is

in need of money in between he may borrow up to 70% of the deposit at 2% above the

interest rate applicable to that particular deposit.

Saving Bank Account: A saving bank account provides limited withdrawal facility and
carries a moderate rate of interest on deposits. Interest is allowed on the saving bank

account on the lowest credit balance kept in a particular month. Some restrictions are

placed on withdrawals. Further a specified minimum balance must always be

maintained in the account.

Current Bank Account: A current account may be defined as a running account
between a banker and a customer. Customer can deposit money into or withdraw

money from a current account whenever they like. There are no restrictions to the

number of withdrawal, subject, however to the minimum credit balance to be kept as per

the rule of the bank. As a rule no interest is allowed on a current account. An exception

however is sometimes made if the credit balance in a current account is not allowed to

fall below a prescribed figure. In other words current account is simply a business

account.

Bank Cheque : A cheque is an unconditional order on the bank made by a client
instructing the bank to pay on demand a certain sum of money to or to the order or a

specified person or to a bearer. In other words, when a trader wants to discharge his

debts he signs a written order on his bank authorizing the bank to pay a certain sum of

money-to his creditor. The order is known as ‘cheque’.

Types of Cheques : Bearer Cheque : A bearer cheque is made payable to the bearer
i.e. it is



payable to the person who presents it to the bank for encashment. The language of

such a cheque runs thus pay to X or bearer or self. It is payable to any body who

presents it at the counter.

Crossed Cheque : Crossed cheque are those which cannot be encashed at the
counter but which can be collected only by a bank from drawee bank. A cheque is

crossed by drawing two Cross lines across its face with or without Account Payee only

words.

Types of Cheques : Bearer Cheque : A bearer cheque is made payable to the bearer
i.e. it is

payable to the person who presents it to the bank for encashment. The language of

such a cheque runs thus pay to X or bearer or self. It is payable to any body who

presents it at the counter.

Crossed Cheque : Crossed cheque are those which cannot be encashed at the
counter but which can be collected only by a bank from drawee bank. A cheque is

crossed by drawing two Cross lines across its face with or without Account Payee only

words.

VAT VALUE ADDED

TAX

What is VAT?

VAT or Value Added Tax is a consumption tax, which is charged at each stage of
production based on the value added to the product at that stage. Many States in India
have adopted VAT in place of sales tax. In the sales tax structure, there are problems of
double taxation of commodities and multiplicity of taxes, resulting in a cascading tax
burden. For instance, in the sales tax structure, before a commodity is produced, inputs
are first taxed, and then after the commodity is produced with input tax load, output is
taxed again. This causes an unfair double taxation with cascading effects. In the VAT, a



set-off is given for input tax as well as tax paid on previous purchases. In the sales tax



structure that existed in India and is still existing in some states, there was multiplicity of
taxes such as turnover tax, surcharge on sales tax, additional surcharge, etc.

With introduction of VAT, these other taxes have abolished. In addition, Central
sales tax is also going to be phased out. As a result, overall tax burden will be
rationalized, and prices in general will also fall. Moreover, VAT will replace the existing
system of inspection by a system of built-in self-assessment by the dealers and
auditing. The tax structure will become simple and more transparent. That will improve
tax compliance and also increase revenue growth.

VAT is a modern and simplified system of taxation where the tax is levied and
collected at each stage on the value additions with a provision for set off against tax
paid at the various stages / tax paid on inputs. VAT is a system of indirect taxation,
which has been introduced in lieu of sales tax. It is the tax paid by the producers,
manufacturers, retailers or any other dealer who add value to the goods and that is
ultimately passed on to the consumer. VAT has been introduced in India to ensure a fair
and uniform system of taxation. It is an efficient, transparent, revenue-neutral, globally
acceptable and easy to administer taxation system. It benefits the common man
(consumer), businessman and the Government.

Further, VAT enhances competitiveness by removing the cascading effect of
taxes on goods and makes the levy of tax simple and self-regulatory, ensuring flexibility
to generate large revenues. The cascading effect is brought about by the existing
structure of taxation where inputs are taxed before a commodity is produced and the
output is taxed after it is produced. This causes an unfair double-taxation. However, in
VAT, a set-off is given for input tax (tax paid on purchases). This results in the overall
tax burden being rationalized and a fall in prices of goods. This concept is explained
with an example, in the Computation of VAT section .

VAT works in two different ways:

If VAT-registered businesses receive more output tax than the taxes paid as

input, they will need to pay the difference to the Commissioner of Taxes (State).

If the input tax paid is more than the output tax collected, You can carry forward the Input
credit and adjust it against the output tax in the subsequent months.

You can have the Input Credit refunded to you at the end of the current or following
year, by the Government.

You can receive refunds for Input Credit on exports within a period of three months.



Term Description
Input tax This is a tax paid on purchases

Output tax This is a tax charged on sales

Input Credit The amount of Input tax that is
permitted to be set off against Output tax.

VAT Rates

According to the White Paper, there are 550 categories of goods under the VAT
system. They are classified into the following four groups, depending on the VAT
rate:

VAT @ 4% : The largest number of goods (270) comprising of basic necessity items
such as drugs and medicines, agricultural and industrial inputs, capital goods and
declared goods are under 4% VAT rate.

VAT @ 1% : This is for a specific category of goods like gold, silver, etc.

VAT@12.5% : The remaining commodities are under the general VAT rate of
12.5%.

Exempted from VAT

There are about 46 commodities under the exempted category. This includes a
maximum of 10 commodities that each state would be allowed to select, from a broader
approved list for VAT exemption. The exempted commodities include natural and
unprocessed products in unorganized sector as well as items, which are legally barred
from taxation.

Note: The few goods that are outside VAT as a matter of policy would include liquor,
lottery tickets, petroleum products, as the prices of these items are not fully
marketdetermined. These items will continue to be taxed under the sales tax act of the
respective states.



Registration Proces

For Existing Dealers

1) All the registered dealers under the PGST act 1948 shall apply in VAT-I form with in
30 days of the appointed day.

2) Old registration certificates to be attached in original.

3) No application fee.

4) An eleven digit (TIN) Taxpayer identification number has been generated and is
available on the official website i.e. www.chandigarh.nic.in, Excise and Taxation
Department Chandigarh and shall be communicated by post.

For Fresh / New dealers.

1) Application for registration under VAT act to be submitted in the form VAT-I,
alongwith application fee of Rs. 500/-

2) The application has to be submitted with in 30 days of a person becoming Liable
to pay Tax.

SERVICE TAX

Service tax is tax of 21st Century. Service Tax is a form of indirect tax imposed on
specified

services called “taxable services”. Service tax cannot be charged on any service which is
not

included in the list of taxable services. Over the past few years, service tax been
expanded to cover new services. The intention of the government is to gradually
increase the list of taxable services until most services fall within the scope of service
tax.

Highlights of the service tax are as follows :

http://www.chandigarh.nic.in/


1. Service tax is imposed under Finance Act, 1994 as amended from time to time.



2.Service tax is payable @ 12% plus education cess of 2%, plus SAH education
cess of 1% (total 12.36%) w.e.f. 11th May 2007 [Section 66].(The exemption limit was
Rs four lakhs up to 31-3-2007).

3.Service tax is payable on taxable services as defined in various clauses of
section 65(105) of Finance Act, 1994. Presently, about 99 services are taxable.

4.Service tax is payable on gross amount charged for taxable service provided or
to be provided [Section 67].

5.Presently Service tax is payable @ 10% plus education cess of 2%, plus SAH
education cess of 1% (total 10.36%) & Small units whose turnover less than Rs. Ten
lakhs per annum are exempt from service tax.

6. Every provider of taxable service should apply for registration in form ST-1 within 30
days from date of charge (in case of new services) and date of commencement of
business of providing taxable services.

7. Assessee providing service from various premises can have centralised registration
[Rule 4(2)]

8. If payment of tax is delayed, interest is payable @ 13% [Section 75]

Invoice by service provider

Assesses should prepare invoice in respect of his services. Details required to be
shown in invoice/bill/challan - As per rule 4A(1), the invoice/challan/Bill should be signed
by authorized person of provider of input services, should be serially numbered and
should contain following details -

1. Name, address and registration number of person providing taxable service

2. Description, classification and value of taxable service provided or to be provided and

Education Cess and SAH Education Cess (Sec & Higher Edu. Cess) to be shown
separately - Education Cess and SAH Education Cess to be shown separately in the
Invoice for complying with requirements of Central Credit Rules to facilitate availment of
Central credit by recipient – para 5.1 CBE&C Circular No. 97/8/2007-ST dated 23-82007.

Procedures of Service tax
Administration of service tax is under Central Excise department. The main
procedures to be followed are - 1. Registration

2. Maintenance of records

3. Payment of service tax and



4. Half yearly return.



There are no prescribed forms of records. The records maintained by assesses including
computerized data maintained by assesses in accordance with various other laws are
acceptable [rule 5(1)].

Registration under Service Tax: A ‘person liable for paying service tax’ has to register
with Superintendent of Central Excise under whose jurisdiction your premises fall. He
should register within 30 days from date of commencement of the

business of providing taxable service. The person will have to apply for registration in
form ST-1.If a person is providing more than one taxable service; he may make a single
application. He should mention in the application all the taxable services provided by him.
[rule 4(4)]. Applicant should submit following at the time of filing application for
registration:

1. Copy of PAN

2. Proof of Residence and

3. Constitution of applicant.

The registration certificate will be granted by Superintendent of Central Excise in seven
days in form ST-2.


	TOPIC 1: COMPUTER FUNDAMENTALS TOPIC 2: DESKTOP PU
	TOPIC 5: FINANCIAL ACCOUNTING PRACTICAL LAB ASSIGN
	COMPUTER FUNDAMENTALS
	CHARLES BABBAGE
	Definition
	Accuracy
	Storage Capability
	Diligence
	Versatility
	Automation
	Reduction In Paper Work
	Reduction In Cost
	Dependency
	Environment
	Insurance
	Education
	Marketing
	Health Care
	Engineering Design
	Military
	Communication
	Government applications
	INPUT DEVICES
	OUTPUT DEVICES
	CPU (CENTRAL PROCESSING UNIT)
	Memory or Storage Unit:
	Control Unit:
	ALU (Arithmetic Logic Unit):
	ARITHMETIC SECTION
	LOGIC SECTION
	Units of Computer Memory Measurements
	Computer Memory
	Volatile memory
	Non-volatile memory


	OPERATING SYSTEM
	Objectives of Operating System
	Install Windows 7
	Pre-installation checklist
	Installation process
	To Continue the Installation
	To complete the installation
	MS-DOS
	DOS Commands
	Other DOS Command commonly used are:
	Attrib
	Break
	Chcp
	Chkdsk
	Choice
	Cls
	Dir

	WINDOWS OPERATIONS:
	MS- PAINT
	To draw a straight line
	To draw a freeform line
	To draw a curved line
	To send an image using e-mail
	To draw a rectangle or square
	Notepad overview
	WORDPAD
	The WordPad window
	Selecting text
	Copying and moving text
	To copy text and paste it in another location
	Inserting and deleting text
	Formatting your document
	To change the font, font style, or font size:
	To change the color
	To change the alignment
	Saving your document
	To save the document


	MS-OFFICE:
	MS- WORD
	Opening Microsoft Word
	Restore Down:
	Quick Access Toolbar
	Keyboard Review
	MICROSOFT WORD BASICS
	Deleting Text
	BACKSPACE ↔ DELETE
	Undoing and Redoing
	Formatting Text
	DOING MORE WITH MICROSOFT WORD
	Modifying Line Spacing
	To change the line spacing:
	Creating Bulleted and Numbered Lists
	To create a list:
	Changing Views and Overall Look
	Click on the Page Layout Tab.
	Spelling and Grammar Check
	USING MICROSOFT WORD
	Opening Microsoft Word
	MICROSOFT WORD BASICS
	Deleting Text
	Microsoft Word Features The Title Bar
	The File Menu
	The Home Tab
	The Ruler
	Keyboard Review

	MICROSOFT EXCEL
	Opening Microsoft Excel
	Microsoft Excel Features
	The Title Bar
	The Ribbon Menu System
	The File Menu
	The Home Tab
	Equation Editor
	Keyboard Review
	Pointer Shapes
	MICROSOFT EXCEL BASICS
	Inserting Rows and Columns.
	Sorting Data
	AutoSum and Excel Equations
	Select the AutoSum icon from the ribbon menu:
	Creating Charts and Graphs:
	Multiple Sheets
	=‘March 2012’!D11
	Cutting, Copying, and Pasting Data
	Filling Data across Columns and Rows
	Saving Spreadsheets
	Printing Spreadsheets
	Finding More Help
	Closing the Program


	MICROSOFT POWERPOINT
	Microsoft PowerPoint Components:
	The Title Bar
	The Menu Bar
	Standard Toolbar
	New | Open | Save | Print | Preview | Spell-check 

	SIMPLE TASKS IN MICROSOFT POWERPOINT
	Text Boxes:
	Slide Design:
	Designing your own background:
	Slide Layout:
	Note the four different types of layout categories
	Inserting a Picture:
	Inserting a Graph or Table:
	Inserting a Picture.
	Insert ► Chart (or Table).
	Slide Management:

	Saving Slide Shows:
	Closing the Program:

	Introduction:
	What is the Internet?

	Uses of Internet
	1)Email:
	2)Information:
	3)Business:
	4)Social Networking:
	5)Shopping:
	6)Entertainment:
	7)E-Commerce:
	8)Services:
	9)Job Search:
	10)Dating/Personals:

	E-mailing
	How It Is Used

	Comparisons
	With word processing
	With other electronic layout software
	What is the Print Media?
	Why is the Print Media Important?
	ADVANTAGES AND DISADVANTAGES OF PRINT MEDIA
	Advantages of print media
	Disadvantages of print media

	Characteristics of Print Media
	PAGE MAKER:
	System Requirements

	Tools used in pagemaker
	Text Tool
	The Pointer Tool
	Rotate Tool
	To rotate text,
	Cropping Tool
	To crop a graphic,
	Rectangular Tools
	Elliptical Tools
	Polygon Tools
	Supported platforms
	Characteristic features
	CorelDraw Graphics Suite
	CDR File Format
	File Format
	Language Availabilities
	Plugins
	Tools
	Pen Tool
	Measuring and navigation
	Selection
	Cropping
	Slicing
	Moving
	Marquee
	Lasso
	Quick Selection
	Magic Wand
	Eraser
	Typing
	Retouching
	Content-aware
	Healing tools
	Puppet wrap
	Video Editing
	3D
	Mobile integration
	Camera Raw

	HTML / DHTML , NOTEPAD & DREAMWEAVER
	Introduction to HTML
	WEBDESIGNING
	For creation of HTML files we required Two ways :
	<HR Size=5 Color=”Red” Width=70% Align=”Right”>
	Basic structure of HTML Document :
	Align = Left / Center / Right <H1 Align=”Left”> So
	<HR Size=5 Color=”Red” Width=70% Align=”Right”>
	<S>
	<TT> SoftBrain </TT>
	Using Special Characters :
	Attributes of Unordered Listtype=”circle”type=”s
	Definiton term=Appears after the Tag <DT> Definiti
	AN INPUT DEVICE
	<IMG SRC=”imagename.gif”>
	Image Element Attributes:
	Align Attributes with Floating Image: Align=Left /
	Alt working for text
	CREATING TABLES
	Table Attributes : <Align>Attribute :
	<Border>Attribute :<Table Border=5>
	<Tr Bgcolor=”Color Name”>
	<Th Bgcolor=”Color Name”>
	<Table Background=”Computer.jpg”>
	<Caption Align=Top/Bottom/Left/Right>Caption Text<
	<Table Cell spacing=”Number”> Cellpadding Attribut
	<Td Colspan=”Number”> <Th Colspan=”Number”>
	<A HREF=”filename.html”>content</A>
	<a href=”http.// 
	<A href=”abc.html”><img src=”image.jpg”></A>
	<A NAME=”LOCATION”>
	MARQUEE
	<Marquee></Marquee>
	For direction of scrolling
	For background color/width/height
	For speed controlling in marquee
	MULTIMEDIA
	Adding Video : <embed src="movies.mpg" height="200
	<A href=”music.wav”> Click Here For Background Mus
	Adding Animated Gif’s : (Graphics Interchange Form
	FORM Creation in HTML
	1.Action
	Syntax:<Form action=”URL” method=get/post>Form Ele
	Form Creation:
	<Fieldset>
	</Fieldset>
	<head><title>Feedback Online Form</title></head>
	<form>
	<legend align=”right”>Form 
	<input type=”text” name=”text-id” value=”default-t
	<input type=”text” name=”text-id” value=”default-t
	<input type=”text” name=”t1” size=25 maxlength=25 
	<input type=”text” name=”t2” size=25 maxlength=25 
	<input type=”checkbox” name=”box id” value=”checkb
	<input type="checkbox" name="c1" value="checkbox" 
	<input type="checkbox" name="c2">
	<input type="checkbox" name="c3">
	<input type="checkbox" name="c4">
	<input type="checkbox" name="c5">
	<input type=”radio” name=”radio id” value=”radiobu
	<input name="radiobutton" type="radio" value="radi
	<input name="radiobutton" type="radio" value="radi
	<label>Year</label>
	<option value=”Choice Id 1” selected>2000</option>
	</select>
	<select name="s1" size=1>
	<option name="02">february</option>
	<option name="04">april</option>
	DD&nbsp;&nbsp;&nbsp;
	<option name="01">01</option>
	<option name="03">03</option>
	<option name="05">30</option></select> &nbsp;&nbsp
	<select name="s3" size=1>
	<option name="02">2002</option>
	<option name="04">2004</option>
	</select><br>
	<Textarea name=”text-Id” rows=”n” cols=”n”>Type an
	<label>Type Your Message Here</label><br>
	<textarea name=”ta” rows=15 cols=60></textarea><br
	<Input type=”file” name=”file-id” size=”n” accepts
	<input type="file" name="file"><br><hr>
	<input type=”password” name=”passwordid” value=”de
	<label>User
	<input type="text" name="t1" size=25 maxlength=25 
	<Input type=”button” name=”button id” value=”click
	<input type=”image” name=”img” src=”pic.jpg” heigh
	<input type=”submit” name=”sub” value=”Submit”>
	<input type=”reset” name=”res” value=”Reset”>
	</form></body></html>
	1.A number of pixels.
	3.The symbol,’*’ which indicates the remaining space
	<Frameset Cols=”50%,50%></Frameset>
	<html>
	<frameset>
	<frameset rows="50%,50%">
	<frame name="bb">
	<frameset rows="50%,50%">
	<frame name="dd">
	</frameset>
	</html>
	1.The filename.html file that has to be opened.


	WEB EDITOR NOTEPAD
	Using Links
	The Right Mouse Button
	Using History
	Saving a Web Page
	Accessing the Favorites Menu

	WEB FRAMEWORK DREAMWEAVER
	WHAT’S A ROOT FOLDER?
	Page Properties
	Web Page Preview
	Adding Images
	Delete an Image
	Create a Second Page
	Page Navigation
	Add an E-mail Link
	Creating a Link within a Page
	Create a link to the anchor
	Page Layout with Tables
	Create a Table
	Merge Cells
	Insert an Image
	Delete a row
	Experiment with cell color and other options
	Why we use Language ?
	What is C ?
	Characteristics of C
	Features of C Programming Language :
	1. Low Level Features :
	2. Portability :
	3. Powerful
	4. Bit Manipulation
	5. High Level Features :
	6. Modular Programming
	7. Efficient Use of Pointers
	C Program Structure
	local variables C Statements
	NOTE:
	C Keywords
	C Instructions
	Type Declaration Instruction
	Arithmetic Instruction
	Variables
	How do you declare a variable?
	Basic Data Types
	Data Type DescriptionMemoryRangeFormat
	Qualifiers Used With Basic Data Types
	Constants
	Operators in C :
	Arithmetic operators :
	OperatorsFunction Performed
	Unary Operators :
	The increment operator (denotes as ‘ ++ ’ )
	Relational and Logical Operators :
	Comparison Operators
	Pointers
	Statements in C Language
	Conditional Statement
	1.If Statement
	3.Nested If-Else Statement
	•Sequence statements
	•Selection statements
	Types of Looping Statements:
	•Entry controlled loop
	1.Entry controlled loop :
	•while loop
	2.Exit controlled loop :
	do-while loop
	}
	Do-While Loop Statement:
	Do
	}while(condition)
	Advantage of Arrays
	Array Declaration
	Types of Arrays
	Single Dimensional Arrays
	Single Dimensional Arrays :
	Multidimensional Arrays :
	Array Initialization
	Entering Data into an Array :
	C describes two distinct methods :
	b)Dynamic Initialization Static :
	Dynamic :
	Array Inside the Memory
	Multi Dimensional Arrays :
	Two Dimensional Array :
	Character Arrays
	Strings
	strlen ( )
	strcpy ( )
	strcmp ( )
	Function
	Note :
	Functions may be divided into three categories.
	Without arguments without return value
	With arguments without return value
	With arguments with return value
	Advantage of Functions :
	The types of variables are :
	Local Variables :
	Global Variables :
	Recursion in Functions
	C program to check odd or even using modulus opera
	C program to check odd or even using bitwise opera
	Find odd or even using conditional operator
	C program to check odd or even without using bitwi
	Prime number program in c language
	break;
	C program for prime number or not
	break;
	C program for prime number using function
	Purpose of keeping Accounts or Need For Proper Acc
	What Is Accounts ?
	Object of Book- Keeping are :
	Legal Requirements For Maintaining Books Of Accoun
	Penalty Under Income Tax Act :
	Accounting Terminology
	Meaning of Book Keeping
	Recording of Business Transactions Is To Be Done I
	rnal Cum Cash Book
	ok
	Transactions
	Difference between Book Keeping and Accounting:
	Advantages of Book-Keeping & Accountancy
	Objective of Accounting
	Book Keeping : To maintain Account books
	Objective Of Financial Accounting
	To protect business properties : This
	possible
	supplying thefollowing information to the manage
	it owes and what its wons.
	Basic Principle :
	Personal Account Is A Operator
	Real Account Is A Source Of Operation
	Nominal Account :
	Nominal Account Is A Result Of Operation f Nomin
	CREDIT ALL INCOME &GAINS.
	Double Entry System
	Voucher
	--->Bill.M No.
	--->D.D. No.
	--->To paid for the month of March 99 Some diffe
	Procedure for recording transaction in the Journal
	Example :
	Some Important Heads of Expenditure Rent A/C
	Salary A/C(Administration staff) Wager A/C(Fact
	Postage & Telegram A/C
	Donation A/C (Receipt required above Rs 50/-) Purc
	Business Promotion or Advertisement A/C Repair & M
	News paper & Periodicals A/C Furniture & Fixture A
	Sales promotions A/C Discount and allowances A/C B
	Bank Changes A/C Depreciation A/C
	Cash Book
	The cash book is normally divided into two parts :
	Ledgers
	Ledger Posting:
	Trial Balance
	What is a Trial Balance
	Special Features of Trial Balance
	Why is Trial Balance Prepared?
	Final Accounts
	Kinds of Assets
	Cash in hand Cash at bank
	Advances to Staff Advances to Supplier Earnest Mon
	Adjustment In Profit & Loss A/c with Journal Entri
	Telephone any telephone bill out standing
	Water & Electricity Payable
	Advance Given
	Loss of stock by fire : There are two types of los
	CALCULATE YOUR TAX
	1.Income from “Salaries”.
	3.Income from “Business or Profession”.
	5.Income from “Other Sources”(any income that does n
	Rent, Taxes, Repairs And Maintenance Of Buildings,
	Types of Business
	Proprietorship : (Single person or sole proprietor
	Private Limited Company :
	Public Limited Company :
	Commercial Area :10%
	Vehicle
	Income Tax And Accounts
	:
	Income Of Five Types
	Introduction To Tally
	Tally Screen
	CREATE A COMPANY
	LIST OF GROUP UNDER TALLY
	SUNDRY CREDITORS & SUNDRY DEBITORS SUSPENSE ACCOUN
	UN SECURED LOANS & SECURED LOANS ACCOUNT RECIEVEAB
	BANK ACCOUNT & BANK OCC A/C BRANCH/ DIVISIONS
	EXPENDITURE ACCOUNT EXPENCE (DIRECT) EXPENCE (INDI
	MFG./ TRDG. (EXPENCE) MISC. EXPENCES (ASSETS)
	SUBSIDIARY FARMS & SUNDRY FARMS
	Introduction
	Banking Industry in India
	VAT works in two different ways:
	TermDescription
	Input CreditThe amount of Input tax that is perm
	According to the White Paper, there are 550 catego
	VAT@12.5% : The remaining commodities are under th
	For Fresh / New dealers.
	Highlights of the service tax are as follows :
	Invoice by service provider
	Procedures of Service tax



